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GENERAL INFORMATION

SECTION 1 GENERAL INFORMATION

1.1 SCOPE OF MANUAL 242 -98% X-X X XX
' Band Options
This addendum updates current LTR® 9800- oer C = Compander
series service manuals with information needed to i _ \ljt'”'z D = Data/Acc
service 9800-series LTR-Net™ transceivers. The LTR | g - goo mHz e ;i:br')‘fption/
service manuals it updates are as follows: 9 = 900 MHz Compander
H = Horn/Acc
984x Series UHF Part No. 001-9840-202 Type Cable
988x/989x 800/900 MHz Part No. 001-9880-200 1= Low tier, dual BW Confia.
98xx Series UHF/800/900 MHz Part No. g = mi'dhtlggrdgjﬁm 1o L—QOW —
001-9800-200 (when available) e LO%V ior 12.5 kit 2 = Mid Pwr std
5= Mid tier, 12.5 kHz* [~ 3 = High Pwr std
1.2 DIFFERENCES BETWEEN LTR AND 6 = High tier, 12.5 kHz 6 = L.P. no acc*
LTR-NET VERSIONS 8 = High tier rem, dual BW 7 =M.P.no acc
0 = High tier rem, 12.5 kHz 8 =H.P.noacc
The difference between LTR and LTR-Net Signaling Freq Range
versions of the 9800-series transceivers is the operat- 2=LTR 0 = Full band (800/
ing software. All electrical and mechanical compo- 4 = Multi-Net 900 MHz)
nents remain the same. Therefore, use this addendum| 6 = LTR-Net 3=430-470 MHz
for Operation and Programming information for LTR- |8 = Data only LTR 5=470-512 MHz
Net models, and use the current sections of your 9= Data only M-Net
service manual for Installation, Circuit Description, 0 = Conv only*
Parts List, Schematic Diagram, and PC Board Layout [* These configurations are currently not available

information.
1.4 PART NUMBER BREAKDOWN
Different software is used to program LTR and
LTR-Net versions of this transceiver. The LTR-Net The following is a breakdown of the part number
software is a Windows 95/NT program, and the LTR  used to identify this transceiver.
software is a DOS program. Therefore, either

Windows 95 or NT 4 or later is required to program an | Model Revision Manufacture Warranty
LTR-Net transceiver. The part numbers of this soft- From P.N.  Letter Date Plant Number
ware are shown in Table 1-1. | | | | |
98xx X A 10 9 A 12345
T fEe\— L A = Waseca
1.3 TRANSCEIVER IDENTIFICATION . o
1= Mid pwr LTR Last Digit of Year
h . i ificati i . 2 = High pwr LTR
The transceiver identification number is printed | 3 = pigh pwr conv Week No. of Year
on a label that is attached to the chassis. In addition, it{ 4 = Mid pwr LTR-Net
is programmed into memory and can be read using the| 5 = High pwr LTR-Net
programmer. The information contained in this 6 = Mid pwr Multi-Net |
number is as follows 7 = High pwr Multi-Net| NOTE: Mid power = 25W
8 = Mid pwr Data UHF, 15W 800/900 MHz;
9 = High pwr Data High power = 40W UHF,
0 = Mid pwr Conv 30W 800/900 MHz)
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1.5 MISCELLANEOUS
1.5.1 ACCESSORIES

Table 1-1 is a partial listing of accessories that are
available for 9800-series transceivers. Refer to this

1.5.3 KEY CAP KIT

Key Cap Kit, Part No. 587-9840-002, will be
included with each transceiver. This kit includes 25
keycaps labeled for the following functions:

table in the service manual for other accessories that FCN* SCAN* A/D* ROAM* TEL*
are available. AUX MHNG BANK HOME EMER
HORN MON STLH ENCPT C/IG
PAGE MCPA RXPA PRI TA
Table 1-1 98xx Accessories USR 1 USR 2 CPND (Blank) (Blank)

Accessory Part No.

Key Cap Kit (see Section 1.5.3) 587-9840-002

Programming Accessories
023-9800-000
597-2002-200
597-5900-002

Remote Programming Interface (RPI)
Cable, RPI to transceiver
Cable, RPI to computer, 6 ft.
(DBYF to DB9M)
Personality Programming Software, Win
95/NT, 3%, 1.44 M diskette for
LTR-Net 98xx mobile models only

Flash programming software

023-9998-457

023-9998-432

Tune software (see Section 1.5.4)

1.5.2 AVAILABLE LTR-NET MODELS

Current EFJohnson LTR-Net transceivers are
listed in Table 1-2.

The keypads indicated by an asterisk ( * ) are
installed in the front panel at the factory. To remove a
key cap, insert a tool with a sharp tip in the slot on the
bottom of the cap and carefully pry against the front
panel to release the cap. Then simply pull it out.

NOTE: The above key cap kit may not be available
until later in 1999. Therefore, early models may be
equipped with only the FCN, SCAN, A/D, TA, and
AUX key caps.

1.5.4 TRANSCEIVER TUNING
LTR-Net 98xx models are currently not field

tunable. If retuning is required, return the transceiver
to the factory.

Table 1-2 EFJohnson LTR-Net Transceivers

Fre Localities | Systems | Groups Power

Model (MH(;) [1] y (1] [ l]sp Type Output Other Features

8170 800 14 14 10 Portable 3.0/1.0W |Quick select switch, user sel pwr output

8171 800 14 14 10 Portable 2.0/1.0W | Quick sel sw, sel pwr, Intrin Safe

8172 900 14 14 10 Portable 2.5/1.0W |Quick select switch, user sel pwr output

8173 900 14 14 10 Portable 2.0/1.0W | Quick sel sw, sel pwr, Intrin Safe

9843 400 35 99 99 Mob Dash |25 or 40W [High-tier, up to 16 banks selectable

9883 800 35 99 99 Mob Dash |15 or 30W |High-tier, up to 16 banks selectable

9896 900 35 99 99 Mob Dash |15 or 30W [High-tier, up to 16 banks selectable
[1] With 9800-series high tier transceivers, up to approximately 35 LTR-Net or 60 conventional localities are programmable.
However, due to memory limitations, the maximum number decreases as the total number of localities, systems, and groups
increases.
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SECTION 2 OPERATION

Transmit/Busy
Indicator

A

l_

OCe

LB~

On-Off/Volume
(Press/Rotate)

Microphone
Jack

Option Switches

Select Switch
(Press/Rotate)

Speaker

O
D

TEL

Display

Figure 2-1 Front Panel Controls and Indicators

2.1 FEATURES

2.1.1 INTRODUCTION

The features available are as follows. The LTR-
Net features are available when a system programmed
for LTR-Net operation is selected and likewise for the
LTR and conventional features. Most features can be
enabled or disabled by programming.

2.1.2 GENERAL FEATURES

e Upto 35 LTR-Netor 60 LTR/conventional localities
(sites) programmable [1]

e Upto 16 banks programmable (a bank is a collection
of systems)

e Up to 99 systems per bank and up to 99 groups per
system programmable [1]

e Each system selects an LTR-Net, LTR, or conven-
tional locality (site)

e Large 2-line x 8-character liquid crystal display
(LCD) with backlight

e Unique 8-character group alpha tags

e Alpha tag or numeric system/group display mode
user selectable

System Scan

Group Scan

User programmable scan list(s)

All five option switches programmable

Menu mode

Emergency system/group quick select switch
Stealth mode to disable LED, tones, and backlight
Proceed (clear-to-talk) tone

Time-out timer

Call indicator

Companding (optional)

Two accessory option slots

One of five preset power output levels
programmable for each locality

[1] Because of memory limitations, the maximum number
that can be programmed decreases as the total number
of localities/banks/systems/groups increases.

2.1.3 LTR-NET FEATURES

e Standard, telephone, unique ID, and directed group
calls

April 1999
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e Roaming (automatic locality search)

e Queuing of telephone, unique ID, and directed
group calls by radio system

e Eight levels of receive priority programmable on
each group

e Transmit inhibit

2.1.4 LTR FEATURES

Standard and telephone calls

e FEight levels of receive priority programmable on
each group

e Transmit inhibit

2.1.5 CONVENTIONAL FEATURES

e FEach group selects a radio channel

Channels programmable for tone (CTCSS), digital
(DCS) Call Guard, external, or carrier squelch
control

User-adjustable squelch level

Busy indicator

Transmit disable on busy

Monitor mode

Receive-only channels

Talk-around

2.2 CONTROLS
2.2.1 FRONT PANEL

The transceiver is shown in Figure 2-1. All of the
option switches are programmable, so the function of
each switch can vary from those shown. The controls
and indicators operate as follows:

On-Off/Volume - Pressing the knob turns power on
and off. The vehicle ignition switch may also control
power as described in Section 2.5.10. Rotating this
knob sets the volume level (see Section 2.4.2).

Select Switch - This switch changes the selected
system or group and is also used in the menu mode
(see Section 2.6) and other times. When changing the

April 1999
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system/group, turning this switch clockwise increases
the selected system or group, and turning it counter-
clockwise decreases the selected system or group. To
switch between system and group select, press this
switch. Refer to Section 2.4.5 for more information.

This control also has two alternate functions that
are selected by first pressing the FCN option switch.
Refer to Section 2.5.6 for more information.

Tri-Color Indicator - Indicates the following
conditions:

Red - Transmitter keyed, normal power output

Orange - Transmitter keyed, power reduced by
thermal foldback circuit

Green-Busy conventional channel (carrier detected).

Microphone Jack - Connection point for the micro-
phone and also the RPI programming interface when
programming the transceiver.

Microphone Push-To-Talk (PTT) Switch - Keys the
transmitter.

Speaker - A speaker is located behind the grille. An
optional speaker can be connected to the external

speaker jack described in Section 2.2.2. The internal
speaker is disabled when an external speaker is used.

Option Switches - As previously mentioned, all five
option switches are programmable. The functions that
can be programmed are listed in Table 2-1 on page
2-13. Refer to Section 2.6 for more information on
option switch and menu functions:

Function Switch - If this option switch is
programmed, it controls the following functions:

Menu Mode Select - Press FCN twice (see
Section 2.6.2) or the MENU option switch.

Home System/Group Select - Press FCN and then
the Select switch (see Section 2.5.7) or the
HOME option switch.

Squelch Level Adjust - In the conventional mode
only, press FCN and then rotate the Select switch
to adjust the squelch level (Section 2.4.7).
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2.2.2 REAR PANEL JACKS AND
CONNECTORS

Antenna Power Ext. Speaker

Jack Jack Jack

il

Antenna Jack - Miniature UHF jack for connecting
the antenna.

Power Jack - Connection point for a nominal 12-volt,
negative ground power source.

Speaker Jack - Connection point for an external
4.7-ohm, 5-watt speaker. The internal speaker is
disabled when a speaker is connected to this jack.

Accessory Cable (Not Shown) - This optional pigtail
cable installs in the speaker jack opening and is used
to connect the ignition sense, horn alert, and other
outputs.

Data/Accessory Cable (Not Shown) - This optional
cable also installs in the speaker jack opening, and it
includes the preceding accessory cable and a data
cable with no connector or a female HD DB-15
connector. The data cable is used to connect data
equipment such as a modem to the transceiver. Data
equipment is not currently supported.

2.3 DISPLAY DESCRIPTION

The display is shown in Figure 2-2, and it
indicates the following information.

16-Character Message Area - Indicates the selected
system and group (see Section 2.4.4), error condi-
tions, and status information (see Section 2.12.4).

|S| - Indicates that the displayed system is in the scan
list (see Section 2.7.6).

El - Indicates that the displayed group is in the scan
list (see Section 2.7.6).

? - With LTR-Net operation, indicates that the
selected group is programmed for telephone or auxil-
iary calls (see Section 2.9.1). With LTR operation,
indicates that the selected group is programmed for
telephone calls.

Z - Indicates that scanning is enabled (see Section
2.7).

A - Indicates that the function controlled by the
AUX option switch or OPTION menu parameter is
enabled (see Section 2.5.9).

C - Indicates that a call has been received on a
group programmed for a call indicator (see Section
2.5.2). To turn this indication off, press any key.

‘ - Indicates that the monitor mode is enabled. This
mode disables Call Guard squelch and other squelch
control features so that all messages are heard on
conventional systems (see Section 2.11.1).

Sys Scan Phone/  Scan Call Not  Grp Scan
List Aux ID Selected & Used List

—
S| QA ZAC P,

\ \

16-Character
Message Area

Option Monitor

Figure 2-2 Display
2.4 GENERAL OPERATION
2.4.1 POWER-UP SEQUENCE
When transceiver power is turned on by pressing

the front panel power switch or turning the ignition
switch on, the following start-up sequence occurs:
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1. The backlight turns on. 2.4.4 SYSTEM/GROUP DISPLAY
INFORMATION
2. All segments of the alphanumeric display are
enabled and the last seven digits of the transceiver Up to 99 systems and up to 99 groups per system
part number (see Section 1.4) are displayed on the can be displayed. Either a numeric or alpha tag display
top line very briefly. For example, a 800 MHz, high mode can be selected by the user if the menu S/G
tier, LTR-Net, 15-watt transceiver is indicated as  DISP menu parameter is enabled (see Section 2.6.2). If
“9883602". The eighth display digit is reserved for not, it is fixed by programming.
future use and is always “0".
When the numeric mode is selected, the system
3. Ifthere are unread error codes, the last code that and group numbers are indicated on the top line of the
occurred is displayed a* CODE xx” on the display as Sxx and Gxx, and the group alpha tag (up to
bottom line (see Section 2.14). eight characters) is displayed on the bottom line (the
system alpha tag is not displayed). For example,
4. A beeps sounds (if tones are enabled) and the transSystem 1, Group 1 (CAR 220) is displayed as follows:
ceiver is ready to be used.

System Number|

2.4.2 DETERMINING VOLUME LEVEL
Group Number

The relative volume setting can be determined by Group Alpha Tag
noting the position of the index on the volume knob. It
may also be possible to enable a reference tone or Numeric Display Mode
audio for setting the volume level using one of the
following methods: When the alpha mode is selected, the system

alpha tag is displayed on the top line, and the group

o If key press tones have been enabled as described iralpha tag is displayed on the bottom line (the system
Section 2.5.15, a short tone can be enabled by rotat-and group numbers are not indicated). For example, a
ing the select switch or pressing an option switch. “SECURITY” system and “CAR 220" group are

displayed as follows:

e If a conventional system is selected, take the micro-
phone off-hook to enable the monitor mode (unless
off-hook detect is disabled). If someone is talking, J——
audio is then heard. If nobody is talking, the squelch || =
control can also be adjusted as described in Section
2.4.7 and noise should be heard. Refer to Section
2.11.1 for more information on the monitor mode.
When an LTR-Net or LTR system is selected, the Alpha Display Mode
receiver cannot be manually unsquelched.

T <&—— System Alpha Tag

{ | [<¢— Group Alpha Tag

2.4.5 SELECTING SYSTEMS AND GROUPS

2.4.3 BACKLIGHT OPERATION

The front panel Select switch is used to change

The display and keypad backlight can be the system and group. Rotating this switch clockwise

controlled by the menu BACKLGHT parameter. The increases the system or group, and rotating it counter-
three states that can be selected are Bright, Dim, and clockwise decreases the system or group. After the
Off. Itis in the selected condition whenever power is  highest system or group is selected, wrap-around to
turned on. If this menu parameter has been disabled bythe lowest system or group occurs and vice versa. The
programming, the backlight is fixed in one of these wrap-around tone sounds when this occurs (if tones
states. are enabled).
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Pressing the Select switch toggles between the
system and group select modes. With the numeric
display mode (see preceding section), the active mode
is indicated by an arrow in the display. This arrow
points to “Sxx”” when the system select mode is
enabled, and to “Gxx” when the group select mode is
selected (see following example).

If the alpha display mode is selected, the system
or group select mode is indicated by an underline in
the left-most character position. This underline is on
the system alpha tag line when the system select mode
is selected and the group alpha tag line when the group
select mode is selected (see following example).

System Select
Mode

Group Select
Mode

Select Mode Indicator (Numeric Display Mode)

System Select
Mode

Group Select
Mode

Select Mode Indicator (Alpha Display Mode)

The transceiver remains in the selected mode
until transceiver power is cycled or normal transceiver
operation is interrupted such as by selecting the menu
mode. The programmed “Select Knob Default” condi-
tion is then selected. A separate return time timer is
currently not programmable with LTR-Net models.

Group Tracking

When the selected system is changed, the same
group number is selected on the new system if it is
programmed. If it is not, the last selected group is
selected. The preferred group changes only when
another LTR-Net/LTR group is manually selected. For
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example, assume the following systems and groups are
programmed:

System 1 - Group 1 manually selected
System 2 - Groups 2 and 3 (Grp 2 last selected)
System 3 - Groups 1 and 2

If the radio is currently on System 1/Group 1 and
System 2 is selected, Group 2 is displayed because
there is no Group 1 programmed. If System 3 is then
selected without having manually changed the group,
Group 1 is selected.

This operation occurs only when selecting other
LTR and LTR-Net systems. When selecting a conven-
tional system, the last selected group is always
displayed. Manually changing the group with a
conventional system selected does not change the
preferred LTR-Net/LTR group.

2.4.6 MICROPHONE OFF-HOOK DETECT

Off-hook detection can be disabled on a radio-
wide basis by programming. The microphone is then
always assumed to be “on-hook” and taking it off-
hook does not enable conventional channel monitoring
or temporarily disable scanning. One reason for select-
ing this option may be to prevent scanning from being
disabled when the microphone is off-hook. Monitoring
can also be disabled on conventional systems on a
group-by-group basis as described in Section 2.11.1.

2.4.7 SETTING SQUELCH CONTROL

The squelch level for LTR-Net/LTR operation is
set during transceiver alignment and cannot be reset by
the user. However, with conventional operation, it can
be set if the FCN switch is programmed. If the squelch
level cannot be changed by the user (not recom-
mended), a default level is used.

With dual band (12.5/25 kHz) models, separate
levels are maintained for each band. Adjusting the
squelch with a 12.5 kHz channel selected sets the 12.5
kHz level, and adjusting it with a 25 kHz channel
selected sets the 25 kHz level. Proceed as follows:

1. Select a conventional system, and a non-busy group
programmed for carrier squelch. If the group is

April 1999
Part No. 001-9800-600



OPERATION

programmed for Call Guard squelch, the monitor
mode described in Section 2.11.1 must also be
enabled.

2. Press the FCN switch and then within 8 seconds
rotate the Select switch as you would a normal
squelch control. Rotate it counterclockwise until
noise is heard and then rotate it clockwise slightly
past where the noise just mutes. The squelch adjust
mode is indicated by “SQUELCH” on the top line of
the display, and the relative squelch level is indi-
cated by a bar graph on the bottom line.

3. To select the current level and exit the mode, press
the Select switch again. This also occurs automati-
cally 2 seconds after a change is made or 8 seconds
after no activity.

NOTE: Some readjustment may be required if weak
messages are not heard or unsquelching occurs when
no messages are present.

2.4.8 LTR-NET, LTR, AND CONVENTIONAL
OPERATING MODES

Introduction

This transceiver can be programmed to operate in
the LTR-Net, LTR, and conventional modes. Each
selectable system can be programmed to select a
locality programmed for one of these modes. The type
of operation that is programmed is determined by the
type of repeater equipment being accessed. The differ-
ences in operation are described in the following infor-
mation and also noted elsewhere as required.

LTR-Net and LTR Operation

The LTR-Net mode provides the most operating
features. Some features available only in the LTR-Net
mode include roaming (automatic locality search),
unique ID calls, and directed group calls. LTR-Net
features are described in Sections 2.8 and 2.9.

Operation in the LTR mode is similar to the LTR-
Net mode except that the preceding (and other) LTR-
Net features are not available.The types of calls that
can be placed in the LTR mode are standard group
(mobile-to-mobile) and telephone. LTR features are
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described in Sections 2.8 and 2.10 and also the LTR
Application Note, Part No. 009-0001-020, rev. 8 or
later.

Both the LTR-Net and LTR modes provide auto-
matic channel selection (trunking) and monitoring
before transmitting. Special tones and display
messages indicate busy and out-of-range conditions,
and telephone calls can be placed almost as conve-
niently as with your home telephone.

Selecting a system selects a locality, home
repeater, collection of groups, and other information.
Likewise, selecting a group selects the call type, trans-
mit and receive ID codes of group calls, call indicator
and horn alert operation, and other information. The
group call ID codes determine the mobile or group of
mobiles being called and what calls are received.

Conventional Operation

In the conventional mode, selecting a system
selects a block of up to 99 channels, and selecting a
group selects a channel from that block. Each channel
(group) can be programmed for a different squelch
control technique (CTCSS, CDCS, or carrier) and
other parameters. The squelch level must be adjusted
as described in Section 2.4.7 to properly receive
conventional calls.

With conventional operation, an out-of-range
condition is not indicated by a special tone or display
message because there is no data handshake with a
repeater that allows this condition to be detected. A
busy condition is detected automatically if the Trans-
mit Disable On Busy feature is used (see Section
2.11.2). Otherwise, it must be detected manually (see
following). Refer to Section 2.11 for more information
on conventional operation.

To manually monitor a conventional channel
before transmitting to determine if it is being used by
someone else, proceed as follows:

Using Busy Indicator - With scanning disabled and
the squelch control adjusted as described in Section
2.4.7, note if the indicator on the front panel is lighted
green. If it is, a carrier is being detected on the
currently selected conventional group (channel). If this



OPERATION

indicator is not lighted, the channel is not busy and the
message can be transmitted.

Using Monitor Mode - If scanning, take the micro-
phone off-hook to disable scanning and enable the
monitor mode (indicated by ‘ in the display). The
monitor mode disables squelch control features so that
all messages are heard. If none are heard, the channel
is free and the message can be transmitted. Refer to
Section 2.11.1 for more information on monitoring.

If off-hook detection is disabled or off-hook
monitoring is disabled on the selected conventional
group (see Section 2.4.6), taking the microphone off-
hook does not enable the monitor mode. The Transmit
Disable On Busy feature must then be used to perform
monitoring.

2.4.9 LOCALITIES, SYSTEMS, AND GROUPS

When any call is placed, a locality, system, and
group are selected. Definitions of each of these terms
follows:

Localities

An LTR-Net and LTR locality is a repeater site.
The repeaters are typically co-located and intercon-
nected by a common bus to form a trunked channel
group. A conventional locality may or may not include
repeaters at the same physical site. A locality can
include up to twenty repeaters.

Unique locality parameters include the channel
frequencies and bandwidth of each repeater at the site.
Other information that is programmed includes the
status repeater (LTR-Net only), and what repeaters are
equipped with telephone interconnect (LTR only) and
companding. Up to approximately 35 LTR-Net or 60
LTR/conventional localities can be programmed (the
maximum number decreases as the number of banks,
systems, and groups increases).

Systems

Systems consist of a collection of groups (see next
paragraph) and other unique information. Each system
is linked to one of the programmed localities. Up to 99
systems can be programmed.
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LTR-Net and LTR systems are programmed with
the home repeater number, a collection of groups, and
transmit inhibit block of ID codes (see Section 2.8.4).
The home repeater number and group ID code form
the address for group calls. In addition, it is the
repeater that is monitored for incoming call informa-
tion (the status repeater serves as a backup with LTR-
Net operation).

Conventional systems are programmed with a
collection of groups, each of which selects a unique
radio channel (see following).

Groups

The groups assigned to a system select individual
call information. Up to 99 groups can be assigned to
each system. With all three types of operation, each
group is programmed with a group alpha tag and prior-
ity, group scan, and call indicator information. The
available group types are as follows.

LTR-Net Group Types

Dispatch - Used to place and receive standard group
(mobile-to-mobile) calls. Encode and decode IDs
from 1-239 can be specified.

Telco - Used to place telephone calls.

Auxiliary - Used to place unique ID and directed
group calls.

Data - Used to place and receive unique ID data
calls. This call is currently not available.

LTR Group Types

Dispatch - Used to place and receive standard group
(mobile-to-mobile) calls. Encode and decode IDs
from 1-250 can be specified when accessing an LTR
locality (site). If an LTR-Net locality is being
accessed, IDs from 1-239 can be specified.

Telco - Selected to place telephone calls. A RIC
(interconnect) ID is also specified. This code is one
that has been reserved on the repeater system for
telephone calls.
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Conventional Group Types

Only dispatch calls can be programmed with
conventional operation. Conventional groups select
the radio channel, Call Guard squelch, and other
information.

2.4.10 PLACING AND RECEIVING STANDARD
GROUP CALLS

NOTE: The following procedure applies to all operat-
ing modes (LTR-Net/LTR/Conventional).

Standard group (dispatch) calls are between two
or more mobile or control station transceivers. Unlike
other types of calls, no number is dialed when the call
is placed. Proceed as follows to place and receive a
group call:

Placing a Group Call

1. Turn transceiver power on and set the volume as
described in Sections 2.4.1 and 2.4.2. With conven-
tional operation, also set the squelch as described in
Section 2.4.7.

Select the system and group of the mobile being
called as described in Section 2.4.5.

3. If a conventional call is being placed, monitor the
channel manually or automatically as described in
the preceding section.

The microphone PTT (push-to-talk) switch must be
pressed (and held) to talk and released to listen.
Operation with the different call types is as follows:

LTR-Net/LTR Operation

e [fthe proceed tone is enabled, it sounds when the
system is successfully accessed. The proceed tone
(and other tones) can be disabled if desired by the
Tones menu parameter or by programming (see
Section 2.5.15).

e [fall repeaters are busy, the busy tone sounds (see
Section 2.12) and “BUSY” is indicated on the
lower line of the display. The PTT switch must
then be released and pressed again to make
another access attempt.
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e [fthe system could not be accessed because of an
out-of-range condition or some other reason, the
intercept tone sounds and “NO ACCES” is indi-
cated on the lower line of the display. The PTT
switch must then be released and pressed again to
make another access attempt. Drive closer to the
radio system or away from shielding structures
and try again.

When responding, busy or out-of-range condi-
tions may also occur as when placing a call
because the system is accessed for each
transmission.

Conventional Operation

e [fthe channel is busy and the Transmit Disable On
Busy feature is programmed, “DSBL BSY” is
indicated on the lower line of the display and the
transmitter is disabled. Any channel activity is
heard while the PTT switch is pressed (see
Section 2.11.2).

Otherwise, busy and out-off-range conditions are
not indicated (see Section 2.4.8) and speaking can
begin when the PTT switch is pressed. If the
proceed tone is enabled, it indicates when speak-
ing can begin but does not indicate that a repeater
has been successfully accessed (see Section
2.5.11).

. When the call is finished, place the microphone
back on-hook.

Receiving a Standard Call

1. Turn transceiver power on and set the volume and
squelch as described in Sections 2.4.1 and 2.4.2.

Select or scan (see Section 2.7) the system and
group programmed for the call you want to receive.

3. When the message is received, take the microphone
off-hook and press the PTT switch to talk and
release it to listen. If scanning, a response may not
automatically occur on the group of call. Refer to
Section 2.7.8 for more information.
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2.4.11 PLACING AND RECEIVING TELEPHONE
CALLS

The procedure for placing LTR-Net telephone
calls is described in Section 2.9.1, and the procedure
for LTR telephone calls is described in Section 2.10.2.
If telephone calls can be placed in the conventional
mode, the procedure used depends on the specific
interconnect equipment being used.

2.5 GENERAL FEATURES
2.5.1 BANK SELECT

Up to sixteen banks can be programmed. Banks
are collections of systems that have been set up for
operation in a specific geographic area or other uses.
For example, one bank could be programmed for oper-
ation in Minneapolis and another for operation in
Milwaukee. Each bank is identified by a unique alpha
tag.

Banks are selected by either the BANK menu
parameter or option switch. In the menu mode rotate
the Select switch to display “BANK SEL” on the top
line, and then press the Select switch to change the
bank. The alpha tag of the current bank is displayed on
the bottom line. Refer to Section 2.6.2 for more menu
mode information. If using the option switch, when
“BANK SEL” is displayed on the top line, simply
press the Select switch to select the desired bank.

Any programmed system can be assigned to a
bank, and the system numbering can be different for
each bank. Only the systems in the currently selected
bank are selected or scanned, and at least one bank is
always programmed. Unique bank parameters include
Emergency system/group (see Section 2.5.4), Home
system/group (see Section 2.5.7), and the default scan
list status of each system.

When a different bank is selected, the last
selected system in that bank is displayed, and the
displayed group is the last selected group of that
system. These are the only user selected functions that
are stored on a per bank basis.

2.5.2 CALL INDICATOR

The call indicator is “C” in the upper part of the
display as shown in the following illustration.

Call
Indicator

The purpose of this indication is to show that a
call was received while the user was away from the
vehicle. It is turned off by pressing any button or turn-
ing transceiver power off and then on. If scanning and
the “last received” configuration is programmed (see
Section 2.7.8), the system and group of the last call are
displayed. Otherwise, the currently selected system/
group is displayed.

Each selectable group can be programmed so that
the Call indicator is activated when a call is received.
With conventional operation, the Call indicator is acti-
vated if the transceiver unsquelches for 2 seconds or
longer. Therefore, if Call Guard squelch is
programmed, it must also be detected for the call indi-
cation to appear (unless it is disabled by the monitor
mode).

2.5.3 COMPANDING

The companding feature is optional with this
transceiver. It is a separate module that installs in one
of the audio/logic board option slots (Option Slot 2 is
normally used). Companding improves audio quality
by decreasing the amount of noise present in the audio
signal. It does this by providing a 2:1 compression of
the audio signal on the transmit end and a 1:2 expan-
sion on the receive end. Companding is especially
recommended for 12.5 kHz bandwidth channels
because audio quality improvement is usually
significant.

If this feature is used, it must be utilized in both
the transmitting and receiving mobile. The best results
are obtained if companding is also used in the
repeater; however, improvement also results if it is
only used in the mobile and handheld transceivers.
With telephone calls, companding must be utilized at
the repeater if it is used in the mobile.
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Each locality (site) channel can be individually
programmed for companding. Then whenever a call is
received or transmitted on one of those channels,
companding is automatically enabled. Companding is
not selectable by the user, and the companding status
is not indicated in the display. The control line for this
function (Output A or B) must be programmed for
“Compand” and active high as described in
Section 3.13.

2.5.4 EMERGENCY SWITCH

The Emergency option switch functions as an
emergency system/group quick select. Each bank can
be programmed for a different emergency system/
group.

When the emergency switch is pressed, the emer-
gency system/group is selected and the alpha tag
programmed for the emergency group is displayed
(“EMERGENCY™ is not displayed unless it is the
alpha tag). Normal message reception and scanning
continue if applicable. The emergency message must
be manually transmitted (automatic emergency trans-
missions do not occur). Another system/group can be
selected normally at any time.

2.5.5 ENCRYPTION
Voice encryption is currently not available.
2.5.6 FUNCTION SWITCH

The FCN (function) switch performs the follow-
ing functions. When the function select mode is active,
“FCN” is displayed on the lower line of the display.
This mode is automatically exited if no additional
activity occurs within 8 seconds.

Menu Mode Select - Pressing FCN twice or the
MENU option switch selects the menu mode described
in Section 2.6.

Home System/Group Select - Pressing FCN and then
the Select switch or the HOME option switch selects
the home system/group as described in Section 2.5.7.

Squelch Adjust - Pressing FCN and then rotating the
Select switch sets the conventional mode squelch level
as described in Section 2.4.7.
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2.5.7 HOME SYSTEM/GROUP SELECT

The Home Select feature quickly selects the
preprogrammed home system/group. This is done by
pressing the Home switch or the FCN switch and then
the Select switch (see Section 2.6.1). The home
system/group is then displayed and it becomes the
selected system/group (it is not temporarily selected).
A different home system/group can be programmed
for each bank.

If the home system/group is selected while scan-
ning, scanning halts for the programmed scan delay
period. If no home system is programmed or the FCN
switch is disabled, the home select feature is not
available.

2.5.8 HORN ALERT

The horn alert feature is currently not available.

2.5.9 OPTION SELECT

A programmable AUX option switch or the
OPTION menu parameter (see Section 2.6) can be
used to control some type of dealer-defined accessory
such as a DTMF decoder. The enable mode is indi-
cated by A in the display. If the menu mode is used,
this indication does not appear until the menu mode is
exited.

If this function is used, the I/O line controlling
the option (such as the Output D line of accessory
connector J101) must be programmed for the Acces-
sory Option as described in Section 3.13. These are
CMOS outputs with a 470-ohm series resistance and a
typical maximum source and sink current of 2 mA.
Therefore, some type of driver circuit may be required.

2.5.10 POWER TURN-OFF DELAY

The transceiver can be installed so that the vehi-
cle ignition switch as well as the front-panel power
switch controls transceiver power. This is done by
installing the ignition switch cable and removing R170
on the audio/logic board (see Section 2.4.3 of service
manual). Turn-off delays of Immediate, 10, 20, 30, 40,
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or 50 minutes, 1, 2, 4, 8, 10, 12, or 16 hours or Forever
can then be programmed. The delay can be overridden
at any time by turning power off using the front-panel
power switch or turning the ignition switch back on.

A turn-off delay allows features such as the call
indicator to remain active for the programmed delay
time after the ignition switch is turned off. At the same
time, advantages of ignition switch control can be
utilized such as preventing battery discharge that may
occur if the transceiver is accidentally left on for an
extended period.

2.5.11 PROCEED (CLEAR-TO-TALK) TONE

This is a tone that sounds shortly after the PTT
switch is pressed to indicate that the system has been
accessed and speaking can begin. It is always enabled
on LTR-Net/LTR systems and can be enabled and
disabled on all conventional systems by program-
ming. This and other tones can also be disabled by the
Tones menu parameter or programming as described
in Section 2.5.15.

If the radio system is busy when making an LTR-

Net or LTR call, the busy tone sounds instead of the
proceed tone and “BUSY” is indicated on the bottom
line of the display. If an access attempt is unsuccess-
ful, such as because of an out-of-range condition, the
intercept tone sounds and “NO ACCES” is indicated
in the display. When either of these conditions occur,
the PTT switch must be released and pressed again to
make another attempt.

On conventional systems, no data handshake with
a repeater occurs, so a busy or out-of-range condition
cannot be detected from data. The Transmit Disable
On Busy feature can be used to automatically perform
monitoring (see Section 2.11.2). If the channel is then
busy, the proceed tone does not sound unless the trans-
mitter is keyed by quickly releasing and then pressing
the PTT switch. Otherwise, the proceed tone sounds (if
enabled) even if the channel is busy.

With conventional operation, if Call Guard
squelch is programmed on the group, there is a 0.5-
second delay before the proceed tone sounds. This
delay gives the receiving mobile time to detect the
Call Guard signal which prevents the partial loss of the
first word of the transmitted message.

2.5.12 PROGRAMMABLE POWER OUTPUT

One of five levels can be programmed. The actual
power output at each of these levels is set during trans-
ceiver alignment (see Section 1.5.4). The high power
level is factory preset at the rated high power output
for the model, and the low power settings are all preset
at 10 watts with high power models and 2.5 watts with
medium power models. Power output is not user
selectable, and the currently selected level is not
indicated.

2.5.13 STEALTH MODE

The stealth mode disables the following tones and
indicators so that they do not reveal that the transmit-
ter has been keyed or the presence of someone using
the transceiver. However, the receive (speaker) audio
and display remain enabled.

e All supervisory tones (see Section 2.5.15)
e The front panel tri-color indicator
e Display backlight

The stealth mode is selected by the STEALTH
menu parameter (see Section 2.6.2). The above func-
tions are disabled immediately when the switch is
pressed, and there is no special indication that this
mode is selected. With the menu mode, the tones and
indicator are disabled immediately when “ON” is
selected, and the backlight remains enabled until the
menu mode is exited. If the stealth mode is not select-
able by the menu mode, it is fixed in the on or off
condition by programming.

2.5.14 TIME-OUT TIMER
General

The time-out timer disables the transmitter if it is
keyed continuously for longer than the programmed
time. It is programmed in half-minute increments from
0.5 - 5.0 minutes or it can be disabled. If the transmit-
ter is keyed continuously for longer than the
programmed time, the transmitter is disabled, “TIME-
OUT” is indicated on the lower line of the display, and
the conversation time-out tone sounds. The timer and
tone are reset by releasing the PTT switch.
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One use of this feature is to prevent a repeater
from being kept busy for an extended period by an
accidentally keyed transmitter. It can also prevent
possible damage to the transmitter caused by transmit-
ting for an excessively long period.

2.5.15 TONE SELECT

If the TONES menu parameter is enabled by
programming, the user can select the tones that sound.
Otherwise, the tone mode is selected by program-
ming. The following choices are available:

SILENT - All tones are disabled.

KEYS - Only the Select switch) and key press tones
are enabled.

ALERTS - All tones except the preceding Key Beep
tones are enabled.

ALL - Both the preceding Key Beep and Alert tones
are enabled.

2.5.16 TRANSMITTER THERMAL FOLDBACK

The temperature of the power amplifier is moni-
tored by the control logic when transmitting. If a
temperature is detected that could damage the power
amplifier module or other devices, power is automati-
cally cut back to a preset low level. After sufficient
cooling occurs, power output returns to the normal
level. This provides hysteresis so that power is not cut
back again after only a short transmission. When
power is cut back, the transmit LED is orange instead
of red (no message is displayed).

If temperature continues to increase at the low
power setting to the point where more serious damage
could occur (this should seldom happen), the transmit-
ter is disabled, a warning tone sounds, and “NO
POWER? is displayed. The transmitter remains
disabled until temperature decreases to the first
temperature limit. Power output is then produced at
the preset low setting. The temperature limits and low
power level are fixed in software.

The supply voltage applied to the transceiver is
also monitored in the transmit mode. If this voltage
rises above 18.5 volts DC, the transmitter is disabled
and the same indications are produced as described in
the preceding paragraph. This prevents possible
damage to transistors in the transmitter.
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2.6 OPTION SWITCHES AND MENU MODE
2.6.1 USING OPTION SWITCHES

This transceiver has five option switches (see
Figure 2-1). All are programmable and the available
functions are listed in Table 2-1. A function can be
controlled by both the option switch and menu mode
parameter if desired. Any switch can also be disabled
if desired.

2.6.2 MENU MODE INFORMATION

The menu mode is selected by pressing the FCN
option switch twice within 8 seconds or the MENU
option switch. If neither of these switches are
programmed, the menu mode is not available. The
functions that can be controlled by the menu mode are
indicated in the “Menu Items” column of Table 2-1.
Some functions can also be controlled by programma-
ble option switches (see preceding section). Other
highlights of menu mode operation are as follows:

e Programming determines what functions are
displayed in the menu mode. Functions can be
controlled by both the menu parameter and option
switch if available.

e Some functions can be set in a fixed condition by
disabling the option switch and menu item and then
programming the default condition in the menu for
the desired mode. However, if a parameter can be
changed by an option switch or menu parameter or

is automatically changed, the programmed default
condition is maintained only until the first time it is
changed.

e C(Calls cannot be received or transmitted while in the
menu mode.

2.6.3 USING MENU MODE
To use the menu mode, proceed as follows:

1. To select the menu mode, press the FCN option
switch twice within 8 seconds or the MENU option
switch. The top line indicates the function being
edited, and the bottom line indicates the current
status as follows.
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-4— Function

Status

Menu Mode Display

2. Todisplay the various functions that are controllable

by the menu mode (top line indication), rotate the
Select switch. The currently selected status is
displayed for each function.

. To change the selected status, press the Select
switch. Information displayed for each menu
parameter is shown in Section 2.12.5.

. To display another menu function, rotate the Select
switch. Then change the status if desired as
described in the preceding step.

5. The selected configurations for the various func-
tions are saved when the menu mode is exited in one
of the following ways:

e Pressing the FCN or MENU option switch again

e Pressing the PTT switch

e Automatically when time-out occurs 2 seconds
after a change is made or 8 seconds after no
changes are made.

2.7 SYSTEM AND GROUP SCAN

2.7.1 GENERAL

Both system and group scanning are available.
Refer to Sections 2.7.3 - 2.7.5 for more information.
Both types of scanning are turned on and off by the
Scan option switch. When system and/or group scan-
ning is enabled, Z is displayed, and when system or

Table 2-1 Menu Mode and Option Switch Functions

Function Menu Items Option Switch See Section:
Add/delete (scan list programming) A/D 2.7.6
Backlight adjust BACKLGHT 2.4.3
Bank select BANK SEL BANK 2.5.1
Display mode select S/G DISPL 24.4
Emergency EMER 2.5.4
Function select FCN 2.5.6
Home sys/grp select HOME or FCN then 2.5.7
press Sel Sw
Menu mode select MENU or FCN 2.6.2
twice
Option select OPTION AUX 2.5.9
Roaming on-off ROAMING ROAM 293
Scan on-off SCAN 2.7
Scan type select SCN TYPE 2.7
Scan continue on-off SCN CONT 2.17.7
Scan list save mode SCN SAVE 2.7.6
Stealth mode select STEALTH 2.5.13
Squelch adjust FCN then rotate 2.4.7
Sel Sw

Telephone group select TEL 2.8.5
Tone type select TONES 2.5.15
NOTE: Parameters left blank are not available.

2-13
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group scanning is actually occurring, a scrolling
underline is displayed on the upper line (see following
illustration).

System Scan List Group Scan List

System or Group
Scanning Selected

System or Group
Scanning Occurring

Scan Indicators

Other Scan Information

The microphone must be on-hook for scanning to
occur (unless off-hook detection has been disabled as
described in Section 2.4.6). When a message is
detected that the transceiver is programmed to receive,
scanning stops and the message is received. Shortly
after the message is complete, scanning resumes
(unless it has been disabled). The length of this delay
is set as described in Section 2.7.7. The selected
system and group can be changed in the normal
manner while scanning. Scanning resumes shortly
after the change is made.

When scanning is occurring (see preceding illus-
trations), transmissions always occur on the displayed
system/group. However, when a message is received,
scanning temporarily stops and the display changes to
the system/group of the call. A response may then
occur on the displayed or selected group as described
in Section 2.7.8.

2.7.2 SELECTING SCAN TYPE

The following system and group scan functions
are available:

System Scan - This feature detects calls on all systems
that are in the scan list (see Section 2.7.6). If system
scanning is not used, calls are detected on only the
currently selected system.
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Group Scan - This feature detects calls on all select-
able groups in the selected or scanned systems that are
in the group scan list. If group scanning is not used,
calls are detected on only the currently selected group
(or the last selected group of scanned systems) and
higher priority groups.

The type of scanning can be selected by the user
if the SCN TYPE menu parameter is enabled. Other-
wise, it is fixed by programming. The available types
are as follows:

SYSTEMS - Both system and group scanning enabled

GROUPS - Group scanning only enabled

OFF - Both system and group scanning disabled,
SCAN switch non-functional

The following configurations can also be
programmed:

e If the Scan switch is disabled by programming, the
SCN TYPE menu parameter can be used to select
one of the three preceding modes.

e Ifboth the Scan switch and menu parameter are
disabled, scanning is fixed in the programmed
default condition.

o [f the SCN TYPE menu parameter is disabled, the
user can enable only the type of scanning selected
by programming.

2.7.3 LTR-NET MODE SCANNING

When an LTR-Net system is selected, scanning is
always the single locality (site) type. Therefore, LTR
and conventional systems are not scanned. Calls are
detected on all LTR-Net systems in the scan list that
are programmed for that locality. LTR-Net systems
programmed for other localities are not scanned even
if they are in the scan list. Roaming occurs while scan-
ning if it is enabled by the menu parameter or option
switch, and priority calls are detected (Section 2.8.1).

If the selected system is an LTR or conventional
system, all programmed systems in the scan list are
scanned (including LTR-Net), and roaming is disabled.
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2.7.4 LTR MODE SCANNING

With LTR mode scanning, the home repeater of

switch. If this switch is not programmed, scan list
programming is not available. The scan lists can be
programmed even if scanning is not enabled. The

each LTR system in the scan list is scanned. Scanningdisplayed system is in the scan list and scanned

is sequential through all LTR systems in the scan list.
If several positions are programmed with the same
LTR system, system information is loaded only once.
Therefore, there is no delay to change systems which
results in very efficient scanning of those positions.
Each home repeater is scanned for only as long as

normally when|§| is displayed, and the displayed
group is in the scan list and scanned normally when
@ is displayed (see illustration on page 3-14).

The system/group select mode described in
Section 2.4.5 controls if the system or group scan list is

necessary to detect all calls. Priority calls are detected changed when the A/D switch is pressed. If this switch

on LTR systems while scanning (see Section 2.8.1).
LTR systems are not scanned if an LTR-Net system is
selected (see preceding section).

2.7.5 CONVENTIONAL MODE SCANNING

With conventional operation, the channels of each
conventional system in the scan list are scanned in
order. Call Guard squelch is detected if the monitor
mode is disabled (see Section 2.11.1). If the monitor

is pressed with the system select mode enabled, the
status of the displayed system is changed. Likewise, if
it is pressed with the group select mode enabled, the
status of the group is changed. For example, to change
the status of the displayed system, press the Select
switch if necessary so that the system select mode is
indicated and then press the A/D switch.

Deleting a system only temporarily deletes the
groups associated with that system. When a system is

mode is enabled, all calls occurring on a scanned chanadded back into the scan list, the original group scan

nel are received. Conventional systems are not

list is again active. Systems and groups can be deleted

scanned if an LTR-Net system is selected (see Sectionfrom the scan list while listening to a message on the

2.7.3).

A feature called Adaptive Tone Scan (ATS) is
used when scanning conventional channels. If no
carrier is detected, the channel is scanned for only 40
ms. If a carrier is detected, searching for Call Guard
signaling occurs (if programmed). If the tone type of
Call Guard squelch is programmed, the channel is
monitored for 180-420 ms. The shorter time is when
the tone is outside certain limits, and the longer time is
if it is at or near the programmed value. If digital type
is programmed, approximately 350 ms is required to
determine an invalid code (less time is usually
required to detect valid codes).

2.7.6 SCAN LIST PROGRAMMING

NOTES: Calls are always detected on the revert
(selected) system/group while scanning even if it is
deleted from the scan list.

Deleting LTR-Net systems from the scan list also
deletes them from locality searching when roaming
even when scanning is disabled (see Section 2.9.3).

The system and group scan lists are user
programmable using the A/D (add/delete) option
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system or group by pressing the A/D switch in the
normal manner. Scanning resumes shortly after the
system or group is deleted.

Saving Current Scan List Changes

The menu SCN SAVE parameter or the default
programming of this parameter determines if changes
to the system and group scan lists are saved. If “ON”
is selected, changes are saved to memory as they are
made and the scan list does not change when power is
cycled. If “OFF” is selected, changes are not saved
and the programmed default status is reselected when
power is cycled.

2.7.7 SCAN DELAY AND CONTINUE TIMERS
Receive Delay

When a message is received while scanning, there
is a programmable delay of 0-7 seconds before scan-
ning resumes. This delay is called the Receive Delay
Time, and it prevents another message from being
received before a response can be made. This delay is
also in effect if a control is changed while scanning
such as selecting another system/group. This timer is
reset each time another call is received.
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NOTE: Scanning does not resume if it is disabled,
such as by taking the microphone off-hook.

Call Delay Time

The receive delay time controls the scan delay
until the transmitter is keyed and then the Call Delay
Time controls the delay. This time is programmable
for 0-7 seconds, and it ensures that a response to your
message is heard instead of some other message occur-
ring on another system/group. The Call Delay Timer
remains active for the remainder of the conversation,
and controls when normal scanning resumes, even if
additional responses are received.

Scan Continue Timer

There is also a scan continue timer that can be
programmed. This timer controls the maximum time
that a call is received before scanning resumes. This
prevents scanning from being delayed for long peri-
ods by lengthy calls. This time can be programmed for
0-60 seconds in 1-second steps. If “0” is programmed,
there is no time limit and the entire message is always
received. If the menu SCN CONT parameter is avail-
able, this feature can be turned on and off by the user
(see Section 2.6.2).

2.7.8 TRANSMITTING IN THE SCAN MODE

When the transmitter is keyed in the scan mode,
programming of the “Scan Revert Mode” radio param-
eter determines if the transmission occurs on the last
selected or the received system/group. The display
usually indicates the system/group on which a trans-
mission occurs. An exception is when “last selected”
is programmed and a call is being received on a
system/group other than the selected.

The three programmable Scan Revert Mode
configurations are as follows. When an LTR-Net/LTR
priority call is received (see Section 2.8.1), this
programming also determines if a response occurs on
the displayed or selected group, even if scanning is
disabled.

Last Selected - Transmissions always occur on the
system/group that was last selected by the CHL (low
tier) or Select (high tier) switch. To respond to a call
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not on the selected system/group, one of the following
methods can be used:

e Select the system/group of the call manually using
the CHL or Select switch.

e Before scanning resumes, exit the scan mode by
pressing the SCAN switch. The system/group of the
call then becomes the selected system/group and it
is not necessary to change it manually.

Last Received - The selected system/group changes to
the system/group of a call. Therefore, you can always
respond to a call without having to manually change
the system/group. To return to the previously selected
system/group, the CHL or Select switch must be used
to manually select it. This mode may produce undesir-
able operation with group tracking (Section 2.4.5).

Temporary Last Received - The display changes to
the system/group of a call for only the duration of the
scan delay period described in Section 2.7.7. Then
when the delay expires and scanning resumes (if not
disabled, for example, by taking the microphone off-
hook), the selected system/group is again displayed.
Therefore, you can respond to a call without changing
the selected system/group as long as you do so before
scanning resumes.

2.8 LTR-NET AND LTR FEATURES

2.8.1 RECEIVE PRIORITY CALLS

This transceiver uses a different receive priority
scheme than has been used with other EFJohnson LTR
transceivers. Instead of programming one or two fixed
priority ID codes, each selectable group is assigned a
priority number. That number then determines if a call
on that group can interrupt a call on another group in
that system.

The following priority information is
programmed for each LTR-Net and LTR group:

e FEach LTR-Net and LTR group is assigned a priority
number from 1-8.

e Fach LTR-Net and LTR group can be programmed
as interruptible or not interruptible.
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The highest priority is programmed by “1”” and
the lowest priority by “8”. If a call is detected on the
selected group or on any group of the selected system
with a priority higher than the selected group, it is
received. System or group scanning do not need to be
enabled for this to occur.

Likewise, if a call is being received on a group
programmed as interruptible and a call is detected on a
group with a higher priority, the current call is imme-
diately dropped and the higher priority call received.

If calls on certain groups are not to be interrupted
by higher priority calls, the group can be programmed
as not interruptible. For example, if telephone calls are
not to be interrupted, the Telco group can be
programmed as not interruptible. This has the same
affect as programming the Telco group with a “1”
priority. However, if this was done instead of program-
ming it as not interruptible, calls on the Telco group
would interrupt all other lower priority calls which
may not be desirable.

The transceiver displays the system and group of
the priority call while it is being received. The
programming of the “Scan Revert Mode” parameter
(see Section 2.7.8) determines if the change to the
priority group is temporary or permanent and if a
transmission occurs on the priority group.

With LTR-Net operation, incoming call informa-
tion is received on the repeater to which a mobile is
trunked as well as the home and status repeaters.
Therefore, priority calls are detected when the trans-
ceiver is trunked to other repeaters.

With LTR operation, incoming call information is
received on only the home repeater. Therefore, priority
calls are not detected while trunked to some other
repeater. To reach most mobiles with a priority
message in this case, the operator can key the transmit-
ter and then not begin speaking for several seconds.
This allows trunked-out mobiles time to finish the
transmission and return to the home repeater.

This still may not reach mobiles making tele-
phone calls because they hold a repeater for the dura-
tion of a conversation (instead of the duration of the
transmission as with dispatch calls). Other times when
priority calls could be missed are with both types of

operation are when some other system not
programmed with the priority ID is being monitored
and while transmitting.

2.8.2 BLOCK ID CODES AND ACCESS
PRIORITY

This transceiver does not use block ID codes.
However, with up to 99 groups programmable per
system and group scanning, it is usually possible to
program the transceiver to receive all desired calls.

Access priority, which controls which transceiv-
ers can access the system during busy periods, is not
available with this transceiver. The preceding section
describes receive priority which controls which calls
are received.

2.8.3 STANDARD GROUP CALLS

Standard group (dispatch) calls are between
mobiles or groups of mobiles which use the standard
group ID codes from 1-239 (LTR-Net) or 1-250 (LTR)
that are assignable to each home repeater. LTR-Net
and LTR standard calls are very similar and are placed
and received using the same procedure. Simply select
a group programmed with the ID code of the mobile
being called and then press the PTT switch. No num-
ber is dialed with a DTMF keypad as with telephone
or special calls.

To receive a standard group call, the group pro-
grammed with the ID code being transmitted must be
selected or scanned. Also, calls with a higher priority
than the selected group are always received as
described in Section 2.8.1. The procedure used to
place and receive these calls is described in Section
2.4.10.

2.8.4 TRANSMIT INHIBIT

This feature prevents the transmitter from keying
if the mobile being called is busy with another call. To
enable this feature, the LTR-Net or LTR system is pro-
grammed with a block of transmit inhibit ID codes that
can include up to all 239 or 250. If a code within this
block is detected up to 5 seconds before the PTT
switch is pressed, the transmitter does not key, the
intercept tone sounds, and “TX INHIB” is displayed.
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To make another call attempt, the PTT switch
must be released and then pressed again. Although the
5-second timer does count down while the PTT switch
is pressed, it is not possible to complete the call by
holding the PTT switch down until the intercept tone
stops sounding.

Another use of this feature is to prevent the acci-
dental interruption of a call in progress. This could
happen when the transmitting party unkeys. It can also
provide an indication that the mobile being called is
busy. A similar Transmit Disable On Busy feature is
available on conventional systems.

2.8.5 TELEPHONE SYSTEM/GROUP SELECT

If the Telephone option switch is programmed, it
can be used to quickly select the group programmed
for telephone calls. When a telephone group or LTR-
Net Auxiliary call group is selected, '." is displayed.
If more than one LTR group is programmed for tele-
phone calls, the first higher numbered telephone group
is selected. If there is no telephone group or a conven-
tional system is selected, “NO PHONE” is displayed
and an error tone sounds.

2.9 LTR-NET FEATURES

NOTE: For more information on LTR-Net operation,
refer to Section 2.4.8.

2.9.1 SPECIAL CALLS
Introduction

Both standard and special calls can be placed and
received with LTR-Net operation (standard calls were
described in Section 2.8.3). The special calls origi-
nated by the mobile include Telephone and Auxiliary
(see following information). When a group pro-
grammed for either of these calls is selected, Oil is
displayed.

Most other special calls such as Interrogate,
Mobile Disable, and Reassignment are originated by
the system operator or a dispatcher. Special LTR-Net
calls use the special call group ID codes from 240-254.
An optional DTMF microphone and special program-
ming are required to place special calls.
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Mobile-Originated Special Calls

Telephone (Telco) - These are interconnect calls to or
from a mobile made through the Public Switched Tele-
phone Network (PSTN).

Auxiliary - These calls allow a mobile to communicate
with specific mobiles or groups at the same locality
(site) or another LTR-Net locality (when several LTR-
Net repeater systems form a network). Calls to specific
mobiles are called Unique ID calls, and calls to specific
groups are called Directed Group calls.

Directed Group calls allow communication with
groups that are otherwise not accessible because no
selectable system has been programmed with the home
repeater or group ID of those mobiles. Directed Group
calls can be made to any home repeater on any group
ID code from 1-239.

Data - This call allows data transmissions to be made

to a specific unique ID. This call is currently not
available.

Transceiver Programming For Special Calls

To originate a special call and then respond, the
selected group must be programmed for the special
call being made (Telephone or Auxiliary). The pro-
gramming software automatically loads the correct ID
codes for these calls. Refer to the following chart for
more information.

Originating Mobile Receiving Mobile
Type of Call Encode/Decode ID| Decode/Encode ID
Telephone Telephone Telephone
Auxiliary
Unique ID | Auxiliary Auxiliary
Dir Group | Auxiliary Group ID

To receive Telephone and Unique ID calls and
then respond, one of the selectable groups must be
programmed for the applicable call (Telephone or
Auxiliary). These calls are received regardless of
which group is selected or group scan programming.
All that is required is that a group be programmed for
the call and the system be selected or scanned. The
transceiver temporarily or permanently changes to the
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group programmed for the call depending on scan
revert programming (see Section 2.7.8).

To receive a Directed Group call and respond, a
selected, priority, or scanned group must be pro-
grammed for the group ID specified by the originating
mobile. This is because the call is converted to a stan-
dard group call by the switch.

To receive landside originated telephone calls, the
transceiver must be programmed for telephone calls
even though the unique ID of the mobile may be speci-
fied when placing the call (see “Landside-Originated
Calls” which follows).

Special Call Authorization

When a mobile is programmed to make Tele-
phone calls, system authorization is needed before ser-
vice is available. This authorization is performed by
the system operator through the System and Sub-
scriber Manager, and it determines what type of ser-
vice is available. For example, a mobile may be autho-
rized to dial local numbers only. This authorization is
keyed to the mobile’s unique ID which is transmitted
when any call is made.

Authorization is also required to make auxiliary
calls. Unique ID calls can be made to any mobile in
the same locality (site) or some other locality that is
programmed for Auxiliary calls. The same applies to
Directed Group calls except that the mobile receiving
the call does not need to be programmed for Auxiliary
calls, just the standard group ID being transmitted.

Placing a Special Call

The following is the procedure for placing a spe-
cial call. An optional DTMF microphone is required to
place this call.

1. Select the group programmed for Telephone or Aux-
iliary calls, whichever is to be made. When a group
programmed for either of these calls is selected,

& is displayed.

Press the PTT switch and when the system is
accessed, the proceed tone sounds (if tones are
enabled). Release the PTT switch and a dial tone
should be heard. Busy conditions and successful and
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3.

unsuccessful accesses are indicated as described in
Section 2.4.10.

If atelephone call is being placed, dial the telephone
number of the landside party you are calling.

. If aunique ID or directed group call is being made,

a 1-10 digit number is dialed which specifies the
destination of the call. This number is entered the
same as with telephone calls. The digits dialed for
the various types of calls are as follows:

Unique ID Call (Current Locality)
1-5 digit unique ID of mobile/dispatcher

Unique ID Call (Directed Locality)
3-digit locality ID +
5-digit unique ID of mobile/dispatcher

Directed Group Call (Current Locality)
3-digit home repeater number +
3-digit group ID

Directed Group Call (Directed Locality)
3-digit locality number +

3-digit home repeater number +

3-digit group ID

Unique ID Call (Using Telephone Number)
10-digit telephone number or mobile being called

NOTE: Mobile-to-mobile unique ID calls can also
be placed by dialing the mobile s telephone number
if it has one.

. Release the PTT switch if it was pressed to dial the

number. A beep should then sound which indicates
that the number was accepted by the system. If this
beep does not sound, an unauthorized number may
have been dialed or a dialing mistake may have been
made. If a system resource busy condition exists, the
call is placed in a queue by the system (see Section
2.9.2).

The various types of calls then proceed as follows:

Telephone Call - The normal landside ringing or
busy tone is heard. When the party answers, press
the PTT switch to talk and release it to listen as with
standard calls.
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Unique ID Call - A “ringing” tone is heard which
indicates that the mobile is being rung. If there is no
answer, ringing stops after several rings or the call
can be terminated by pressing the # key. When the
party answers, press the PTT switch to talk and
release it to listen as with a standard call.

Directed Group Call - A second beep sounds
which indicates that the path to the mobile is com-
plete and speaking can begin (no ringing of the other
mobile occurs). Press the PTT switch to talk and
release it to listen.

NOTE: Since this transceiver operates half-duplex,
you cannot hear the other caller while transmitting
or speak to the other caller while receiving.

7. When the call is finished, terminate it by pressing
the # key. This tells the system that the call is com-
plete and prevents additional billing for the time
required by the system to automatically detect the
end of the call.

Receiving Special Calls

To receive a special call, all that is required is that
the system programmed for the special call be selected
(see information at the beginning of this section).
When a Telephone or Unique ID call is received,
“ringing” is heard. If it is a Directed Group call, only
the voice of the calling party is heard because no ring-
ing occurs.

Landside-Originate Special Calls

Calls can be also be made from any landside tele-
phone to specific mobiles (Unique ID calls) or groups
(Directed Group calls). Calls can also be placed to
other sites similar to when they are mobile dialed.

If the system has DID lines, the landside caller
can dial a mobile directly because each mobile that
can receive these calls is given its own phone number.
If the system has standard trunk lines, the telephone
number of the system is dialed. Then when the system
answers, a short tone sounds to indicate that the digits
specifying the destination of the call should be dialed.
The same digits are dialed as described in “Placing a
Special Call”. The landside telephone must produce
standard DTMF tones to dial these digits.
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After these digits are dialed, a beep is heard
which indicates that the number was accepted by the
system. Ringing then indicates that the mobile is being
rung unless it is a Directed Group call. With those
calls, no ringing of the mobile occurs and another beep
is heard which indicates the path is complete and
speaking should begin.

After the mobile answers, the landside party
should respond in the normal manner. Remember that
the mobile is operating half duplex and cannot hear the
landside party while transmitting. When the call is fin-
ished, it should be terminated by the mobile party.
Three beeps indicate that the call has terminated.

2.9.2 BUSY QUEUING/FREE SYSTEM
RINGBACK

This transceiver does not have a feature that
places a call in a queue if all channels are busy. In
addition, it does not have a free system ringback
feature that alerts the user when the repeater system is
no longer busy.

However, busy queuing may be provided at the
system level for telephone, unique ID, and directed
group calls (not standard group calls). If this feature is
enabled by the System and Subscriber Manager and
resources are not available when one of these calls are
placed, a voice message informs the user that the call
has been placed in a queue. This message occurs when
the PTT switch is released after dialing the digits.

If resources then become available, the call is
automatically placed and the normal ringing or beep
tones are heard. If the call cannot be placed in the
allotted time, it is terminated and another voice
message informs the user that this has occurred.

2.9.3 ROAMING (AUTO-REGISTRATION)
General

The roaming (auto-registration) feature permits
all types of LTR-Net calls to be automatically routed
to the LTR-Net locality (site) in which the mobile is
operating. To utilize roaming, the following are
required:

e An LTR-Net system must be selected.
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e Roaming must be enabled by the ROAM option
switch, ROAMING menu parameter, or program-
ming (if the option switch and menu parameter are
not available).

system scanning is enabled, an LTR-Net system
must be selected. If an LTR or conventional system
is selected, roaming is disabled.

When roaming is enabled or disabled by the
option switch, either “ROAM ON” or “ROAM OFF”
is momentarily displayed to indicate the current mode.
With the menu mode, either “ON” or “OFF” is
selected as described in Section 2.6.2. If communica-
tion is to be maintained on the current locality regard-
less of signal strength, turn roaming off.

Registering on a New Locality

When power is turned on with roaming enabled,
registration is attempted on the currently selected
locality every 5 seconds if there is a free channel. The
registration message includes the mobile’s unique ID
and the home repeater to be used. The registration

information is forwarded to the System and Subscriber

Manager which then knows its location.

If roaming was disabled when power was turned
on and then later enabled, registration on the current
system does not occur until a special event such as
transmitting, changing systems, or receiving a call
occurs. Therefore, the user may want to briefly press
the PTT switch after turning roaming on.

If the signal from a locality becomes weak (see
“Dropout and Capture Parameters” which follows) or

If no localities are found on the first pass that
have a high enough signal level, the locality that was
just dropped is added back into the search list and all
localities in the scan list are checked using the Capture
setting programmed for each locality. The display

Scanning does not need to be enabled. However, if indicates “LCL SRCH", and searching continues until

a strong enough locality is found. If none are found
before the PTT switch is pressed again, the transmis-
sion is attempted on the last registered locality, and
searching resumes when the transmission ends.

De-Registering

If an LTR-Net system is selected when power is
turned off, a de-registration message is automatically
sent that tells the system that the mobile is no longer in
service. This increases system efficiency by reducing
the number of system resources used in trying to reach
out-of-service mobiles. Transceiver power is automati-
cally held on until this message is sent. If power to the
transceiver is switched off immediately, such as by a
relay, this message cannot be sent.

Revert System/Group Selection After Registration

After registration on a new locality occurs, “LCL
SRCH?" is no longer displayed and the system of the
new LTR-Net locality is displayed. The new system is
the next higher system with a different locality that
could be accessed. For example, if System 3 was
selected and System 5 is the next higher system with a
different locality number, that becomes the selected
system if it can be accessed (wrap-around occurs after
the highest system is checked).

The selected group does not change when regis-
tration on a new site occurs. This allows registration

if two consecutive unsuccessful access attempts occuron a new locality to be nearly transparent to the user.

(“NO ACCES” displayed), the transceiver begins
automatic locality search. The unsuccessful access

Therefore, when programming the transceiver, the
same group programming should be used in all LTR-

counter is reset whenever power is cycled, the selected\et systems that a mobile roams into. If the same

system is changed, or a successful access occurs.

During locality search, the status channels of
other LTR-Net localities in the system scan list are
checked (see Section 2.7.6). During the first pass,
“HSQ SRCH” (High Squelch Search) is displayed, the
locality that was just dropped is not checked, and the
Tight Squelch setting programmed for each locality is
used (see “Dropout and Capture Parameters” which
follows).
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group is not programmed in the new system, the last
selected group on the new system is selected. A call
can be received on the new locality before registration
occurs if the call is already active on the new locality.

Dropout and Capture Parameters

The transceiver squelch is used to control when
searching for a new site begins and also when registra-
tion on a new site occurs. A reference squelch level is
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set during alignment as described in the service manual2.9.5 TRANSCEIVER DISABLE

(see Section 1.5.4). In addition, three squelch levels

called Dropout, Capture, and Tight Capture Percentage If a mobile is lost or stolen or is being used to
are programmed for each locality (see Table 3-3). interfere with communication, it can be temporarily or
These levels automatically tighten the squelch setting permanently disabled by the system operator.

in certain operating modes. The tightened amount is

the programmed percentage of the difference between A mobile can be temporarily disabled by trans-

the reference level and the maximum tight setting mitting the Sleep command to the unique ID of the
(equivalent to rotating a squelch knob fully clockwise). affected mobile. When a transceiver receives this
These squelch levels function as follows: command, SLEEPING is displayed continuously on
the lower line and no calls can be received or transmit-
Dropout Percentage -This is the percentage that ted. However, registration on new localities continues

squelch is tightened when not in a call. This prevents normally.The transceiver can be re-enabled again by
the transceiver from staying on a weak locality when the system operator by sending an Interrogate
another stronger locality may be nearby. The default message. This is indicated when the display returns to
level is 33%, and setting higher levels may cause moreits normal mode.

missed calls during weak signal periods. If there is no

other site nearby, this parameter should be 0%. A mobile can be permanently disabled by sending
the Kill command to the unique ID of the affected
Tight Capture Percentage -This is the percentage mobile. The transceiver then responds that it has

the squelch is tightened during the first pass when received this message and then permanently disables
searching for a new site (HSQ SRCH displayed). This itself. It is then totally inoperative and CALL SVC is
parameter should always be greater than or equal to displayed continuously. It must then be brought back
the Capture Percentage which follows, and it ensures in for reprogramming to make it operational again.
that registration occurs on a strong locality if there is

one. The default level is 80%.

Capture Percentage -This is the percentage that

squelch is tightened on the second and later passes 2.9.6 HOME CHANNEL ALIASING

when searching for a new site (LCL SRCH displayed).

This parameter should always be greater than or equallntroduction

to the Dropout Percentage, and it ensures that registra-

tion occurs on a stronger site. The default level is 46%. The home channel aliasing feature increases the
number of standard group calls programmable on a

NOTE: The transceiver uses the value programmed locality. It does this by allowing calls to be

for the locality being sampled, not the value programmed on non-existent home repeaters. There-

programmed for the locality which was just dropped. fore, instead of being limited to just the 239 ID codes
on each active home repeater, group calls can be

2.9.4 OVER-THE-AIR LOCALITY CHANNEL programmed on each of the 20 home repeaters allowed
UPDATES per locality (the twentieth repeater is usually the status
repeater which is typically not assigned as a home
Localities are initially programmed with the repeater). This permits up to 20 x 239 or 4780 group
channel numbers of all repeaters currently in use. calls on each locality.
These are then the channels that the transceiver can
access when placing and receiving calls. If new chan- The active repeaters on each locality are desig-

nels are later added to a locality, over-the-air program- nated by locality programming (see Section 3.6.8).
ming is used to update the transceivers with the new Active repeaters are programmed with a frequency and
channels. This eliminates the need to bring them in for have the Active box checked. Inactive repeaters have

reprogramming. Channel updates occur on only the Active box unchecked. If repeaters are later added,
selected repeaters, and they are initiated automaticallythey can be added to the locality by over-the-air

by the radio system. programming (see Section 2.9.4).
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NOTE: Since this feature does not increase system  2.10 LTR FEATURES
capacity, adding too many users may result in unsatis-
factory operation due to frequent busy conditions. 2.10.1 GENERAL LTR FEATURES

Operation With Home Channel Aliasing LTR operation is described in Section 2.4.8. The
two types of calls that can be placed with LTR opera-
If a system programmed with a non-existent tion are Group and Telephone. Standard Group calls

home repeater is selected, the next lower active home and other common LTR and LTR-Net features are
repeater is monitored for incoming calls and go-to described in Section 2.8. LTR telephone calls and
repeater information. For example, if home repeater 6 other unique LTR features are described in the infor-
is programmed on the selected system and the active mation which follows.

repeaters are 1, 10, and 20, repeater 1 is monitored. In

addition, all other mobiles on that locality with a 2.10.2 LTR TELEPHONE CALLS

selected system programmed for home repeaters 1-9

monitor that repeater. General

If a group call is then placed, the home channel of LTR localities which are set up for LTR telephone
the call is the home channel programmed for the calls have a block of ID codes reserved for RIC
selected system, not the repeater being monitored. Therepeater interconnect) calls. For the transceiver to
call is detected like any other group call (it is received place and receive telephone calls on those localities,
if a system/group programmed for that home repeater/an LTR telephone group must be programed with an
group ID is selected or scanned). ID code from this block. Then when this ID code is

decoded (received) or a telephone group is selected to
make a call, the transceiver enters the telephone oper-
Repeater Number Programming With Aliasing ating mode.

Since the next lower numbered repeater is moni- To place an LTR telephone call, a telephone
tored when a system with a non-existent home repeategroup must be selected; to receive an LTR telephone
is selected, a numbering scheme should be used that call, the telephone ID must be selected or scanned or
equalizes, as much as possible, the gaps between the have a higher priority. An optional DTMF microphone
active repeaters. This equalizes the loading on the is required to dial the telephone number.
active channels.

Since this transceiver operates half duplex, the

When repeater 1 is reached, wrap-around to PTT switch must be pressed to talk and released to
repeater 20 occurs. Therefore, the status repeater is listen the same time as with a dispatch call. Therefore,
always assigned as Repeater 20 and Repeater 1 as arthe mobile user cannot hear the landside caller while
active repeater. This prevents the status repeater fromtransmitting or speak to the landside caller while
being used as a home repeater which is not desirable receiving.
because it then has no backup repeater (see Section
4.6). Examples of repeater numbering schemes are asPlacing an LTR Telephone Call
follows:

1. Turn transceiver power on and set the volume as

No. of Repeaters Numbering described in Sections 2.4.1 and 2.4.2.

1 20 2. Select the system and group programmed for tele-
2 1,20 phone calls. If equipped with a Telephone option

3 1, 10, 20 switch, it can be used to quickly select a telephone
4 1,7,14,20 group (see Section 2.8.5). The telephone symbol

5 1,5, 10, 15, 20 ".‘ is displayed when a group programmed for tele-
10 1,3,5,7,9,11,13, 15,17, 20 phone calls is selected.
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Briefly press the PTT switch to obtain a dial tone. A have this capability). With most systems, a mobile
successful access and busy or no access conditionsiser can be called directly (each has a unique tele-

are indicated as described in Section 2.4.10.

phone number). With others, the mobile being called

must be specified as follows:

When a dial tone is heard, enter the number to be

called in one of the following ways: 1.

e Enter it directly using the 0-9 keys. If too much

time elapses between digits, the call is 2.

terminated.

o If the microphone has a memory, it may be possi-
ble to recall the number from memory and dial it
automatically.

After the number is sent, landside ringing should be
heard (a landside busy condition could also be indi-
cated). When the other party answers, press the PTT
switch and respond. The PTT switch must be
pressed to talk and released to listen, the same as
with standard calls.

3.
. When the call is finished, press the # key to termi-

nate the call. Three beeps indicate that the call has

Dial the number of the radio system in which the
mobile transceiver is operating.

When the system answers, a short tone sounds to
indicate that the number of the mobile being called
should be dialed. This number is usually five digits
long and must be dialed using a tone-type telephone.
The first two digits are the home repeater number of
the mobile, and the last three digits are the telephone
ID code of the mobile. With LTR interconnect
equipment, the first digit must be dialed within 5
seconds of hearing the tone, and no more than 5
seconds must elapse between digits or the call is
terminated.

Ringing is then heard by the landside caller while
the mobile is being rung.

been terminated. Terminating the call in this manner 2.10.3 BUSY QUEUING/FREE SYSTEM

prevents extra billing that may occur for the time
required for the system to automatically detect the
end of the call.

RINGBACK

The LTR free system ringback and busy queuing

features are not available with this transceiver.

Receiving a Telephone Call

1.

2.10.4 SYSTEM SEARCH

Turn transceiver power on and set the volume as
described in Sections 2.4.1 and 2.4.2.

LTR system search is not available with this

transceiver.

Select or scan the system and group programmed for

telephone calls. If equipped with a Telephone option 2.10.5 TRANSPOND

switch, it can be used to quickly select a telephone
group (see Section 2.8.5). When a group

The LTR transpond feature is not available with

programmed for telephone calls is selected, the tele+this transceiver.

phone symbo"." is displayed).

2.11 CONVENTIONAL MODE FEATURES

. When “ringing” is heard, press the PTT switch and

respond. The PTT switch must be pressed to talk andNOTE: For more information on conventional opera-

released to listen as with a dispatch call.

in step 6 of the preceding section.

tion, refer to Section 2.4.8.

. When the call is finished, it should be terminated as 2.11.1 MONITOR MODE

General

Placing a Landside-To-Mobile Telephone Call

The monitor mode temporarily halts scanning and

Calls can be placed from a landside telephone to adisables squelch control features such as Call Guard so
mobile transceiver (if the transceiver and radio system that all activity on a channel to be monitored. To select
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the monitor mode, take the microphone off-hook. The problem, there is the option with this feature to allow
monitor mode is indicated b‘ in the display. transmitting if the correct receive Call Guard tone or
code is detected.
A conventional system must be selected to enable
monitoring. If the microphone is taken off-hook with  2.11.3 RECEIVE-ONLY GROUPS
an LTR-Net/LTR system selected, scanning halts but

monitoring is not selected. Conventional groups can be programmed so that
transmitting is disabled (monitoring only is allowed).
Per Group Monitor Enable/Disable This is done by programming the Tx Option parameter

for “Disabled”. If the PTT switch is pressed with one
Each conventional group can be programmed so of these groups selected, the intercept tone sounds and
that off-hook monitoring is disabled. It is then always “TX DSBL" is displayed.
disabled on that group regardless of the current micro-

phone hanger state. Monitoring then must be 2.11.4 TALK-AROUND
performed by the Transmit Disable On Busy feature
described in the next section. Scanning is still Normally, all transmissions go through a repeater.
controlled in the normal manner by the hook switch  However, there may be times when a user is out of
state. range of the repeater system and unable to talk to
anyone even though the mobile being called may be
If monitoring is not disabled on a group, itis only a short distance away. In this situation, the

enabled by taking the microphone off-hook. If off-hook repeater talk-around feature can be used to transmit on
detection is disabled on a radio-wide basis as describedhe receive frequency so that the transmission does not
in Section 2.4.6, monitoring must be performed by the have to go through a repeater.
following Transmit Disable On Busy feature.
Any conventional group can be programmed for
2.11.2 TRANSMIT DISABLE ON BUSY talk-around. It is then enabled by simply selecting one
of those groups. It is not selectable by an option
The Transmit Disable On Busy feature automati- switch. There is no talk-around indicator unless it is
cally disables the transmitter if the channel is busy indicated by the group alpha tag.
(carrier present) and it has not been monitored before
the PTT switch is pressed. This feature is enabled or 2.11.5 CALL GUARD SQUELCH
disabled on each conventional group by programming.
Introduction
When the transmitter is disabled by this feature,
the busy tone sounds briefly and “DSBL BSY” is indi- Tone, digital, or inverted digital Call Guard
cated on the lower line of the display. The receiver is squelch can be programmed on each transmit and
then enabled while the PTT switch is pressed so that receive channel in any order desired. There is also an
the activity on the channel can be monitored. It is not option to disable the reverse burst or turn-off code on
possible to access a channel by holding down the PTT transmit channels programmed with Call Guard
switch (it must be released to make another attempt). squelch. The reverse burst and turn-off code are
always detected on receive channels programmed with
If this feature is not used or if the channel is being Call Guard squelch (if it is sent).
monitored by an off-hook condition as described in the
preceding section, the transmitter keys even if the The Call Guard squelch feature eliminates
channel is busy. In addition, the transmitter can always distracting messages intended for others using the
be keyed by releasing the PTT switch and then press- channel. This is done by using a subaudible tone or
ing it again within 1 second. digital code to control the squelch. This tone or code is
unique to a user or a group on that channel. This tone
Some repeaters may have delayed drop-out (hangor code is transmitted with the voice signal but is not
time) which causes this feature to disable the transmit-heard because it is in the subaudible range and is atten-
ter even though no busy condition exists. If thisisa  uated by a filter. Call Guard squelch must be used in
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both the transmitting and receiving transceiver to be
functional. When the channel is monitored before
transmitting, Call Guard squelch may be temporarily
disabled by the monitor mode described in Section
2.11.1.

Tone Call Guard Squelch

Tone-type Call Guard squelch utilizes subaudible
CTCSS tones from 67-254.1 Hz. Although there are
42 tones assigned, those above 33 are normally not
used because of their close proximity to the voice band
which starts at 300 Hz. In addition, tones 11, 39, 40,
41, and 42 are normally not used because they may
cause interference with adjacent tones (see Table 3-2)

2.11.6 EXTERNAL ENCODERS AND
DECODERS

External encoders and decoders are not currently
supported by the operating software.

2.12 SUPERVISORY TONES AND DISPLAY
MESSAGES

2.12.1 GENERAL TONES

. The following tones are heard at various times

A reverse burst can be transmitted when the push-to- when operating this transceiver. Some or all of these

talk switch is released to eliminate the squelch tail
(noise burst) in the receiving transceiver. However,
both the transmitting and receiving transceiver must be
equipped with this feature for it to be utilized. The
reverse burst is a 180-degree phase reversal for a
period of time determined by the tone frequency.

Digital Call Guard Squelch

Digital Call Guard squelch (CDCSS) uses digital

data instead of subaudible tones to control the squelch.

This data consists of continuous repetitions of 23-bit
words. No bit or word synchronization information is
used. When the push-to-talk switch is released, a turn-
off code is transmitted which eliminates the squelch
tail similar to the reverse burst.

Although there are thousands of possible code
combinations with 23 bits, only 83 are unique with the
data scheme used. The number specified when the
code is programmed is actually a seed for a special
algorithm used to generate the 23-bit data word. The
data is transmitted at a rate of 134.4 bits per second.
Therefore, approximately six words are transmitted

tones can be disabled by the user if the menu
“TONES” parameter is available (see Section 2.5.15).
If the menu parameter is not available, these tones can
be selected only by the programmer.

Busy Tone -This tone is similar to the standard tele-
phone busy tone, and it indicates that the LTR radio
system is currently busy. It is produced by turning
combined 480 and 620 Hz tones on and off at a 4 Hz
rate. This tone sounds with all types of LTR-Net/LTR
calls (even if the proceed tone is enabled), and
“BUSY” is indicated on the lower line of the display

when it sounds. It does not sound on conventional

systems.

No more access attempts are made once this tone
sounds. The PTT switch must be released and then
pressed again to make another attempt. Therefore, it is
not possible to access the system by holding the PTT
switch down with this tone sounding.

Intercept Tone - This is a siren-like tone (alternating
high and low tones) consisting of 700 Hz and 800 Hz
tones alternating at approximately a 2 Hz rate. This

each second. When the data is decoded, 23-bit sampletone indicates the following no access and error
are taken and then the bits are rotated to determine if aconditions:

valid code was received.

Digital Call Guard squelch can be programmed as
normal or inverted. The only difference is that the
waveform is inverted when “iDCG” is selected. The
inverted type may need to be programmed if the signal
is inverted by the repeater or another transceiver. If
digital Call Guard squelch does not function, try
changing to the other type.
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e No Access If this tone sounds 2-3 seconds after
pressing the PTT switch and “NO ACCES” is
displayed, the data handshake with the repeater
could not be completed. The usual cause is an out-
of-range condition. Six attempts are made before
this tone sounds. No more access attempts are then
made until the PTT switch is released and pressed
again.
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Time-Out Timer- If this tone sounds after the trans-
mitter has been keyed for an extended period and
“TIMEOUT” is displayed, the transmitter has been
disabled by the Time-Out Timer feature (see Section
2.5.14). This tone sounds in all operating modes.

Transmit Inhibit- If this tone sounds as soon as the
PTT switch is pressed with an LTR system selected
and “TX INHIB” is displayed, the transmitter has
been disabled by the Transmit Inhibit feature (see
Section 2.8.4).

Receive-Only Channellf “TX DSBL”" is displayed
when this tone sounds, a conventional receive-only
channel is selected (see Section 2.11.3).

Tx While Receiving Calt If the push-to-talk switch
is pressed while receiving an LTR call, this tone
sounds and “DSBL BSY” is displayed.

Proceed (Clear-To-Talk) Tone -This is a short (700
Hz, 50 ms) tone which sounds after the handshake is
complete to indicate when talking can begin (see
Section 2.5.11).

Key Press Tone -This is a short (700 Hz, 50 ms) tone
that sounds to indicate when an option switch is
pressed (in all modes).

Wrap-Around Tone - A 700 Hz, 80 ms tone followed
by an 800 Hz, 80 ms tone which indicates that the
highest or lowest programmed system or group was
displayed and that wrap-around has occurred (see
Section 2.4.5).

Error Tone - A 1050 Hz, 80 ms tone followed by a

700 Hz, 80 ms tone which indicates that an error
condition occurred.

2.12.2 LTR-NET SPECIAL CALL TONES

NOTE: The following tones are produced by the LTR-
Net switch and are heard only when placing special
calls.

Confirmation Tone - A short tone which sounds
when the number just dialed is accepted by the system
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Call Proceed Tone -With LTR-Net Directed Group
calls, ringing does not occur after the number is dialed.
Instead, this short tone sounds after the confirmation
tone to indicate that the audio path is complete and
speaking can begin.

End Call Tone - Three beeps which sound when the
end of the call has been detected by the system.

Proceed Dialing Tone -When placing a landside-
originate call to a mobile, the caller may dial the
number of the system and then when the system
answers, a humber specifying the mobile being called.
This tone sounds to indicate when the number of the
mobile should be entered (see Section 2.9.1).

2.12.3 LTR TELEPHONE CALL TONES

The following tones are generated by the LTR
interconnect equipment and are heard when making
LTR telephone calls.

Reorder Tone -Three beeps which indicate that the
call has been terminated by the system.

Return Time Warning Tone - Two beeps which warn
that you have not transmitted for an extended period.
If you do not transmit within 5 seconds, the call is
automatically terminated by the system. The time
between transmissions is one of the parameters used
by the system to detect the end of a call when the #
character is not sent.

Conversation Time-Out Tone -Calls are limited to a
certain length by the system. Thirty seconds before
this time is reached, a “tick” begins sounding each
second. When the 30-second time expires, the call is
automatically terminated by the system.

Turn-Around Tone - This is a single beep which may
be used to indicate to the landside party when to
respond to your transmission. It sounds when you
release the PTT switch, and you may patrtially hear this
tone.

Proceed Tone -This tone consists of two beeps and it
tells the landside caller when to enter the five-digit
number specifying the mobile being called. Dialing of
this number must be started within 5 seconds of hear-

ing this tone, and a tone-type telephone must be used.
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2.12.4 DISPLAY MESSAGES

The following messages appear in the display to
indicate various operating modes and error condi-
tions. Selected system/group information appears in
this display during normal operation (see Section
2.4.4).

98xx6xx -On power up, the last seven digits of the

NO PHONE - Indicates that there is no telephone
group programmed in the current system when the
TEL option switch is pressed (Section 2.8.5).

NO POWER - Indicates that the transmitter tempera-
ture is excessive or that the supply voltage is too high
and the transmitter has been shut down (see Section
2.5.16).

transceiver part number (see Section 1.4) are displayedNOT AUTH - Indicates that an attempt to register was

on the top line very briefly. For example, a 800 MHz,
high tier, LTR-Net, 15-watt transceiver is indicated as
“90883602". The eighth display digit is reserved for
future use and is always “0”.

* CODE xx - Indicates that an error condition has
occurred. It is displayed very briefly on the bottom
line at power up (see Section 2.14).

BUSY - Indicates that the LTR-Net/LTR radio system
is currently busy (see “Busy Tone” in Section 2.12.1).

CALL SVC - Indicates that the transceiver has been
totally disabled by an over-the-air message from the

system operator. To return the transceiver to service, it

must be reprogrammed (see Section 2.9.5).

DSBL BSY - Indicates that the transmitter is disabled

by the conventional Transmit Disable On Busy feature

made on a locality where service was not authorized
(see Section 2.9.3).

NOT CONYV - Indicates that an attempt was made to
enable a conventional mode feature on an LTR-Net or
LTR system.

NOT LNET - Indicates that an attempt was made to
enable an LTR-Net function on an LTR or conven-
tional system.

OUT-LOCK - Indicates that the synthesizer is
unlocked. The transceiver is nonfunctional until lock
is re-established.

PROG ERR - Indicates an EEPROM read error.
Check transceiver programming or the EEPROM if
this condition persists (see Section 3.7).

(see Section 2.11.2). It also indicates that the transmit-PRG MODE - Indicates that the transceiver is being

ter was keyed while receiving an LTR call.

FCN - Indicates that the function select mode is
selected by the FCN switch (see Section 2.5.6).

HSQ SRCH -Indicates the transceiver is currently on
the first pass while searching for a new locality on
which to register (see Section 2.9.3).

LCL SRCH - Indicates the transceiver is currently on
the second or later pass while searching for a new
locality on which to register (see Section 2.9.3).

NO ACCES - Indicates that the repeater system could
not be accessed, perhaps because of an out-of-range
condition. Once this indication appears, no more
access attempts are made until the PTT switch is

programmed (see Section 3.7).

SLEEPING - Indicates that the transmitter has been
temporarily disabled by an over-the-air message from
the system operator (see Section 2.9.5).

SQUELCH - Indicates that the conventional squelch
adjust mode is selected (see Section 2.4.7).

TIMEOUT - Indicates that the transmitter has been
disabled by the Time-Out Timer (see Section 2.5.14).

TYPE ERR - Indicates that the programming data is
incompatible with the transceiver (see Section 3.7).

TX DSBL - Indicates that the selected conventional
system is programmed for monitoring only (see

released and then pressed again (see Section 2.12.1).Section 2.11.3).
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TXINHIB - Indicates that the transmitter has been
disabled by the Transmit Inhibit feature (see Section
2.8.4).

2.12.5 MENU MODE MESSAGES

The following messages are displayed in the
menu mode that is described in Section 2.6. Enabled
or yes is indicated by “ON”, and disabled or no by
“OFF".

BACKLGT - Backlight
e BRIGHT
e DIM
o OFF

BANK SEL - Bank select
e Alphatag of programmed banks

OPTION - Option on-off
¢ ON orOFF

ROAMING - LTR-Net roaming on-off
e ON or OFF

SCN CONT - Scan continue on-off
e ON or OFF

SCN SAVE -Scan list save
e ON =saveOFF = not saved

SCN TYPE - Selects type of scanning
e SYSTEM - Both system and group
e GROUPS -Group scanning only
e OFF - Scanning off, switch disabled

S/G DISPL - Sys/grp display mode
e ALPHA
e NUMERIC

STEALTH - Stealth mode select
e ON or OFF

TONES - Tone type select

e SILENT - No tones sound

e KEYS - Only the Select switch and key press
tones sound

e ALERTS - Alltones except preceding Key Beep
tones sound

e ALL - The preceding Key Beep and Alert tones
sound
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2.13 TEST MODE
2.13.1 GENERAL

This transceiver currently does not have a test
mode that can be selected to perform transceiver test-
ing. To manually control the transceiver, program
conventional channels.

2.13.2 DISPLAYING SOFTWARE REVISION
NUMBER

To display the software version number, turn
power on with the top two switches to right of display
pressed. The version number is displayed on the
bottom line as “VER x.xx" (see following illustration).

2.14 ERROR CODES
2.14.1 GENERAL

If error conditions occur during operation that
interrupt normal program execution, reset occurs
which usually restores normal operation, and informa-
tion on the error condition is stored. Up to 11 error
conditions can be stored. If more than 11 occur, the
first 10 continue to be stored and only the 11th code is
overwritten so it is always the most recent code. An
error condition can be caused by such things as a
defective memory chip or other hardware problems or
software problems.

When power is turned on after an error condition
has occurred,* CODE xx” is briefly displayed on
the lower line in addition to the transceiver model
number on the upper line (see Section 2.4.1). The “xx”
indicates the number of the latest unread code.

To display the most recent error code, turn power
on with the top two option switches to the right of the
display pressed. The error code is indicated on the top
line and the operating software version number on the
bottom line. For example, error code “24” and soft-
ware version “2.01” are indicated as follows:

Error Code

Software Version N¢.

April 1999
Part No. 001-9800-600



OPERATION

To mark a code as read, press the Select switch. AConnect the programming setup and then select File >
beep then sounds and the next code is displayed if =~ Read Codes or click thui| jcon in the toolbar (see
applicable. Once all stored codes are marked as read, Section 3.5). ALODE
they can no longer be displayed ard “ CODE xx” is
not displayed at power up. However, they continue to
be stored and can be read using the programmer (see The screen shown in Figure 2-3 is then displayed

next section). which indicates various information about each stored
error code. Contact the Customer Service Department
2.14.2 READING ERROR CODES as described in Section 1 of your service manual for

additional information on the displayed error codes. To
The up to 11 error codes that can be stored can bepermanently erase the current error codes from the
read out of the transceiver using the personality transceiver, click the “Cleak  Codes” button at the
programming software described in Section 3. bottom of the screen.

Code Information
1oC | *coDE | HAME | pomMaIn| oBJECT | EVENT | DaTa | oPT1 | oPT2 | 0PT3 | DESCRIPTICON
0 E6 PANIC ILLEGAL oo oo F1 oooo oo oo 00 Illegal Opcode (Reflash
1 E6 PANIC_ILLEGAL i} oo F1 0000 oo oo 00 Illegal Opcode (Reflash
2 E6 PANIC ILLEGAL oo oo F1 oooo o0 oo il Illegal Opcode (Reflash
3 E6 PANIC ITTEGAT i} oo F1 0000 oo oo 00 Illegal Opcode (Reflash
4 E6 PANIC_ILLEGAL 0o oo F1 0ooo oo oo 00 Illegal Opcode (Reflash
5 E6 PANIC ITTEGAT 00 oo F1 0000 oo oo 00 Illegal Opeode (Reflash
6 D3 DOMAIN_EAD_EVENT 04 03 0o 0ooo oo oo 00 Invalid event was sent
7
g
g
10
4| |

Clear “Cades |

Figure 2-3 Error Code Screen Displayed By Programmer
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SECTION 3 PROGRAMMING

Remote Programming Interface (RPI)

To
Battery To
Ign Sense

To
Antenna

Figure 3-1 Programming Setup

3.1 GENERAL
3.1.1 PROGRAMMING SETUP

The following items are required to program the
transceiver. The part numbers of this equipment are
shown in Table 1-1 in Section 1. The programming
set-up is shown above.

e IBM® PC or compatible personal computer

e EFJohnson Remote Programming Interface (RPI),
Part No. 023-9800-000.

e Cables from the RPI to the computer and radio.

e EFJohnson programming software for 9800-
series transceiver.

3.1.2 MINIMUM COMPUTER REQUIREMENTS

The programming software is designed to run on
an IBM PC or compatible computer that meets the
following minimum requirements:

o Windows 95/98 or NT 4.0 operating system
e 3-1/2” floppy disk drive
e One unused serial port

3-1

The programming software requires a Windows
32-bit operating system such as 95/98 or NT 4.0 to
run. Therefore, a 16-bit operating system such as
Windows 3.1 cannot be used.

Since the program is relatively small (approxi-
mately 500K), it will run properly with the amount of
RAM recommended for the operating system. In addi-
tion, the data files are relatively small (approximately
15K), so minimal hard disk space is required.

3.1.3 REMOTE PROGRAMMING INTERFACE
(RPI)

The RPI provides the required interface between
the computer and transceiver. It converts the RS-232
logic levels from the computer to the TTL logic levels
required by the transceiver microprocessor and vice
versa.

A new RPI (Part No. 023-9800-000) has been
designed for this transceiver. This RPI is backward
compatible, so it can also be used to program most
other EFJohnson transceivers which require an RPIL.
This new RPI is required for Flash programming
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described in Section 3.12, and it has a phone jack for
injecting the transmit audio signal during alignment
(see Section 7 of service manual). Earlier RPI’s, such
as Part No. 023-5810-000 or 023-9750-000, can be
used to perform the standard personality programming
described in most of this section.

When programming this transceiver, the switch on
the front panel of the RPI selects either the standard or
Flash programming mode. The standard mode is
selected when it is away from the LED and the indica-
tor is green, and the Flash mode is selected when it is
toward the LED and the indicator is amber. The stan-
dard mode should be selected for all but Flash
programming.

With remote mount transceivers, this switch is
used to turn transceiver power on and off. A separate
9-16 VDC, 200 mA power supply (such as P.N. 563-
0001-005) must then be plugged into the RPI power
jack to provide power to the RPI.

3.1.4 RPICABLES

The cables from the RPI to the computer and
transceiver are not included with the RPI. The RPI has
a female DB9 connector, and most computer serial
ports have a male DB9 or male DB25 serial connector.
Therefore, either a male DB9 to female DB9 or male
DBY to female DB25 cable is usually required. This is
a standard cable available at most electronic and
computer supply stores. Suitable cables available from
the EFJohnson are listed in Table 1-1.

The cable from the RPI to the transceiver has
modular telephone-style connectors on each end and
plugs into the microphone jack of the transceiver. The
cable for this application is also listed in Table 1-1.

3.1.5 EEPROM DATA STORAGE

Most personality information programmed in the
following sections is stored in the Flash memory
device (U108). In addition, EEPROM U102 is used to
store additional personality information. Other parame-
ters such as alignment settings and current switch
settings are stored in an EEPROM that is part of the
microcomputer chip. Both Flash and EEPROM devices
store data indefinitely without the need for a constant
power supply. The transceiver can be removed from
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the vehicle or even stored on a shelf indefinitely with-
out affecting programming.

If the operating program needs to be updated,
reprogramming is performed using special Flash
programming software and the same setup used for
personality programming. The Flash programming
procedure is described in Section 3.12.

3.1.6 HARDWARE HOOKUP

The programming setup is shown in Figure 3-1.
The RPI-to-transceiver cable is connected from the
modular jack of the RPI to the microphone jack of the
transceiver. The RPI-to-computer cable is connected
from the serial port of the computer to the DB9
connector on the RPI.

The RPI has a switch which selects standard or
Flash modes. Turn on transceiver power and then make
sure that the standard mode indicated by a green LED
is selected (position away from LED).

If it is the first time the program is run and a port
other than Serial Port 1 (COM1) is used, the serial port
may have to be selected. Refer to Section 3.9 for more
information.

3.2 MISCELLANEOUS PROGRAM
INFORMATION

3.2.1 BASIC WINDOWS KNOWLEDGE

With the descriptions which follow in this section,
it is assumed that you have a basic understanding of
how to use your Windows-based operating system. If
you are not familiar with some of the Windows func-
tions described, refer to the Windows Help Screens and
any manuals that may have been included with your
Windows software.

3.2.2 SOFTWARE INSTALLATION

The programming software is supplied on one
3-1/2” diskette. Install this software as follows:

1. Make sure that there are no other Windows applica-
tions open during this installation procedure. Also,
make sure that the computer meets the minimum
requirements listed in Section 3.1.2.
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2. Insert the distribution disk in the disk drive of your
computer.

3. Select Start > Settings > Control Panel and double
click “Add/Remove Programs”. Then click Install
and Next. When SETUP.EXE is automatically
located on the floppy drive, click Next, select the
location for the start-up icon, and enter the name
you want to call the program.

4. Follow the instructions displayed by the setup
program. The default directory for the program is
C:\Program Files\LTR-Net Mobile Programmer. If
you wish to use some other directory, click Browse
and select it or type the name to create a new one.

Making a Backup Copy

When you receive the programming software,
make a backup copy and store the master in a safe
place. To make a copy of the distribution disk, select
My Computer and then right click the floppy drive
icon and select Copy Disk.

3.2.3 STARTING PROGRAM

From Start Menu

The program is started by clicking the shortcut
icon for the program. This shortcut is automatically
created when the program is installed, and is usually
selected by clicking @l Start| > Programs > LTR-Net >
Mobile Programmer.

If this icon is not present or you want to create
another, select Start > Settings > Taskbar. Then select
the Start Menu Programs tab and click the Add button.
Click the Browse button and locate the program file
called LTRNetMobPgmr.exe where you installed it on
your hard drive (see preceding information). Click the
program name and continue following the instructions
that are displayed.

From My Computer or Windows Explorer

To start the program from My Computer or
Windows Explorer, locate the file
LTRNetMobPgmr.EXE and then double click it.

3.3 MAIN WINDOW DESCRIPTION
3.3.1 TITLE BAR

The title bar is located at the top of the window
(see Figure 3-2) and indicates the following:

. i Clicking this control
1con displays the screen on Move
the right which can be usedto | size

perform the indicated window
control functions.

Bestore

Minimize
Maximize

Close Alt+F4

e Name of the current data file
(Johnson_rad.mbl in Figure 3-2).

e Program name (LTR-Net Programmer)
e Window Minimize, Maximize, and Close buttons

3.3.2 MENU BAR

The menu bar (see Figure 3-2) displays the head-
ings for the menus that are used to select program
functions. Quick access to the most frequently used
menu functions are provided by toolbar buttons. Refer
to Sections 3.5 - 3.10 for descriptions of menu
functions.

3.3.3 TOOLBAR

The toolbar (see Figure 3-2) provides quick
access to the most frequently used menu functions.
The toolbar can be turned on and off by selecting
View > Toolbar in the menu bar. The function of these
buttons and section in which the function is described
are as follows:

- Create a new programming file (Section 3.5).
|- Open a disk file (Section 3.5).

E - Save the current file (Section 3.5).

% - Create a new locality (Section 3.6.8).

E - Edit a current locality (Section 3.6.8).

ﬁ - Load locality from repeater file (Section 3.6.8).
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E - Delete a locality (Section 3.6.8).
% - Create a new system (Section 3.6.9).
% - Edit a current system (Section 3.6.9).
% - Copy a system (Section 3.6.9).

'L%f:? - Delete a system (Section 3.6.9).

u? - Edit a group (Section 3.6.10).

Ly

=
!
Gl

-
=

eanit | - Create a new bank (Section 3.6.11).
FEL]

EEﬁ - Edit a current bank (Section 3.6.11).

eanit| - Delete a bank (Section 3.6.11).
DELETE

el - Read the programming data from radio (Section

B 3.7.2).

maill - Write programming data to a radio (Section
T 3.7.3).

i) . Read error code information stored in radio
HIE (Section 2.14)

3.3.4 STATUS BAR

The status bar is located at the bottom of the
screen (see Figure 3-2), and it indicates the following
information. The status bar can be turned on and off by
selecting View > Status Bar in the menu bar.

Program StatusWhen pointing to a function or tool,
this area provides a brief description of it. At other
times, it indicates the current program status.

Caps Lock- Displays “CAPS” when the keyboard
Caps Lock function is enabled.

Num Lock- Displays “NUM” when the numeric keys
are enabled.

Special Modes Normally always blank.
Flash Memory Left Displays a running total of the

amount of space remaining in Flash memory U108 if
the transceiver was programmed with the current
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information. If this number reaches zero before all data
is entered, fewer localities/systems/groups/banks must
be programmed (see Section 2.4.9).

Reserved This display is reserved for future use and

any number it displays can be ignored.

EEPROM Memory Left Functions like the Flash

memory display just described to indicate the amount
of space remaining in EEPROM U102.

3.4 PROGRAMMING PROCEDURE

Introduction

The following is a general procedure that can be

used to program a 98xx-series LTR-Net transceiver.
Detailed information on the screens mentioned in the
procedure is located in Sections 3.5 - 3.10.

Getting Started

1.

Start the program as described in Section 3.2.3. The
main window shown in Figure 3-2 should be
displayed.

Choose the data file to be edited using one of the
following methods:

New File - When the program is started, a new file
is automatically created that contains program
defaults. This file is named “Untitled” until it is
saved. A new file can also be created at any time by

File > New or clicking | in the toolbar.
HE'W

From Disk File- If a file stored on disk is to be
edited or used as a basis for programming another
file, open it by selecting File > Open or clicking

E,”l in the toolbar.

Read From RadieIf the data programmed in a
radio is to be used as a basis for programming
another radio or is to be modified, it can be read
into the program. To do this, select Transfer > Read
Setup Params or cIic% in the toolbar (see
Section 3.7). :
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JLEEC ™ ) ohnson_rad.mbl [Radio Model: 9883-60X] - LTR-Net® Mobile Progr... [Mi=1E3
MenuBar- File Edit Transfer Yiew ComPorts HE||]

Toolbar - 2 o a b
=& wEw | et |LoRo |oecere| MDD | EOTT

etk | e | e | oo | oo | soroum
I:I:IF“r' [IELETE EEUUP EW | EDTT | DELETE| READ | WRITE | % CoDE

Status Bar -  Ready

Flash EEPROM
Program Status/ Caps Num Special Memory Memory
Function Description Lock Lock Modes Left Reserved Left

G R

6283 1951 3799

Figure 3-2 Main Window

Programming Main Radio Parameters

The Main Radio Parameters are parameters that
are the same regardless of which bank/system/group is
selected. They are programmed as follows:

1. Select Edit > Radio Type and the screen that is
displayed programs the Type (mobile, portable),
Tier (high), Frequency Band (UHF, 800 MHz, 900
MHz), and Bandwidth (narrow 12.5 kHz, dual 12.5
and 25 kHz). See Section 3.6.2.

2. Select Edit > Basic Radio Params (Parameters) to
display the screens used to program other radio
parameters. The following parameters are
programmed by these screens:

Basic ParametersSelect the Basic Parameters 3.

screen by clicking the tab at the top. Choose the
desired configuration for each parameter by click-
ing the arrow button or the check box (Section
3.6.3).

Menu ParametersSelect the Menu ltems screen

by clicking the tab at the top. Placing a check in the
box enables the parameter in the menu mode, and
the other box programs the default configuration
(Section 3.6.5).

Key Assignment Select the Key Assignment
screen by clicking the tab at the top. Click the key
to be programmed and then choose the function for
that key by clicking the arrow button to display the
drop-down list (Section 3.6.6).

Input/Output- Parameters in the Input/Output
screen need to be programmed only if an internal
option such as the compander module is installed
or if an option controlled by the AUX option
switch is installed (Section 3.13).

When all parameters in the Radio Parameters
Screens are programmed, click the OK button to
save all changes or the Cancel button to exit without
saving changes.

Locality Programming

Timing ParametersSelect the Timing Parameters
screen by clicking the tab at the top. Choose the

In general, a locality is a repeater site. At least

desired configuration for each parameter by click- one Locality must be programmed before any Systems

ing the arrow button or the check box (Section can be programmed and so on for Groups and Banks.
3.6.4). For example, at least one Locality, System, and Group
April 1999

3-5

Part No. 001-9800-600



PROGRAMMING

must be programmed to program a bank. Proceed as
follows to program localities (Section 3.6.8):

Create New Locality - Select Edit > Localities >

Create New or click ®m| in the toolbar.
rEL)

NOTE: The frequency band is selected in the radio
type screen.

Load Locality From Repeater File - Locality infor-
mation can be loaded from a repeater programming
file so that it does not need to be re-entered. These
files have the .LNT extension, and are loaded by
selecting Edit > Localities > Load From Disk or

clicking =/ in the toolbar.
Lnnnl

Edit Locality - Select Edit > Localities > Edit
Existing or click ?ﬁ? in the toolbar.

Delete Locality - Select Edit > Localities > Delete

Locality or click | in the toolbar.
DELETE

When all parameters in the Locality screen are
programmed, click the OK button to save all changes
and exit, or click the Cancel button to exit without
saving any changes.

System Programming

Each system is linked to one of the localities.
Therefore, at least one locality must be created as just
described before systems can be created. Groups are
added to the systems by group programming described
next. Proceed as follows (Section 3.6.9):

Create New System - Select Edit > Systems >
Create New or click | & | in the toolbar.
MED

Copy System - To copy a system that is already
created for use as a basis in programming another,
select Edit > Systems > Copy Existing or click

o | in the toolbar.
COPY

Delete System - Select Edit > Systems > Delete or
click | m | in the toolbar.
DELETE
When all parameters in the System screen are
programmed, click the OK button to save the changes
and exit, or click the Cancel button to exit without
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saving any changes. Repeat this procedure to add addi-
tional systems.

Group Programming

Each group is linked to one of the systems.
Therefore, at least one system must be created as just
described before groups can be created. Groups
program individual call parameters. Proceed as
follows (Section 3.6.10):

1. To create a new group or edit a group, select Edit >
Groups or click == in the toolbar.
GROUP
2. A screen is then displayed which lists all current
systems. Select the system to which a group is be
added or in which a group is to be edited. Click the
OK button to display the groups in that system.

3. In the Group No. box, select the number or the
group to be added, edited, or deleted.

4. Program the group with the desired parameters.

5. Click the Add button if adding a new group, the
Change button if editing a group, or the Delete
button if deleting a group. To exit without saving the
current changes, click the Cancel button.

6. Repeat until the system has been programmed with
the desired groups. Then click the Done button to
exit. Repeat to program other systems if applicable.

Bank Programming

At least one locality, system, and group must be
programmed before a bank can be programmed. Banks
are collections of systems that may be selected for a
unique application such as operation in different
geographical areas. System numbering and other
parameters can be different for each bank. At least one
bank must always be programmed even if bank select
is not used.

1. Create, Edit, or Delete a bank as follows:

Create a New Bank - Select Edit > Banks > Create

New or click [eanr| in the toolbar.
MEL
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Edit Bank- Select Edit > Banks > Edit Existing or
click EE¥$ in the toolbar. New Ctrl+N
Delete Bank Select Edit > Banks > Delete or click Open... Cul+Q
Bnm{l in the toolbar. Save Ctrl+S
DELETE Save As...

2. When the bank programming screen is displayed, Read *Codes Alt+C

select the display number of the system to be added,
edited, or deleted. Then select the system to be
assigned to that number if applicable. Also program

1 Johnson_rad4.mbl
2 Johnson_rad3.mbl

default scan list status of the system and other bank 3 Johnson_rad2.mbl
information such as alphatag and emergency and 4 Johnson_rad1.mbl
home system/group if applicable. Exit

3. To make the selected changes to the system, click File Menu

the Add, Change, or Delete button, whichever is -

applicable. To add, edit, or delete other systems, g Open - This menu parameter or toolbar icon
repeat this procedure. When finished programming opens a mobile data file that was previously saved to
the bank, click the Done button, or to exit without disk. This allows a disk file to be edited or used as a

making any changes, click the Cancel button. basis for programming another transceiver. If a file
with unsaved changes is currently open, you are asked
Programming Transceiver if you would like to save it before opening the new
file. This function displays a screen listing all the files
When all the programming described in the in the current directory with the .mbl extension.
preceding sections is complete, the data is ready to be
downloaded to the transceiver as follows: E Save -This menu parameter or toolbar icon
saves the current programming data file to disk. If it is
1. Connect the computer to the transceiver as the first time it is being saved, a screen is displayed
described in Section 3.1.6. which allows a file name to be entered (similar to the

Save As function which follows). The Save function
2. Download the data to the transceiver by selecting should be used periodically while editing a file to
Transfer > Write Setup Params or cli% inthe prevent the loss of data if a power failure occurs or
toolbar. HRITE program execution is interrupted for some other
reason. Files are automatically given the .mbl
3. Click the Write button in the screen that is extension.
displayed. Messages and the data are displayed as
programming occurs. Refer to Section 3.7 for more Save As -Same as “Save” except you are prompted to
information. enter a file name. This allows the current file to be
renamed and saved to a new file.

Igioall
—
CODE

3.5 FILE MENU #rone| Read Codes -This menu item or toolbar icon
reads the error code log stored in the radio and
The File Menu shown in the following illustration  displays it. Refer to Section 2.14 for more information.

is used to perform these file operations:

. Recent Files -The file names of the previous files
New - This menu parameter or toolbar icon opened by the program are listed. To open one of these
creates a hew programming data file that contains files, simply click the name.
default parameters. If a file with unsaved changes is
currently open, you are asked if you would like to save Exit - Closes the program. If the current file has
it before opening the new file. New files are automati- unsaved changes, you are asked if you would like to
cally named “Untitled”. save it before exiting.
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Iransfer View ComPorts Help

Radio Type
Basic Mobile Parms Create New
Localities 2 .
Svet R Edit Existing
2YysIems Load from disk
Groups
Delete Locality
Change UID Test Locality
Create New
Edit Existing
bl T
Create New ~0py J
Edit Existing Delete
Delete Test System

Figure 3-3 Edit Menu
3.6 EDIT MENU
3.6.1 INTRODUCTION
The Edit Menu shown in Figure 3-3 or equiva-
lent buttons in the toolbar select screens that program
various transceiver functions. The following informa-

tion describes the screens selected by the Edit Menu.

3.6.2 EDIT RADIO TYPE SCREEN

Select Radio Type
ok I
—Radio Typ
& Mohile Cames
~
Fartatle Help
- Fiadio Tier
S A i
A Er
@ High Tier
i~ Freq Band Info
LGBl el
BTty Ban [

300 MHz
UHF 430
UHF 470

The Radio Type screen shown above selects the
type, tier, frequency band, and bandwidth parameters.
If you are unsure of what a parameter should be, for
example if the transceiver is dual or narrow band, note
the model number on the transceiver idenfication label
or the number that is briefly displayed when power is
turned on. Then refer to Sections 1.3 or 1.4 to deter-
mine this information from these numbers.
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NOTE: The screens described in Sections 3.6.3 - 3.6.7
which follow are displayed by selecting Edit > Basic
Mobile Parms and then clicking the tab at the top.

3.6.3 BASIC PARAMETERS SCREEN

Mobile Radio Parameters

Basic Parameters |Timing Parameters' Menu I(ems' KeyAsswgnmem' \nput/OutputI

Scan Revert Mode IW
Proceedto Talk Tone Type m
Select Knob Default W
Hank Count; m

Horn Honk Mode

Digable Mic Hanger:

r
Conv Proceed to Talk Tone r

Display Ernergency: T
r

Encryption Installed

Pgm Key: I Werify Key:

Ok I Cancel | Help

Scan Revert Mode - Selects the system/group on
which transmissions occur in the scan mode (Section
2.7.8).

Last Selected - Always on the selected.

Last Received - Always on the last received.

Temporary - On the last received if the transmitter
is keyed before scanning resumes.

Proceed-To-Talk Tone - Selects either a single (stan-
dard) or double (loud) proceed-to-talk tone. Currently,
only the single tone is selectable (Section 2.5.11).

Select Knob Default - Selects if the system or group
select mode is enabled when power is turned on and
after the menu mode is selected (Section 2.4.5).

Horn Count - Selects the number of times the horn
alert sounds when it is enabled. Currently, the horn
alert feature is not available (Section 2.5.8).

Horn Honk Mode - Selects horn alert Mode A
(manual on-off) or B (automatic on-oft). Currently, the
horn alert feature is not available (Section 2.5.8).

Disable Mic Hanger - When selected, taking the
microphone off-hook does not halt scanning or enable
conventional mode channel monitoring.
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Conv Proceed-to-Talk Tone - When selected, the
proceed-to-talk tone sounds on conventional systems
as well as on LTR/LTR-Net systems (Section 2.5.11).

Display Emergency - Currently, this parameter is not
used because “EMERGNCY” is always displayed
when the emergency switch is pressed (Section 2.5.4).

Encryption Installed - Currently, encryption is not
available and this parameter is not used. It is checked
if the encryption option is installed. Encryption can
then be enabled or disabled on each group (Section
2.5.5).

Pgm (Program) Key - To prevent unauthorized read-
ing or writing of programming data to a transceiver, a
code consisting of up to eight keyboard characters can
be entered in this box. If this box is left blank, no
protection is used (Section 3.11.1).

Verify Key - The exact code entered in the Pgm Key
box must be re-entered in this box for it to be accepted
as valid code.

3.6.4 TIMING PARAMETERS SCREEN

Mobile Radio Parameters B

Basic Paramsters  Timing Paramsters |Menu Itemsl KeyAsswgnmentI \nput!OutputI

Receive Delay h Transmit Timeout  |3.0 minutes VI
Call Delay: |4 A SelectKnob Retumn: 5 A
Scan Continue: |0 A HonkOn:  |0.50 seconds =

Ignition Sense Delay: |30 minutes vl Hank Off 050 seconds =
oK I

Cancel | Help |

Receive Delay - Selects the time from 0-7 seconds
before scanning resumes after receiving a message
(Section 2.7.7).

Call Delay - Selects the time from 0-7 seconds before
scanning resumes after transmitting a message
(Section 2.7.7).

Scan Continue - Selects the maximum time from 0-60
seconds that a call is monitored before scanning
resumes (Section 2.7.7).

Ignition Sense Delay - Selects a power turn-off delay
of Immediate, 10, 20, 30, 40, 50 minutes, 1, 2, 4, 8, 10,
12, 16 hours, or forever (Section 2.5.10).

Transmit Time-Out - Programs the time-out timer
(Section 2.5.14).

Select Knob Return - Currently, this parameter is not
used. It selects the delay that occurs after the Select
switch is used before it returns to the default select
mode programmed in the preceding Basic Parameters
screen (Section 2.4.5).

Honk On-Off - Currently, the horn alert is not avail-
able. This selects the on and off times for each horn
alert cycle. The number of cycles are selected in the
preceding Basic Parameters screen. Times of 0.25,
0.50, 0.75, or 1.0 second can be programmed (Section
2.5.8).

3.6.5 MENU ITEMS SCREEN

Mobile Radio Parameters

Basic Parameters | Timing Parametars Menu ftems |KeyAsswgnmem| Input,’Outputl

¥ [Sacdight Contal  [arigh ¥| ¥ Scan Save on E
¥ Option Iﬂ ¥ Display Mode m
v Tones m v Scan Continue Off hd
¥ Roaming Off - [¥ Stealih off A
v Hom/Light Alert Off - v Scan Type Off -
I~ Encryption Off hd [C Bank Select m

OK | Cancel | Help

The Menu Items screen programs the parameters
that are selectable in the menu mode. It also programs
the default status of parameters not controlled by the
menu mode or an option switch. Some functions can
be controlled by both an option switch and the menu
mode.

If a function is programmed as not selectable (no
check in the check box), it is fixed in the condition
selected in the drop-down list. For example, if “Tones”
1s not checked and “All” is selected, the Tones menu
parameter is not selectable and all tones always sound.

If a menu item is selectable by the menu mode or
an option switch, the default condition exists only until
the first time that function is changed manually auto-
matically. The last selected and not the default condi-
tion is selected when power is turned on. Refer to

April 1999
Part No. 001-9800-600



PROGRAMMING

Section 2.6 for more menu mode information, and to
Table 3-1 for brief descriptions of items programmed
in the Menu Items screen.

3.6.6 KEY ASSIGNMENT SCREEN

Mobile Radio Parameters

Basic Pararmeters | Tirning Parametersl henu tems  Key Assignment ||nput#0utput|

Click on the buttan you want to change, then use
the drop-down listto selectthe function
assigned to the highlighted key.

IScan >

AD >
IEEmk >

Ermergency hd
mergency

QK I Cancel | Help

The Key Assignment screen is used to program
the front panel option switches. All five switches are
programmable. To program a switch, click it on the
front panel and then select the desired function from
the drop-down list. When finished, click the OK
button to exit and save the changes or Cancel to exit
without saving. Refer to Table 3-1 for brief descrip-
tions of the available switch functions.

3.6.7 INPUT/OUTPUT SCREEN

This Input/Output screen programs the various
input/output lines on the logic board. Refer to Section
3.13 for information on the parameters listed in this
screen.

3.6.8 EDIT LOCALITY SCREEN

The Edit > Localities menu parameter (see Figure
3-3) or equivalent buttons in the toolbar are used to
select the screen that sets up and edits localities. As
described in “Locality Programming” on page 4-5, a
locality is the repeaters at a single location or site. Up
to approximately 35 LTR-Net or 60 LTR or conven-
tional localities can be programmed (see Section
2.4.9). The functions that can be selected by Edit >
Localities menu are as follows:

:?E Edit > Localities > Create New - Creates a new
locality. The screen that is displayed and its parame-
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ters are described in Table 3-3. The frequency band is
selected on the radio type screen (see Section 3.6.2).

:ﬁ? Edit > Localities > Edit Existing - Edits a
current locality. The locality to be edited is selected
from a list. The screen that is displayed and its param-
eters are described in Table 3-3.

E"ﬁ? Edit > Localities > Load From Disk - Loads
locality information from the file used to program an
LTR-Net repeater site. This eliminates the need to re-
enter this information for each mobile. Repeater
programming files have the “.LNT” extension.

ﬁ Edit > Localities > Delete Locality - Deletes a
locality.

Edit > Localities > Test Locality - Creates a locality
that is used for test purposes. Currently, test localities
are not used (see Section 2.13).

3.6.9 EDIT SYSTEM SCREEN

The Edit > Systems menu parameter (see Figure
3-3) or equivalent buttons in the toolbar select the
screen that sets up and edits systems. As described in
“System Programming” on page 4-6, a system is
programmed with one or more selectable groups and
other unique information. Up to 99 systems can be
programmed (see Section 2.4.9). Groups are added to
systems using the group edit function described in the
next section. For a system to be selected or scanned, it
must be linked to a bank (Section 3.6.11).

The system programming functions that can be
selected by the Edit > Systems menu are as follows:
B
ﬁ Edit > Systems > Create New - Creates a new
system. The screen that is displayed is described in
Table 3-4.

B
ﬁ Edit > Systems > Edit Existing - Edits a current
system. The system to be edited is selected from a list.
The screen that is displayed is described in Table 3-4.

cobv | Edit > Systems > Copy Existing - Creates a
new system by copying one of the current systems.
The system to be copied is selected from a list. The

screen that is displayed is described in Table 3-4.
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Table 3-1 Menu and Option Switch Parameter Descriptions

Parameter I\I/Itzll:l (S)vl:f:::(c)ll: Description

Add/Delete X Scan list add/delete switch (Section 2.7.6).

Backlight Control X Controls the display and keypad backlight. Bright, Dim, and Off modes can be
selected (Section 2.4.3).

Bank Select X X Selects banks when two or more are programmed (Section 2.5.1).

Display Mode Sel X Selects the alpha or numeric display mode (Section 2.4.4).

Emergency X Selects the emergency system/group (Section 2.5.4).

Encryption On-Off [1] X X Turns optional encryption on and off (Section 2.5.5).

Function Switch X Selects menu mode, home sys/grp, and sq adjust (Section 2.5.6).

Home sys/grp sel X This switch or FCN Sel displays the home system/group (Section 2.5.7).

Horn alert on-off [1] X X Turns the horn alert on and off if installed (Section 2.5.8).

Menu Mode sel X This switch or FCN FCN select the menu mode .

Mic hook sel [1] X Select on- or -off-hook mode w/off-hook detect is disabled (Section 2.4.6).

Option select X X Turns a dealer installed option on and off (Section 2.5.9).

Roaming on-off X X Turns roaming on and off (Section 2.9.3).

Scan on-off X Turns scanning on and off (Section 2.7).

Scan type select X Selects group, system/group, or no scanning (Section 2.7).

Scan continue X Turns the scan continue feature on and off. This timer limits the amount of
time a message is received while scanning (Section 2.7.7).

Scan list save X When “on” is selected, changes to the scan list are saved (Section 2.7.6).

Stealth mode sel X Turns stealth mode on and off. This mode disables tones, backlight, etc.
(Section 2.5.13).

Squelch adj mode Selects the conventional squelch adjust mode (Section 2.4.7).

Telephone grp sel X Selects a telephone group in system (Section 2.8.5).

Tone type select X Selects the tones that sound (All, Alert, Key, Silent). See Section 2.5.15.

[1] These functions are not currently available and so are ignored by the transceiver.

E Edit > Systems > Delete - Deletes a system. editing screens in Table 3-5 is displayed. Up to 99
groups can be assigned to each system.
Edit > Systems > Test System - Currently, test

systems are not used (see Section 2.13).

SyslD Locality MNarme Tyae

AW Conmv Corre 1 Conventional

C2BELTR LTR1 LTR G
AZSLNet LTR Netl LTR-Net® Hel
ATW Conw Corw2 Comventional 2er

3.6.10 EDIT GROUPS SCREEN

90~ O 1 da L a3 —

NOTE: Refer to Table 3-5 for descriptions of the Edit o e il
Group screens. R Ume an
The Edit > Groups menu parameter (see
Figure 3-3) or @ button in the toolbar is used to
display the screens that set up and edit the groups
assigned to each system. The following screen is 3.6.11 EDIT BANKS SCREEN
displayed to select the system in which groups are to
be added or edited. After the desired system is The Edit > Banks menu parameter (see
selected, click the OK button and one of the group Figure 3-3) or equivalent buttons in the toolbar are
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used to select the screen that sets up and edits banks.
As described in “Bank Programming” on page 3-6,
banks are collections of systems that may be selected,
for example, for operation in different geographical
areas.

Up to sixteen banks can be programmed. System
numbering and other parameters can be different for
each bank. At least one bank must be programmed
even if bank select is not used. The functions that can
be selected by the Edit > Banks menu are as follows:

BANK

rew | Edit > Banks > Create New - Creates a new
bank. The screen that is displayed is described in Table
3-6.
BANE
enz7| Edit > Banks > Edit Existing - Edits a current
bank. The bank to be edited is selected from a list. The
screen that is then displayed is described in Table 3-6.

f[??rli Edit > Banks > Delete - Deletes a bank.

3.6.12 EDIT UNIQUE ID SCREEN

This function displays a screen that can be used to
edit the transceiver unique ID codes assigned to each
LTR-Net locality. This makes unique ID editing more
convenient than selecting each locality individually.

3.7 TRANSFER MENU

File Edit BIcUEEIE View ComPo

Read Setup Params

I Write Setup Params

3.7.1 INTRODUCTION

The Transfer menu shown above is used to Read
(upload) data from the transceiver to the computer and
also to Write (download) data from the computer to
the transceiver. The Read function can be used to
check transceiver programming or to use the data in
one transceiver as the basis for programming another.
The Write function is used to program a transceiver
with the data that has been entered. More information
follows:
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3.7.2 READING A FILE

To read the programming data contained in a
transceiver, proceed as follows.

1. Connect the transceiver to the computer using the
RPI as described in Section 3.1.6.

2. Select Transfer > Read Setup Params or click the
| toolbar button.
READ
3. A screen is then displayed which indicates the
progress of the read operation. Click the Read
button.

4. If the transceiver contains a Program Key, you are
prompted to enter this key before the data is read.
Refer to Section 3.11.1 for more information.

3.7.3 WRITING A FILE

To write the current programming data to a trans-
ceiver, proceed as follows:

1. Connect the transceiver to the computer using the
RPI as described in Section 3.1.6.

2. Select Transfer > Write Setup Params or click the
weelll toolbar button.
LIRITE

3. A screen is then displayed which indicates the
progress of the write operation. Click the Write
button.

4. If the transceiver was previously programmed with
a Program Key, you are prompted to enter this key
before the data is transferred. Refer to Section
3.11.1 for more information.

5. The following messages may be displayed by the
transceiver:

PGM MODE - Standard message while program-
ming is occurring.

TYPE ERR - Indicates that the programming data
is incompatible with the transceiver. A possible
reason for this is using a version of the program-
ming software that is not compatible with the
transceiver software.
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PROG ERR - Indicates that an error was detected
when verifying the data programmed into the trans-
ceiver.

3.8 VIEW MENU

S ComPorts  Help
S
‘r'||]ELETE GROUPL  MELS

' ¥ Toolbar = | me BHNKlBHNI{lBHN
EDTT | DELE

‘v Status Bar
By Bark 10
By Locality F11

By System F12

This View menu is shown above, and it is used to
select these functions:

View Toolbar - Enables and disables the toolbar
(shown behind menu in following screen). Refer to
Section 3.3.3 for more information.

View Status Bar - Enables and disables the status bar
at the bottom of the screen (Section 3.3.4).

View Personality - Displays the programmed Bank,
Locality, or System hierarchy. An example of a Bank
hierarchy follows. To expand or collapse a branch,
double click it. Expandable branches are displayed in
bold type.

Personality Viewer - By Bank

Twin Cty -
- AW Conv - LoclD: 80 (UID 0)
- Conv 1-SYSID: 1
- Conw 1 - Groupd: 1
- Conw 2- Group#: 2
Corw 3-Group#: 3
~A2SL-Net - LoclD: 100 (UID 12345)
*LTR Netl - S¥YSID: 3
-~ Met G - Group#: 1
Met GZ - Group#: 2
- Met G3 - Groupd: 3
MNet G4 - Group#: 4
- C2B LTR - LoclD: 128 (UID 0)
L LTR1-SYSID: 2
~LTRG1 - Group#: 1
- LTR G2 - Group#: 2

g
- A1W Conv - LoclD: 80 (UID 0) e
-~ A25L-Net - LoclD: 100 (UID 12345) LI

oK Hep |

3.9 COMPORTS MENU

The ComPorts menu is shown above, and it is
used to select which computer serial port is used by

[ransfer View Help

Set Com Port
Select COM port
& COM 1 =
€ COk 2 Cancel |
 COk 3
© COMA4 &l

the RPI (see Section 3.1.3). The default is COM 1. If
another port is used, select it using this function. The
new port then becomes the default port, so this func-
tion only needs to be used when the port is changed.

3.10 HELP MENU

Displays help information on the program. Most
screens also have a Help button that can be clicked to
display help on that screen.

3.11 ADDITIONAL PROGRAMMING
INFORMATION

3.11.1 PROGRAM KEY

An eight-character Programming Key can be
entered in the Basic Parameters screen (see Section
3.6.3) to prevent unauthorized reading and writing of
transceiver data. If a transceiver is programmed with a
data file containing a key in this location, the program-
ming data cannot be read from that transceiver unless
the same key is entered. Likewise, the transceiver
cannot be reprogrammed without entering this key.

Any keyboard character can be used when enter-
ing this key (including spaces), and letter case is
considered. For example, entering “A” instead of “a”
results in an invalid entry. Characters entered are
displayed as asterisks (****). A key must be re-
entered in the Verify box to be accepted.

To disable this feature so that no key is required
to read or write data to the transceiver, do not enter
any characters in the Pgm Key box, or if there already
1s a code in this box, delete all characters. Then
program the transceiver with the data file. A valid key
is still required to write over a data file containing key
with a file not containing a key. If the key is lost,
contact Customer Service as described in Section 1.7
of the service manual for information on what to do.

April 1999
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3.11.2 CHANNEL NUMBER PROGRAMMING

NOTE: Use Programming channel numbers and not
FCC channel numbers from the table at the end of this
section. Also, if entering channel frequencies instead
of channel numbers, be sure to enter the repeater
frequency, not the mobile frequency.

The channel frequencies of the repeaters the
transceiver can access are programmed on the locality
screen shown in Table 3-3. The frequency band is
selected in the Radio Type screen before any localities
are programmed (see Section 3.6.2). Either channel
frequencies or channel numbers can be used depend-
ing on which is checked in the Display Mode box of
the applicable locality screen.

If channel numbers are used (available only for
the 800 and 900 MHz bands), use the Programming
channel numbers and not the FCC channel numbers
from the table at end of this section. The 800 MHz
channels from 1-600 are the same as the FCC chan-
nels; however, for channels above 600, a special
programming channel number is used because some
channels were skipped by the FCC scheme. For chan-
nels 1-600, a 12.5 kHz offset band can be selected for
operation in near certain U.S. border areas.

The 12.5/25 kHz IF bandwidth parameter applies
to only UHF channels and 800 MHz channels 1-600
because the other 800 MHz channels and 900 channels
are already 12.5 kHz.

3.11.3 REPEATER NUMBERING

With LTR-Net and LTR repeaters, the repeaters at
a locality are assigned a unique number from 1-20.
Although these numbers can be assigned arbitrarily,
for maximum system efficiency, a scheme should be
used which equalizes, as much as possible, the gaps
between numbers. For example, a five-repeater system
should be numbered 1, 5, 10, 15, and 20. These
numbers are programmed in the repeater and also each
mobile locality (see Section 3.6.8).

If Home Channel Aliasing is used (see Section
2.9.6), the status repeater should be repeater 20 and
repeater 1 should be an active repeater. The other
repeaters should then be spaced evenly from 1-20.
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Part No. 001-9800-600

3.11.4 SPECIFYING RIC-EQUIPPED
REPEATERS

When programming the channel numbers of LTR
localities, you specify if the repeater is equipped with
an EFJohnson repeater interconnect (RIC) controller.
If a system with a transmit ID code programmed for
interconnect is then selected, the transceiver will
attempt to access only repeaters specified as equipped
with this controller. This allows both interconnect and
non-interconnect repeaters to be programmed in each
locality.

Without this feature, the transceiver may trunk to
a repeater not equipped with an interconnect controller
when a telephone call is made. No dial tone or other
supervision is then returned when the PTT switch is
released which may be confusing to the user.

3.11.5 TEST LOCALITY

Currently, the test locality test locality
programmed by Edit > Locality > Test Locality as
described in Section 3.6.8 is not used. The sixteen
channels programmed in this locality are selected by
the test mode which is also currently not available (see
Section 2.13).

3.12 UPDATING RADIO SOFTWARE
3.12.1 INTRODUCTION

The transceiver operating software (firmware)
can be updated in the field without replacing the
microcontroller or a memory device such as an
EPROM. For example, the radio software may be
updated to correct software bugs or add feature
enhancements. This is made possible by the use of a
reprogrammable Flash memory device.

The same basic hardware setup used to program
personality information is also used to update radio
software. One requirement though is that only Remote
Programming Interface (RPI), Part No. 023-9800-000,
can be used. Other RPI’s such as the 023-9750-000,
023-5810-000, and 023-5300-000 do not work.
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Programming is performed using separate Flash
programming software (see Table 1-1). This program
is run by typing PLATUPD at the DOS prompt (the
DOS mode must usually be used). The program
requires a special data file which contains the updated
radio software (see next section). Follow the instruc-
tions on the screen to perform the actual updating.

3.12.2 DATA FILE

To update the radio software, the data file
containing the new radio software is required. The
filename of this data file is 98xtsXzz.S19. The “t” is
the type number and “s” the signaling type from the
transceiver part number (7th and 8th digits, respec-
tively, as described in Section 1.4). The “zz” charac-
ters indicate the feature level of the software.

Contact your Customer Service or your sales
representative concerning the availability of software
updates for this transceiver. They may be available on
the EFJohnson ACES® Bulletin Board System for
downloading. To access this system, dial toll-free from
the U.S. and Canada 1-800-227-3997 (N, 8, 1, ANSI).
From other countries, dial 507-835-8607.

If you do not know your login ID or have ques-
tions or would like to sign up for service on this
system, call 1-800-328-3911, extension 7 (USA and
Canada) or 507-835-6222, extension 2100 (interna-
tional). Once the data file is obtained, it must be
copied to the directory containing the program.

Table 3-2 Call Guard Codes and Tones

Recommended Tone Call Guard Codes

Code Freq Code Freq Code Freq Code Freq Code Freq
00 00.0 09 91.5 18 123.0 27 167.9 36* 233.6
01 67.0 10 94.8 19 127.3 28 173.8 37* 241.8
02 71.9 11** 97.4 20 131.8 29 179.9 38* 250.3
03 74.4 12 100.0 21 136.5 30 186.2 39%* 69.3
04 77.0 13 103.5 22 141.3 31 192.8 40%* 206.5
05 79.7 14 107.2 23 146.2 32 203.5 41% ** 229.1
06 82.5 15 110.9 24 151.4 33 210.7 4% ** 254.1
07 85.4 16 114.8 25 156.7 34* 218.1
08 88.5 17 118.8 26 162.2 35% 225.7

* These tones normally are not used because of their close proximity to the voice frequencies.
** This tone is normally not used because it may cause interference with adjacent tones.

Recommended Digital Call Guard Codes

023 065 131 172 261 346 431 532 654 743
025 071 132 174 263 351 432 546 662 754
026 072 134 205 265 364 445 565 664
031 073 143 223 271 365 464 606 703
032 074 152 226 306 371 465 612 712
043 114 155 243 311 411 466 624 723
047 115 156 244 315 412 503 627 731
051 116 162 245 331 413 506 631 732
054 125 165 251 343 423 516 632 734
April 1999
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Table 3-3 Locality Programming Screen Description

LTR-Net® L ocality Information

—Radia Infa
Locality Name W MNumber: lﬂ Type: lm
Band: [00RFz =] U 235 e n = ﬂl
Powsr. [High = Dropaout %: |33 - _Dislp_laiz::jncy &I
Fix Base Freq lm Capture % m 7 Channel
Tx Base Freg lm Tight Capture % m I= | w/offz et
- Fepeater Info
Fepeaters 1-10 |Repeaters'\1—2[||
# Channel # Banchwicith Status  Active Cornpanding
N s r
I [eo: =] ¢ B
S E ~ [zt =] © 7 r
N 3 - r r
o — & c o r
e = - o o«
S 3 - r r
N — & c o r
N = - o o«
L 3 - r r

This screen is used to create a new locality or edit a current locality. It is displayed by selecting the Edit > Locdlities
menu (see Section 3.6.8) or clicking one of E buttons in the toolbar. In general, a locality is a repeater site.
Parameter Description
Locality Name| This is an eight-character name given to the locality to identify it during programming. It is not displayed by the trapsceiver.

Number |The number from 1-1023 assigned to LTR-Net localities. Each LTR-Net locality that a mobile can access must have a differ-
ent locality number, and the same scheme must be used to program the mobiles and repeaters.

Type Selects the type of locality (LTR-Net, LTR, or Conventional) when new localities are created.

Band The frequency band in which the locality operates. The frequency band selected when the first locality is created pr before
any localites are created by the Radio Type screen (see Section 3.6.2). Once a locality is created, the band canngt be
changed.

uID With LTR-Net localities, programs the unique ID of the mobile when it accesses that locality. Numbers from
1-65503 can be programmed.

Area “0" is usually programmed unless two LTR or LTR-Net localities are close enough to interfere with each other. Ong locality
is then programmed “0” and the other “1”.

Rx/Tx Base |This is a non-editable field shown for reference only. It indicates the base receive and transmit frequency used to|derive the
Frequency |frequency of each channel.
Power Programs the power output that is selected when the transceiver accesses that locality. High, Low 1, Low 2, Low 3] and Low
4 levels can be selected. The power output for each of these levels is set during transceiver alignment (Section 2|5.12).
Dropout  |Programs the percentage that the squelch is tightened when no call is occurring. The higher the percentage, the $ooner auto-
Percentage |matic locality search occurs. The default value is 33%. If there is no other site nearby, this percentage should alwgys be 0%
(Section 2.9.3).
Capture  |Programs the percentage that the squelch is tightened after the first pass when searching for a new site (“LCL SRCH" dis-
Percentage |played). The higher the percentage, the stronger the signal must be in order to attempt registration on a site. Thigparameter
should always be greater than or equal to the preceding Dropout Percentage. The default value is 46% (Section 2.9.3).
Tight Programs the percentage squelch is tightened during the first pass when searching for a new site (‘HSQ SRCH?” displayed).
Capture | The higher the percentage, the stronger the signal must be in order to attempt registration on a site. This paramejer should
Percentage |always be greater than or equal to the preceding Capture Percentage. The default value is 80% (Section 2.9.3).
Display Mode|With the 800/900 MHz bands, selects if Programming channel numbers or frequency (in MHz) is used to programjthe chan-
nel frequency of each repeater. With the UHF band, only channel frequencies can be used, so “Channel” is not sg¢lectable.
Channel numbers are shown in the table at the end of this section. It is possible to switch between the channel and frequency
display modes until a frequency is changed in the frequency mode.
April 1999
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Table 3-3 Locality Programming Screen Description (Continued)

Parameter

Description

Channel
Number

Programs either the channel number or frequency of each repeater at the locality, depending on the Display
Mode that was selected by the preceding parameter. If entering channel numbers, use the Programming channel
numbers from the tables at the end of this section, not the FCC channel number. Channels 1-920 can be pro-
grammed with 800 MHz models, and channels 1-479 can be programmed with 900 MHz models ( Section
3.11.2). NOTE: Repeater frequencies are entered, not the mobile frequencies.

Bandwidth

This parameter is programmable with UHF and 800 MHz dual bandwidth transceivers only (all 900 MHz mod-
els are narrow band). Currently, all UHF and 800 MHz 98xx models are dual bandwidth. Either 12.5 kHz (nar-
row band) or 25 kHz (wideband) can be selected for each repeater. Then when the transceiver accesses that
repeater, it is automatically configured for the proper bandwidth.

Status With LTR-Net operation only, one of the locality repeaters is designated as the status repeater.
Active  |Only repeaters marked as active can be accessed by the transceiver.
Companding| Programs if the repeater is equipped with a compandor. The optional compandor must then be installed, and
companding is automatically enabled whenever that repeater is accessed (Section 2.5.3). The output line
controlling the compander module must also be programmed for companding (Section 3.13).
RIC With LTR operation only, programs if the repeater is equipped with a RIC/TIC (interconnect) module. This

prevents attempted accesses on non-RIC repeaters to make telephone calls (Section 3.11.4).

Table 3-4 System Programming Screen Description

System Information

Systermn MName: IFire Dpt

LocalityID: | 0: Twin Cty

Harme: |1 vl

T Inhikait
’7 Start: |1 vl Stop: -

This screen is used to create a new system or edit a current system. It is displayed by selecting the Edit > Systems menu
.6.9) or clicking one of the Z | buttons in the toolbar. Groups are added using the Edit > Groups function. For a
system to be selected or scanned, it must be linked to a bank using the bank programming screen described in Table 3-6.

(see Section 3

Parameter

Description

System

This is an eight-character name given to the system. It is displayed if the alpha display mode is selected (Sec-

Name tion 2.4.4). Otherwise, it is used only to identify it during programming.
Locality ID |This drop-down list selects the locality to which the system is linked.
Home Selects the home repeater when the system is linked to an LTR or LTR-Net locality.
Transmit |Selects the block of transmit inhibit ID codes up to all 250 for LTR localities or up to all 239 for LTR-Net
Inhibit |localities. If an ID within this block is detected up to 5 seconds before the PTT switch is pressed, the transmitter

does not key (Section 2.8.4).
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Table 3-5 Group Programming Screen Description

This screen is used to add groups to a system or edit groups already assigned to a system. It is displayed by selecting the
Edit > Groups menu or clicking the @ button in the toolbar (see Section 3.6.10). In the following screens, first select from

the drop-down list or the list at the bottom, the Group No. to be added or edited. Then select the desired parameters and make
the changes by clicking the Change button (this is an Add button if adding a Group). To delete a group, select the Group No.

and then click the Delete button. When finished programming the system, click the Done button.

LTR and LTR-Net Group Programming Screen

AZ2SL-Net/LTR Net1 Groups

Group Mo: |3 VI Group Type: IAuinIiary VI Alpha Tag: INet G3
Change |
Priority: |4 vl Encode: I VI Decode: I vl Delete |
RIC ID _ b |
(if LTR and Spare Groups: |4 VI
RIC group _
type ¥ Addto Group Scan List v K
selected) [~ Encryptthis group ¥ Activate Call Light [~ Interruptable
Grp#  Name Type Enc Dec Fri Options
1 Met G1 Dispatch 225 225 3 Scan/int
2 MNet G2 Telco MNEA - NiA 4 Scan
3 MNet G3 ALx MiA NiA 4 Scan
Parameter Description
Group No. |This drop-down list selects the group to be added or edited in the screen.
Group Type | This drop-down list selects one of the following call types:
LTR-Net Systems - Dispatch (standard group call), Telco (telephone call), Auxiliary (unique ID or directed
group call), Data. Currently, data calls are not supported by software (Sections 2.8.3 and 2.9.1).
LTR Systems - Dispatch (standard group call), RIC (telephone call). See Sections 2.8.3 and 2.10.2.
Alpha Tag |This specifies the eight-character alpha tag that is displayed when the group is selected.
Priority |Selects the receive priority of the group. Priority numbers of 1-8 are selectable with LTR-Net and LTR groups
(Section 2.8.1).
Encode ID |With dispatch (group) calls, selects the ID code that is transmitted. Codes 1-239 can be programmed with LTR
Net systems, and 1-250 can be programmed with LTR systems (Section 2.8.3).
RICID |With LTR RIC groups only, selects the ID code on which a telephone call is received (Section 2.10.2).
Decode ID |Similar to Encode ID except selects the receive code that must be decoded to receive a call on the group.
Spare With LTR-Net systems only, selects the number of additional groups that can be added to the system by over-
Groups |the-air programming. This reserves space in memory for the additional groups. If no space has been reserved,
additional groups cannot be added. Space for 0-8 groups can be reserved.
Add to Grp |Selects the default scan list status of the group. This programming can be overridden by the scan list A/D key if]
Scan List |available (Section 2.7.6).
Encrypt this | Currently, encryption is not available. This selects if encryption is enabled when calls are received and trans-
Group |mitted on the group (Section 2.5.5). Encryption must be selected on the Basic Parameters screen to select this
function (Section 3.6.3), and the I/O lines must also be programmed (Section 3.13).
Activate |Currently, the horn alert is not available. If this parameter is checked and the horn alert is enabled, the horn alert
Horn Alert [sounds when a call is received on the group (Section 2.5.8).
Activate Call|Selects if the call indicator is activated when a call is received on the group (Section 2.5.2).
Light
Interruptible| Selects if calls on the group can be interrupted by higher priority calls (Section 2.8.1).
April 1999
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Table 3-5 Group Programming Screen Description (Continued)

Conventional Group Programming Screen

AlW Conv/ConvZ Groups

Group Mao: v Group Type: ICDnv VI

T Call Guard

Type: ITDne VI
Code: I VI

[" Ext CG Required

Alpha Tag: [Conv G1

Change

Fe Call Guard

Type: ITDne - l
Code: I vl

[" Ext CG Required

Tx Opt: IAIWﬁyS hd I

Delete

il

Help

[~ Activate Hom Hank
[T Activate Call Light

¥ Addto Group Scan List
™ Encryptthis graup

[~ Send Turnoff

[ Talk-Around ¥ Disable Mon Off-Hook

Grp# MHame Tywpe Enc Dec P Options
1 Conse 51 Core TO3  TO3 M Scan
2 Corme G2 Core TO5  TO5  MNfA Scan/Hoem/Call/ TA/TO Man_0OH
3 Conv G3 Conw D032 D032 MNiA Scan/TO/Mon_OH
Parameter Description
Group |This drop-down list selects the group to be added or edited in the screen.
Number
Alpha Tag |This specifies the eight-character alpha tag that is displayed when the group is selected.
Tx Option |Always = Tx enabled, TDOB (Transmit Disable On Busy) disabled
Disable Busy = Tx and TDOB enabled, no transmit with carrier even with valid Call Guard
On Valid CG = Tx and TDOB enabled, transmit allowed with valid CG
Disabled = Tx disabled (receive-only channel). See Sections 2.11.2 and 2.11.3.
Tx Call |Selects the type of transmit Call Guard squelch control as Tone (CTCSS), digital (DCS), inverted digital, or
Guard Type |none (carrier). See Section 2.11.5.
Tx Call |If tone or digital encode Call Guard squelch was selected above, selects the tone frequency or digital code that
Guard Code|is transmitted. These tones and codes are also listed in Table 3-2.
(Tx) Ext CG|If this box is checked, both an external encoder and the Call Guard squelch signal are enabled in the transmit
Required |mode (Section 2.11.5).
Rx Call |Selects the type of receive Call Guard squelch control as Tone (CTCSS), digital (DCS), inverted digital, or none
Guard Type |(carrier). See Section 2.11.5.
Rx Call |If tone or digital decode Call Guard squelch was selected above, selects the tone frequency or digital code that
Guard Code |must be decoded to receive a call. These tones and codes are also listed in Table 3-2.
(Rx) Ext CG |If this box is checked, both a detect signal from an external encoder and the Call Guard squelch signal must be
Required |detected for the receiver to unsquelch (Section 2.11.5).
Add to Grp |Selects the default scan list status of the group. This programming can be overridden by the scan list A/D key if]
Scan List |available (Section 2.7.6).
Encrypt this | Currently, encryption is not available. This selects if encryption is enabled when calls are received and trans-
Group |mitted on the group (Section 2.5.5). Encryption must be selected on the Basic Parameters screen to select this
function (Section 3.6.3), and the I/O lines must also be programmed (Section 3.13).
Activate |Currently, the horn alert is not available. If this parameter is checked and the horn alert is enabled, the horn alert
Horn Honk |sounds when a call is received on the group (Section 2.5.8).
Activate Call|Selects if the call indicator is activated when a call is received on the group (Section 2.5.2).
Light
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Table 3-5 Group Programming Screen Description (Continued)

Parameter

Description

Talk-Around

Selects if the talk-around mode is selected when transmissions are made on the group (Section 2.11.4).

Send Turn-
off

Selects if the Call Guard turn-off code is sent when the PTT switch is released (Section 2.11.5).

Disable Mon
Off-Hook

If selected, disables the microphone hanger monitor function on the group. Taking the microphone off-hook
then does not enable the monitor mode although scanning is still disabled (Section 2.11.1).

Table 3-6 Bank Programming Screen Description

Editing Bank 0: Twin Cty

Bank Marme: ITwin Chy

Emergency System: IAZSL—Net LTR Metl

=

Group: |1:Net G1

Done
System Display Mo: |3 vl System: IAESL—NBULTR Metl LI Cancel
¥ Enahle Scan

Set as default bank

|
|
Change I
|
|
|

Haome System: IAZSL—Net LTR Metl LI Group:  ([[ERELE) Delete
Sws Mo, Locality Home Syshame Sys3can Help
1 AlWY Cony 2 Conw 1 vES
2 CZBLTR 1 LTR1 MO
3 A25L-MNet 1 LTR Netl vES

This screen is used to create a new bank or edit a current bank. It is displayed by selecting the Edit > Banks menu (see
Section 3.6.11) or clicking one of the &M

ﬁ buttons in the toolbar. In the above screen, select the number of the system to be
added or edited in the System Display No. drop-down list and then select the desired parameters. Then make the changes by
clicking the Change button (this is an Add button if adding a system). To delete a system from the bank, select it from the
drop-down list or in the list at the bottom of the screen and then click the Delete button. When finished programming the

bank, click the Done button or click Cancel to exit without saving any changes. At least one bank must be programmed even
if bank select is not used.

Parameter
Bank Name

Description

This is an eight-character name given to the bank. It is displayed when banks are selected (Section 2.5.1).
Otherwise, it is used only to identify it during programming.

System
Display No.

Systems can be assigned unique display numbers in each bank. This drop-down list selects the number that is
displayed when the system is selected in the bank.

System

This is a drop-down list of all currently programmed systems that selects the system being added to the bank or

edited. Systems being edited or deleted can also be selected by clicking them in the list at the bottom of the
screen.

Enable Scan

Selects the default scan list status of the system. This is the only system parameter that can be different for each
bank.

Emergency

Selects the emergency system/group that is selected by the Emergency switch on the bank (Section 2.5.4).

System/Grp
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Table 3-6 Bank Programming Screen Description (Continued)

Parameter Description
Home |Selects the home system/group selected by the Home select switch or function on the bank (Section 2.5.7).
System/Grp
Done Button|Click this button when finished editing the bank to save the changes.
Cancel |Click this button to exit the screen without saving any changes to the bank.
Button
Change/Add | This is a Change button when editing a system and an Add button when adding a system. It is clicked to make
Button |the changes to the selected system.
Set As | A default bank can be programmed in the Menu Items screen (Section 3.6.5). Clicking this button assigns the
Default |current bank as the default without having to select that screen. One use of default banks when the bank menu
Button |parameter is disabled is to allow several banks to be programmed and then selectively enable the desired bank
on a per transceiver basis. This button is displayed only if two or more banks are programmed.
Delete  |Deletes the currently selected system from the bank.
Button
Basic Parameters | Timing Parameters | Menu ltems | Key Assignment [nput/ Output |
— Inputs/ Qutputs
Actve State
Option 1: IHIGH vl
Input2:  |Disable >l |HeH =
Input3:  |Disable >l JHeH =]
OutputA:  |Disahle >l |HoH =]
OutputB:  |Disahle =l |HeH =]
OutputC:  |Disable =l JHeH =]
OutputD:  |Disahle >l JHeH =]
QK. I Cancel | Help
Figure 3-4 1/O Line Programming Screen
3.13 1/0 LINE PROGRAMMING outs. In addition, an output line controls Output D of
the accessory cable which can be used to control some
NOTE: External data devices such as modems are not type of external option. Other input/output lines are
currently supported by software. brought out of the transceiver by a cable connected to
J301 for controlling an external data device such as a
3.13.1 INTRODUCTION modem.

The audio/logic board has several input/output The Input/Output screen used to program these
lines that are used to control internal options such as lines is shown in Figure 3-4. It is displayed by select-
the compandor, encryption, and external decoder ing the Edit > Basic Parameters menu and then click-
modules that mount in the Option Slot 1 and 2 wire- ing the Input/Output tab.The parameters in this screen
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that currently are supported by software are described
in the following information.

3.13.2 COMPANDOR PROGRAMMING

When the compandor module option is installed,
the locality channels must be programmed for
companding as described in Section 3.6.8. In addition,
the I/O line which controls the compandor module
(Output A or B) must be programmed for “Compand”
and active high. Consult the installation instructions
included with the compandor and Section 2.5.3 for
more information.

3.13.3 ENCRYPTION PROGRAMMING

NOTE: Encryption is currently not supported by sofi-
ware.

When the encryption module option is installed, it
must be selected on the Basic Parameters screen
described in Section 3.6.3. Then each group on which
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encryption is to be used is programmed for encryption
as described in Section 3.6.10. In addition, the I/O line
which controls the encryption module (Output A or B)
must be programmed for “Encrypt”. Consult the
installation instructions included with the encryption
module and Section 2.5.5 for more information.

3.13.4 OPTION PROGRAMMING

A dealer installed option of some type may be
installed that is controlled by the OPTION menu
parameter or AUX option switch programmed for
Option Select (see Section 2.5.9). The menu parameter
is programmed as described in Section 3.6.5 and the
option switch is programmed as described in Section
3.6.6. The output line that controls the option Output
A - D/Output 1) must then be programmed in the
Input/Output screen for
“Accessory Option” and the desired polarity.
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800 MHz Channels
Prog Chan. | FCC Chan. | Repeater Tx| Repeater Rx Prog Chan. | FCC Chan. | Repeater Tx | Repeater Rx

No. No. Freq. Freq No. No. Freq. Freq

1 1 851.0125 806.0125 53 53 852.3125 807.3125
2 2 851.0375 806.0375 54 54 852.3375 807.3375
3 3 851.0625 806.0625 55 55 852.3625 807.3625
4 4 851.0875 806.0875 56 56 852.3875 807.3875
5 5 851.1125 806.1125 57 57 852.4125 807.4125
6 6 851.1375 806.1375 58 58 852.4375 807.4375
7 7 851.1625 806.1625 59 59 852.4625 807.4625
8 8 851.1875 806.1875 60 60 852.4875 807.4875
9 9 851.2125 806.2125 61 61 852.5125 807.5125
10 10 851.2375 806.2375 62 62 852.5375 807.5375
11 11 851.2625 806.2625 63 63 852.5625 807.5625
12 12 851.2875 806.2875 64 64 852.5875 807.5875
13 13 851.3125 806.3125 65 65 852.6125 807.6125
14 14 851.3375 806.3375 66 66 852.6375 807.6375
15 15 851.3625 806.3625 67 67 852.6625 807.6625
16 16 851.3875 806.3875 68 68 852.6875 807.6875
17 17 851.4125 806.4125 69 69 852.7125 807.7125
18 18 851.4375 806.4375 70 70 852.7375 807.7375
19 19 851.4625 806.4625 71 71 852.7625 807.7625
20 20 851.4875 806.4875 72 72 852.7875 807.7875
21 21 851.5125 806.5125 73 73 852.8125 807.8125
22 22 851.5375 806.5375 74 74 852.8375 807.8375
23 23 851.5625 806.5625 75 75 852.8625 807.8625
24 24 851.5875 806.5875 76 76 852.8875 807.8875
25 25 851.6125 806.6125 77 77 852.9125 807.9125
26 26 851.6375 806.6375 78 78 852.9375 807.9375
27 27 851.6625 806.6625 79 79 852.9625 807.9625
28 28 851.6875 806.6875 80 80 852.9875 807.9875
29 29 851.7125 806.7125 81 81 853.0125 808.0125
30 30 851.7375 806.7375 82 82 853.0375 808.0375
31 31 851.7625 806.7625 83 83 853.0625 808.0625
32 32 851.7875 806.7875 84 84 853.0875 808.0875
33 33 851.8125 806.8125 85 85 853.1125 808.1125
34 34 851.8375 806.8375 86 86 853.1375 808.1375
35 35 851.8625 806.8625 87 87 853.1625 808.1625
36 36 851.8875 806.8875 88 88 853.1875 808.1875
37 37 851.9125 806.9125 89 89 853.2125 808.2125
38 38 851.9375 806.9375 90 90 853.2375 808.2375
39 39 851.9625 806.9625 91 91 853.2625 808.2625
40 40 851.9875 806.9875 92 92 853.2875 808.2875
41 41 852.0125 807.0125 93 93 853.3125 808.3125
42 42 852.0375 807.0375 94 94 853.3375 808.3375
43 43 852.0625 807.0625 95 95 853.3625 808.3625
44 44 852.0875 807.0875 96 96 853.3875 808.3875
45 45 852.1125 807.1125 97 97 853.4125 808.4125
46 46 852.1375 807.1375 98 98 853.4375 808.4375
47 47 852.1625 807.1625 99 99 853.4625 808.4625
48 48 852.1875 807.1875 100 100 853.4875 808.4875
49 49 852.2125 807.2125 101 101 853.5125 808.5125
50 50 852.2375 807.2375 102 102 853.5375 808.5375
51 51 852.2625 807.2625 103 103 853.5625 808.5625
52 52 852.2875 807.2875 104 104 853.5875 808.5875
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800 MHz Channels
Prog Chan. | FCC Chan. | Repeater Tx| Repeater Rx Prog Chan. | FCC Chan. | Repeater Tx | Repeater Rx

No. No. Freq. Freq No. No. Freq. Freq

105 105 853.6125 808.6125 157 157 854.9125 809.9125
106 106 853.6375 808.6375 158 158 854.9375 809.9375
107 107 853.6625 808.6625 159 159 854.9625 809.9625
108 108 853.6875 808.6875 160 160 854.9875 809.9875
109 109 853.7125 808.7125 161 161 855.0125 810.0125
110 110 853.7375 808.7375 162 162 855.0375 810.0375
111 111 853.7625 808.7625 163 163 855.0625 810.0625
112 112 853.7875 808.7875 164 164 855.0875 810.0875
113 113 853.8125 808.8125 165 165 855.1125 810.1125
114 114 853.8375 808.8375 166 166 855.1375 810.1375
115 115 853.8625 808.8625 167 167 855.1625 810.1625
116 116 853.8875 808.8875 168 168 855.1875 810.1875
117 117 853.9125 808.9125 169 169 855.2125 810.2125
118 118 853.9375 808.9375 170 170 855.2375 810.2375
119 119 853.9625 808.9625 171 171 855.2625 810.2625
120 120 853.9875 808.9875 172 172 855.2875 810.2875
121 121 854.0125 809.0125 173 173 855.3125 810.3125
122 122 854.0375 809.0375 174 174 855.3375 810.3375
123 123 854.0625 809.0625 175 175 855.3625 810.3625
124 124 854.0875 809.0875 176 176 855.3875 810.3875
125 125 854.1125 809.1125 177 177 855.4125 810.4125
126 126 854.1375 809.1375 178 178 855.4375 810.4375
127 127 854.1625 809.1625 179 179 855.4625 810.4625
128 128 854.1875 809.1875 180 180 855.4875 810.4875
129 129 854.2125 809.2125 181 181 855.5125 810.5125
130 130 854.2375 809.2375 182 182 855.5375 810.5375
131 131 854.2625 809.2625 183 183 855.5625 810.5625
132 132 854.2875 809.2875 184 184 855.5875 810.5875
133 133 854.3125 809.3125 185 185 855.6125 810.6125
134 134 854.3375 809.3375 186 186 855.6375 810.6375
135 135 854.3625 809.3625 187 187 855.6625 810.6625
136 136 854.3875 809.3875 188 188 855.6875 810.6875
137 137 854.4125 809.4125 189 189 855.7125 810.7125
138 138 854.4375 809.4375 190 190 855.7375 810.7375
139 139 854.4625 809.4625 191 191 855.7625 810.7625
140 140 854.4875 809.4875 192 192 855.7875 810.7875
141 141 854.5125 809.5125 193 193 855.8125 810.8125
142 142 854.5375 809.5375 194 194 855.8375 810.8375
143 143 854.5625 809.5625 195 195 855.8625 810.8625
144 144 854.5875 809.5875 196 196 855.8875 810.8875
145 145 854.6125 809.6125 197 197 855.9125 810.9125
146 146 854.6375 809.6375 198 198 855.9375 810.9375
147 147 854.6625 809.6625 199 199 855.9625 810.9625
148 148 854.6875 809.6875 200 200 855.9875 810.9875
149 149 854.7125 809.7125 201 201 856.0125 811.0125
150 150 854.7375 809.7375 202 202 856.0375 811.0375
151 151 854.7625 809.7625 203 203 856.0625 811.0625
152 152 854.7875 809.7875 204 204 856.0875 811.0875
153 153 854.8125 809.8125 205 205 856.1125 811.1125
154 154 854.8375 809.8375 206 206 856.1375 811.1375
155 155 854.8625 809.8625 207 207 856.1625 811.1625
156 156 854.8875 809.8875 208 208 856.1875 811.1875
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800 MHz Channels
Prog Chan. | FCC Chan. | Repeater Tx| Repeater Rx Prog Chan. | FCC Chan. | Repeater Tx | Repeater Rx

No. No. Freq. Freq No. No. Freq. Freq

209 209 856.2125 811.2125 261 261 857.5125 812.5125
210 210 856.2375 811.2375 262 262 857.5375 812.5375
211 211 856.2625 811.2625 263 263 857.5625 812.5625
212 212 856.2875 811.2875 264 264 857.5875 812.5875
213 213 856.3125 811.3125 265 265 857.6125 812.6125
214 214 856.3375 811.3375 266 266 857.6375 812.6375
215 215 856.3625 811.3625 267 267 857.6625 812.6625
216 216 856.3875 811.3875 268 268 857.6875 812.6875
217 217 856.4125 811.4125 269 269 857.7125 812.7125
218 218 856.4375 811.4375 270 270 857.7375 812.7375
219 219 856.4625 811.4625 271 271 857.7625 812.7625
220 220 856.4875 811.4875 272 272 857.7875 812.7875
221 221 856.5125 811.5125 273 273 857.8125 812.8125
222 222 856.5375 811.5375 274 274 857.8375 812.8375
223 223 856.5625 811.5625 275 275 857.8625 812.8625
224 224 856.5875 811.5875 276 276 857.8875 812.8875
225 225 856.6125 811.6125 277 277 857.9125 812.9125
226 226 856.6375 811.6375 278 278 857.9375 812.9375
227 227 856.6625 811.6625 279 279 857.9625 812.9625
228 228 856.6875 811.6875 280 280 857.9875 812.9875
229 229 856.7125 811.7125 281 281 858.0125 813.0125
230 230 856.7375 811.7375 282 282 858.0375 813.0375
231 231 856.7625 811.7625 283 283 858.0625 813.0625
232 232 856.7875 811.7875 284 284 858.0875 813.0875
233 233 856.8125 811.8125 285 285 858.1125 813.1125
234 234 856.8375 811.8375 286 286 858.1375 813.1375
235 235 856.8625 811.8625 287 287 858.1625 813.1625
236 236 856.8875 811.8875 288 288 858.1875 813.1875
237 237 856.9125 811.9125 289 289 858.2125 813.2125
238 238 856.9375 811.9375 290 290 858.2375 813.2375
239 239 856.9625 811.9625 291 291 858.2625 813.2625
240 240 856.9875 811.9875 292 292 858.2875 813.2875
241 241 857.0125 812.0125 293 293 858.3125 813.3125
242 242 857.0375 812.0375 294 294 858.3375 813.3375
243 243 857.0625 812.0625 295 295 858.3625 813.3625
244 244 857.0875 812.0875 296 296 858.3875 813.3875
245 245 857.1125 812.1125 297 297 858.4125 813.4125
246 246 857.1375 812.1375 298 298 858.4375 813.4375
247 247 857.1625 812.1625 299 299 858.4625 813.4625
248 248 857.1875 812.1875 300 300 858.4875 813.4875
249 249 857.2125 812.2125 301 301 858.5125 813.5125
250 250 857.2375 812.2375 302 302 858.5375 813.5375
251 251 857.2625 812.2625 303 303 858.5625 813.5625
252 252 857.2875 812.2875 304 304 858.5875 813.5875
253 253 857.3125 812.3125 305 305 858.6125 813.6125
254 254 857.3375 812.3375 306 306 858.6375 813.6375
255 255 857.3625 812.3625 307 307 858.6625 813.6625
256 256 857.3875 812.3875 308 308 858.6875 813.6875
257 257 857.4125 812.4125 309 309 858.7125 813.7125
258 258 857.4375 812.4375 310 310 858.7375 813.7375
259 259 857.4625 812.4625 311 311 858.7625 813.7625
260 260 857.4875 812.4875 312 312 858.7875 813.7875
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800 MHz Channels
Prog Chan. | FCC Chan. | Repeater Tx| Repeater Rx Prog Chan. | FCC Chan. | Repeater Tx | Repeater Rx

No. No. Freq. Freq No. No. Freq. Freq

313 313 858.8125 813.8125 365 365 860.1125 815.1125
314 314 858.8375 813.8375 366 366 860.1375 815.1375
315 315 858.8625 813.8625 367 367 860.1625 815.1625
316 316 858.8875 813.8875 368 368 860.1875 815.1875
317 317 858.9125 813.9125 369 369 860.2125 815.2125
318 318 858.9375 813.9375 370 370 860.2375 815.2375
319 319 858.9625 813.9625 371 371 860.2625 815.2625
320 320 858.9875 813.9875 372 372 860.2875 815.2875
321 321 859.0125 814.0125 373 373 860.3125 815.3125
322 322 859.0375 814.0375 374 374 860.3375 815.3375
323 323 859.0625 814.0625 375 375 860.3625 815.3625
324 324 859.0875 814.0875 376 376 860.3875 815.3875
325 325 859.1125 814.1125 377 377 860.4125 815.4125
326 326 859.1375 814.1375 378 378 860.4375 815.4375
327 327 859.1625 814.1625 379 379 860.4625 815.4625
328 328 859.1875 814.1875 380 380 860.4875 815.4875
329 329 859.2125 814.2125 381 381 860.5125 815.5125
330 330 859.2375 814.2375 382 382 860.5375 815.5375
331 331 859.2625 814.2625 383 383 860.5625 815.5625
332 332 859.2875 814.2875 384 384 860.5875 815.5875
333 333 859.3125 814.3125 385 385 860.6125 815.6125
334 334 859.3375 814.3375 386 386 860.6375 815.6375
335 335 859.3625 814.3625 387 387 860.6625 815.6625
336 336 859.3875 814.3875 388 388 860.6875 815.6875
337 337 859.4125 814.4125 389 389 860.7125 815.7125
338 338 859.4375 814.4375 390 390 860.7375 815.7375
339 339 859.4625 814.4625 391 391 860.7625 815.7625
340 340 859.4875 814.4875 392 392 860.7875 815.7875
341 341 859.5125 814.5125 393 393 860.8125 815.8125
342 342 859.5375 814.5375 394 394 860.8375 815.8375
343 343 859.5625 814.5625 395 395 860.8625 815.8625
344 344 859.5875 814.5875 396 396 860.8875 815.8875
345 345 859.6125 814.6125 397 397 860.9125 815.9125
346 346 859.6375 814.6375 398 398 860.9375 815.9375
347 347 859.6625 814.6625 399 399 860.9625 815.9625
348 348 859.6875 814.6875 400 400 860.9875 815.9875
349 349 859.7125 814.7125 401 401 861.0125 816.0125
350 350 859.7375 814.7375 402 402 861.0375 816.0375
351 351 859.7625 814.7625 403 403 861.0625 816.0625
352 352 859.7875 814.7875 404 404 861.0875 816.0875
353 353 859.8125 814.8125 405 405 861.1125 816.1125
354 354 859.8375 814.8375 406 406 861.1375 816.1375
355 355 859.8625 814.8625 407 407 861.1625 816.1625
356 356 859.8875 814.8875 408 408 861.1875 816.1875
357 357 859.9125 814.9125 409 409 861.2125 816.2125
358 358 859.9375 814.9375 410 410 861.2375 816.2375
359 359 859.9625 814.9625 411 411 861.2625 816.2625
360 360 859.9875 814.9875 412 412 861.2875 816.2875
361 361 860.0125 815.0125 413 413 861.3125 816.3125
362 362 860.0375 815.0375 414 414 861.3375 816.3375
363 363 860.0625 815.0625 415 415 861.3625 816.3625
364 364 860.0875 815.0875 416 416 861.3875 816.3875
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800 MHz Channels
Prog Chan. | FCC Chan. | Repeater Tx| Repeater Rx Prog Chan. | FCC Chan. | Repeater Tx | Repeater Rx

No. No. Freq. Freq No. No. Freq. Freq

417 417 861.4125 816.4125 469 469 862.7125 817.7125
418 418 861.4375 816.4375 470 470 862.7375 817.7375
419 419 861.4625 816.4625 471 471 862.7625 817.7625
420 420 861.4875 816.4875 472 472 862.7875 817.7875
421 421 861.5125 816.5125 473 473 862.8125 817.8125
422 422 861.5375 816.5375 474 474 862.8375 817.8375
423 423 861.5625 816.5625 475 475 862.8625 817.8625
424 424 861.5875 816.5875 476 476 862.8875 817.8875
425 425 861.6125 816.6125 477 477 862.9125 817.9125
426 426 861.6375 816.6375 478 478 862.9375 817.9375
427 427 861.6625 816.6625 479 479 862.9625 817.9625
428 428 861.6875 816.6875 480 480 862.9875 817.9875
429 429 861.7125 816.7125 481 481 863.0125 818.0125
430 430 861.7375 816.7375 482 482 863.0375 818.0375
431 431 861.7625 816.7625 483 483 863.0625 818.0625
432 432 861.7875 816.7875 484 484 863.0875 818.0875
433 433 861.8125 816.8125 485 485 863.1125 818.1125
434 434 861.8375 816.8375 486 486 863.1375 818.1375
435 435 861.8625 816.8625 487 487 863.1625 818.1625
436 436 861.8875 816.8875 488 488 863.1875 818.1875
437 437 861.9125 816.9125 489 489 863.2125 818.2125
438 438 861.9375 816.9375 490 490 863.2375 818.2375
439 439 861.9625 816.9625 491 491 863.2625 818.2625
440 440 861.9875 816.9875 492 492 863.2875 818.2875
441 441 862.0125 817.0125 493 493 863.3125 818.3125
442 442 862.0375 817.0375 494 494 863.3375 818.3375
443 443 862.0625 817.0625 495 495 863.3625 818.3625
444 444 862.0875 817.0875 496 496 863.3875 818.3875
445 445 862.1125 817.1125 497 497 863.4125 818.4125
446 446 862.1375 817.1375 498 498 863.4375 818.4375
447 447 862.1625 817.1625 499 499 863.4625 818.4625
448 448 862.1875 817.1875 500 500 863.4875 818.4875
449 449 862.2125 817.2125 501 501 863.5125 818.5125
450 450 862.2375 817.2375 502 502 863.5375 818.5375
451 451 862.2625 817.2625 503 503 863.5625 818.5625
452 452 862.2875 817.2875 504 504 863.5875 818.5875
453 453 862.3125 817.3125 505 505 863.6125 818.6125
454 454 862.3375 817.3375 506 506 863.6375 818.6375
455 455 862.3625 817.3625 507 507 863.6625 818.6625
456 456 862.3875 817.3875 508 508 863.6875 818.6875
457 457 862.4125 817.4125 509 509 863.7125 818.7125
458 458 862.4375 817.4375 510 510 863.7375 818.7375
459 459 862.4625 817.4625 511 511 863.7625 818.7625
460 460 862.4875 817.4875 512 512 863.7875 818.7875
461 461 862.5125 817.5125 513 513 863.8125 818.8125
462 462 862.5375 817.5375 514 514 863.8375 818.8375
463 463 862.5625 817.5625 515 515 863.8625 818.8625
464 464 862.5875 817.5875 516 516 863.8875 818.8875
465 465 862.6125 817.6125 517 517 863.9125 818.9125
466 466 862.6375 817.6375 518 518 863.9375 818.9375
467 467 862.6625 817.6625 519 519 863.9625 818.9625
468 468 862.6875 817.6875 520 520 863.9875 818.9875

April 1999

3-27

Part No. 001-9800-600



PROGRAMMING

800 MHz Channels
Prog Chan. | FCC Chan. | Repeater Tx| Repeater Rx Prog Chan. | FCC Chan. | Repeater Tx | Repeater Rx

No. No. Freq. Freq No. [1] No. [1] Freq. Freq

521 521 864.0125 819.0125 573 573 865.3125 820.3125
522 522 864.0375 819.0375 574 574 865.3375 820.3375
523 523 864.0625 819.0625 575 575 865.3625 820.3625
524 524 864.0875 819.0875 576 576 865.3875 820.3875
525 525 864.1125 819.1125 577 577 865.4125 820.4125
526 526 864.1375 819.1375 578 578 865.4375 820.4375
527 527 864.1625 819.1625 579 579 865.4625 820.4625
528 528 864.1875 819.1875 580 580 865.4875 820.4875
529 529 864.2125 819.2125 581 581 865.5125 820.5125
530 530 864.2375 819.2375 582 582 865.5375 820.5375
531 531 864.2625 819.2625 583 583 865.5625 820.5625
532 532 864.2875 819.2875 584 584 865.5875 820.5875
533 533 864.3125 819.3125 585 585 865.6125 820.6125
534 534 864.3375 819.3375 586 586 865.6375 820.6375
535 535 864.3625 819.3625 587 587 865.6625 820.6625
536 536 864.3875 819.3875 588 588 865.6875 820.6875
537 537 864.4125 819.4125 589 589 865.7125 820.7125
538 538 864.4375 819.4375 590 590 865.7375 820.7375
539 539 864.4625 819.4625 591 591 865.7625 820.7625
540 540 864.4875 819.4875 592 592 865.7875 820.7875
541 541 864.5125 819.5125 593 593 865.8125 820.8125
542 542 864.5375 819.5375 594 594 865.8375 820.8375
543 543 864.5625 819.5625 595 595 865.8625 820.8625
544 544 864.5875 819.5875 596 596 865.8875 820.8875
545 545 864.6125 819.6125 597 597 865.9125 820.9125
546 546 864.6375 819.6375 598 598 865.9375 820.9375
547 547 864.6625 819.6625 599 599 865.9625 820.9625
548 548 864.6875 819.6875 600 600 865.9875 820.9875
549 549 864.7125 819.7125 601 - 866.0000 821.0000
550 550 864.7375 819.7375 602 601 866.0125 821.0125
551 551 864.7625 819.7625 603 - 866.0250 821.0250
552 552 864.7875 819.7875 604 602 866.0375 821.0375
553 553 864.8125 819.8125 605 603 866.0500 821.0500
554 554 864.8375 819.8375 606 604 866.0625 821.0625
555 555 864.8625 819.8625 607 605 866.0750 821.0750
556 556 864.8875 819.8875 608 606 866.0875 821.0875
557 557 864.9125 819.9125 609 607 866.1000 821.1000
558 558 864.9375 819.9375 610 608 866.1125 821.1125
559 559 864.9625 819.9625 611 609 866.1250 821.1250
560 560 864.9875 819.9875 612 610 866.1375 821.1375
561 561 865.0125 820.0125 613 611 866.1500 821.1500
562 562 865.0375 820.0375 614 612 866.1625 821.1625
563 563 865.0625 820.0625 615 613 866.1750 821.1750
564 564 865.0875 820.0875 616 614 866.1875 821.1875
565 565 865.1125 820.1125 617 615 866.2000 821.2000
566 566 865.1375 820.1375 618 616 866.2125 821.2125
567 567 865.1625 820.1625 619 617 866.2250 821.2250
568 568 865.1875 820.1875 620 618 866.2375 821.2375
569 569 865.2125 820.2125 621 619 866.2500 821.2500
570 570 865.2375 820.2375 622 620 866.2625 821.2625
571 571 865.2625 820.2625 623 621 866.2750 821.2750
572 572 865.2875 820.2875 624 622 866.2875 821.2875

[1] Use the Programming Channel Number, not the FCC Channel Number
April 1999

Part No. 001-9800-600

3-28




PROGRAMMING

800 MHz Channels
Prog Chan. | FCC Chan. | Repeater Tx| Repeater Rx Prog Chan. | FCC Chan. | Repeater Tx | Repeater Rx
No. [1] No. [1] Freq. Freq No. [1] No. [1] Freq. Freq
625 623 866.3000 821.3000 677 673 866.9500 821.9500
626 624 866.3125 821.3125 678 674 866.9625 821.9625
627 625 866.3250 821.3250 679 675 866.9750 821.9750
628 626 866.3375 821.3375 680 676 866.9875 821.9875
629 627 866.3500 821.3500 681 - 867.0000 822.0000
630 628 866.3625 821.3625 682 677 867.0125 822.0125
631 629 866.3750 821.3750 683 - 867.0250 822.0250
632 630 866.3875 821.3875 684 678 867.0375 822.0375
633 631 866.4000 821.4000 685 679 867.0500 822.0500
634 632 866.4125 821.4125 686 680 867.0625 822.0625
635 633 866.4250 821.4250 687 681 867.0750 822.0750
636 634 866.4375 821.4375 688 682 867.0875 822.0875
637 635 866.4500 821.4500 689 683 867.1000 822.1000
638 636 866.4625 821.4625 690 684 867.1125 822.1125
639 637 866.4750 821.4750 691 685 867.1250 822.1250
640 638 866.4875 821.4875 692 686 867.1375 822.1375
641 - 866.5000 821.5000 693 687 867.1500 822.1500
642 639 866.5125 821.5125 694 688 867.1625 822.1625
643 - 866.5250 821.5250 695 689 867.1750 822.1750
644 640 866.5375 821.5375 696 690 867.1875 822.1875
645 641 866.5500 821.5500 697 691 867.2000 822.2000
646 642 866.5625 821.5625 698 692 867.2125 822.2125
647 643 866.5750 821.5750 699 693 867.2250 822.2250
648 644 866.5875 821.5875 700 694 867.2375 822.2375
649 645 866.6000 821.6000 701 695 867.2500 822.2500
650 646 866.6125 821.6125 702 696 867.2625 822.2625
651 647 866.6250 821.6250 703 697 867.2750 822.2750
652 648 866.6375 821.6375 704 698 867.2875 822.2875
653 649 866.6500 821.6500 705 699 867.3000 822.3000
654 650 866.6625 821.6625 706 700 867.3125 822.3125
655 651 866.6750 821.6750 707 701 867.3250 822.3250
656 652 866.6875 821.6875 708 702 867.3375 822.3375
657 653 866.7000 821.7000 709 703 867.3500 822.3500
658 654 866.7125 821.7125 710 704 867.3625 822.3625
659 655 866.7250 821.7250 711 705 867.3750 822.3750
660 656 866.7375 821.7375 712 706 867.3875 822.3875
661 657 866.7500 821.7500 713 707 867.4000 822.4000
662 658 866.7625 821.7625 714 708 867.4125 822.4125
663 659 866.7750 821.7750 715 709 867.4250 822.4250
664 660 866.7875 821.7875 716 710 867.4375 822.4375
665 661 866.8000 821.8000 717 711 867.4500 822.4500
666 662 866.8125 821.8125 718 712 867.4625 822.4625
667 663 866.8250 821.8250 719 713 867.4750 822.4750
668 664 866.8375 821.8375 720 714 867.4875 822.4875
669 665 866.8500 821.8500 721 - 867.5000 822.5000
670 666 866.8625 821.8625 722 715 867.5125 822.5125
671 667 866.8750 821.8750 723 - 867.5250 822.5250
672 668 866.8875 821.8875 724 716 867.5375 822.5375
673 669 866.9000 821.9000 725 717 867.5500 822.5500
674 670 866.9125 821.9125 726 718 867.5625 822.5625
675 671 866.9250 821.9250 727 719 867.5750 822.5750
676 672 866.9375 821.9375 728 720 867.5875 822.5875
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PROGRAMMING

800 MHz Channels
Prog Chan. | FCC Chan. | Repeater Tx| Repeater Rx Prog Chan. | FCC Chan. | Repeater Tx | Repeater Rx
No. [1] No. [1] Freq. Freq No. [1] No. [1] Freq. Freq
729 721 867.6000 822.6000 781 771 868.2500 823.2500
730 722 867.6125 822.6125 782 772 868.2625 823.2625
731 723 867.6250 822.6250 783 773 868.2750 823.2750
732 724 867.6375 822.6375 784 774 868.2875 823.2875
733 725 867.6500 822.6500 785 775 868.3000 823.3000
734 726 867.6625 822.6625 786 776 868.3125 823.3125
735 727 867.6750 822.6750 787 777 868.3250 823.3250
736 728 867.6875 822.6875 788 778 868.3375 823.3375
737 729 867.7000 822.7000 789 779 868.3500 823.3500
738 730 867.7125 822.7125 790 780 868.3625 823.3625
739 731 867.7250 822.7250 791 781 868.3750 823.3750
740 732 867.7375 822.7375 792 782 868.3875 823.3875
741 733 867.7500 822.7500 793 783 868.4000 823.4000
742 734 867.7625 822.7625 794 784 868.4125 823.4125
743 735 867.7750 822.7750 795 785 868.4250 823.4250
744 736 867.7875 822.7875 796 786 868.4375 823.4375
745 737 867.8000 822.8000 797 787 868.4500 823.4500
746 738 867.8125 822.8125 798 788 868.4625 823.4625
747 739 867.8250 822.8250 799 789 868.4750 823.4750
748 740 867.8375 822.8375 800 790 868.4875 823.4875
749 741 867.8500 822.8500 801 791 868.5000 823.5000
750 742 867.8625 822.8625 802 792 868.5125 823.5125
751 743 867.8750 822.8750 803 793 868.5250 823.5250
752 744 867.8875 822.8875 804 794 868.5375 823.5375
753 745 867.9000 822.9000 805 795 868.5500 823.5500
754 746 867.9125 822.9125 806 796 868.5625 823.5625
755 747 867.9250 822.9250 807 797 868.5750 823.5750
756 748 867.9375 822.9375 808 798 868.5875 823.5875
757 749 867.9500 822.9500 809 799 868.6000 823.6000
758 750 867.9625 822.9625 810 800 868.6125 823.6125
759 751 867.9750 822.9750 811 801 868.6250 823.6250
760 752 867.9875 822.9875 812 802 868.6375 823.6375
761 - 868.0000 823.0000 813 803 868.6500 823.6500
762 753 868.0125 823.0125 814 804 868.6625 823.6625
763 - 868.0250 823.0250 815 805 868.6750 823.6750
764 754 868.0375 823.0375 816 806 868.6875 823.6875
765 755 868.0500 823.0500 817 807 868.7000 823.7000
766 756 868.0625 823.0625 818 808 868.7125 823.7125
767 757 868.0750 823.0750 819 809 868.7250 823.7250
768 758 868.0875 823.0875 820 810 868.7375 823.7375
769 759 868.1000 823.1000 821 811 868.7500 823.7500
770 760 868.1125 823.1125 822 812 868.7625 823.7625
771 761 868.1250 823.1250 823 813 868.7750 823.7750
772 762 868.1375 823.1375 824 814 868.7875 823.7875
773 763 868.1500 823.1500 825 815 868.8000 823.8000
774 764 868.1625 823.1625 826 816 868.8125 823.8125
775 765 868.1750 823.1750 827 817 868.8250 823.8250
776 766 868.1875 823.1875 828 818 868.8375 823.8375
777 767 868.2000 823.2000 829 819 868.8500 823.8500
778 768 868.2125 823.2125 830 820 868.8625 823.8625
779 769 868.2250 823.2250 831 821 868.8750 823.8750
780 770 868.2375 823.2375 832 822 868.8875 823.8875
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PROGRAMMING

800 MHz Channels
Prog Chan. | FCC Chan. | Repeater Tx| Repeater Rx Prog Chan. | FCC Chan. | Repeater Tx | Repeater Rx
No. [1] No. [1] Freq. Freq No. [1] No. [1] Freq. Freq
833 823 868.9000 823.9000 877 - 869.4500 824.4500
834 824 868.9125 823.9125 878 - 869.4625 824.4625
835 825 868.9250 823.9250 879 - 869.4750 824.4750
836 826 868.9375 823.9375 880 - 869.4875 824.4875
837 827 868.9500 823.9500 881 - 869.5000 824.5000
838 828 868.9625 823.9625 882 - 869.5125 824.5125
839 829 868.9750 823.9750 883 - 869.5250 824.5250
840 830 868.9875 823.9875 884 - 869.5375 824.5375
841 - 869.0000 824.0000 885 - 869.5500 824.5500
842 - 869.0125 824.0125 886 - 869.5625 824.5625
843 - 869.0250 824.0250 887 - 869.5750 824.5750
844 - 869.0375 824.0375 888 - 869.5875 824.5875
845 - 869.0500 824.0500 889 - 869.6000 824.6000
846 - 869.0625 824.0625 890 - 869.6125 824.6125
847 - 869.0750 824.0750 891 - 869.6250 824.6250
848 - 869.0875 824.0875 892 - 869.6375 824.6375
849 - 869.1000 824.1000 893 - 869.6500 824.6500
850 - 869.1125 824.1125 894 - 869.6625 824.6625
851 - 869.1250 824.1250 895 - 869.6750 824.6750
852 - 869.1375 824.1375 896 - 869.6875 824.6875
853 - 869.1500 824.1500 897 - 869.7000 824.7000
854 - 869.1625 824.1625 898 - 869.7125 824.7125
855 - 869.1750 824.1750 899 - 869.7250 824.7250
856 - 869.1875 824.1875 900 - 869.7375 824.7375
857 - 869.2000 824.2000 901 - 869.7500 824.7500
858 - 869.2125 824.2125 902 - 869.7625 824.7625
859 - 869.2250 824.2250 903 - 869.7750 824.7750
860 - 869.2375 824.2375 904 - 869.7875 824.7875
861 - 869.2500 824.2500 905 - 869.8000 824.8000
862 - 869.2625 824.2625 906 - 869.8125 824.8125
863 - 869.2750 824.2750 907 - 869.8250 824.8250
864 - 869.2875 824.2875 908 - 869.8375 824.8375
865 - 869.3000 824.3000 909 - 869.8500 824.8500
866 - 869.3125 824.3125 910 - 869.8625 824.8625
867 - 869.3250 824.3250 911 - 869.8750 824.8750
868 - 869.3375 824.3375 912 - 869.8875 824.8875
869 - 869.3500 824.3500 913 - 869.9000 824.9000
870 - 869.3625 824.3625 914 - 869.9125 824.9125
871 - 869.3750 824.3750 915 - 869.9250 824.9250
872 - 869.3875 824.3875 916 - 869.9375 824.9375
873 - 869.4000 824.4000 917 - 869.9500 824.9500
874 - 869.4125 824.4125 918 - 869.9625 824.9625
875 - 869.4250 824.4250 919 - 869.9750 824.9750
876 - 869.4375 824.4375 920 - 869.9875 824.9875
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PROGRAMMING

900 MHz Channels
Prog Chan. | FCC Chan. | Repeater Tx| Repeater Rx Prog Chan. | FCC Chan. | Repeater Tx | Repeater Rx

No. No. Freq. Freq No. No. Freq. Freq

1 1 935.0125 896.0125 52 52 935.6500 896.6500
2 2 935.0250 896.0250 53 53 935.6625 896.6625
3 3 935.0375 896.0375 54 54 935.6750 896.6750
4 4 935.0500 896.0500 55 55 935.6875 896.6875
5 5 935.0625 896.0625 56 56 935.7000 896.7000
6 6 935.0750 896.0750 57 57 935.7125 896.7125
7 7 935.0875 896.0875 58 58 935.7250 896.7250
8 8 935.1000 896.1000 59 59 935.7375 896.7375
9 9 935.1125 896.1125 60 60 935.7500 896.7500
10 10 935.1250 896.1250 61 61 935.7625 896.7625
11 11 935.1375 896.1375 62 62 935.7750 896.7750
12 12 935.1500 896.1500 63 63 935.7875 896.7875
13 13 935.1625 896.1625 64 64 935.8000 896.8000
14 14 935.1750 896.1750 65 65 935.8125 896.8125
15 15 935.1875 896.1875 66 66 935.8250 896.8250
16 16 935.2000 896.2000 67 67 935.8375 896.8375
17 17 935.2125 896.2125 68 68 935.8500 896.8500
18 18 935.2250 896.2250 69 69 935.8625 896.8625
19 19 935.2375 896.2375 70 70 935.8750 896.8750
20 20 935.2500 896.2500 71 71 935.8875 896.8875
21 21 935.2625 896.2625 72 72 935.9000 896.9000
22 22 935.2750 896.2750 73 73 935.9125 896.9125
23 23 935.2875 896.2875 74 74 935.9250 896.9250
24 24 935.3000 896.3000 75 75 935.9375 896.9375
25 25 935.3125 896.3125 76 76 935.9500 896.9500
26 26 935.3250 896.3250 77 77 935.9625 896.9625
27 27 935.3375 896.3375 78 78 935.9750 896.9750
28 28 935.3500 896.3500 79 79 935.9875 896.9875
29 29 935.3625 896.3625 80 80 936.0000 897.0000
30 30 935.3750 896.3750 81 81 936.0125 897.0125
31 31 935.3875 896.3875 82 82 936.0250 897.0250
32 32 935.4000 896.4000 83 83 936.0375 897.0375
33 33 935.4125 896.4125 84 84 936.0500 897.0500
34 34 935.4250 896.4250 85 85 936.0625 897.0625
35 35 935.4375 896.4375 86 86 936.0750 897.0750
36 36 935.4500 896.4500 87 87 936.0875 897.0875
37 37 935.4625 896.4625 88 88 936.1000 897.1000
38 38 935.4750 896.4750 89 89 936.1125 897.1125
39 39 935.4875 896.4875 90 90 936.1250 897.1250
40 40 935.5000 896.5000 91 91 936.1375 897.1375
41 41 935.5125 896.5125 92 92 936.1500 897.1500
42 42 935.5250 896.5250 93 93 936.1625 897.1625
43 43 935.5375 896.5375 94 94 936.1750 897.1750
44 44 935.5500 896.5500 95 95 936.1875 897.1875
45 45 935.5625 896.5625 96 96 936.2000 897.2000
46 46 935.5750 896.5750 97 97 936.2125 897.2125
47 47 935.5875 896.5875 98 98 936.2250 897.2250
48 48 935.6000 896.6000 99 99 936.2375 897.2375
49 49 935.6125 896.6125 100 100 936.2500 897.2500
50 50 935.6250 896.6250 101 101 936.2625 897.2625
51 51 935.6375 896.6375 102 102 936.2750 897.2750
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900 MHz Channels
Prog Chan. | FCC Chan. | Repeater Tx| Repeater Rx Prog Chan. | FCC Chan. | Repeater Tx | Repeater Rx

No. No. Freq. Freq No. No. Freq. Freq

103 103 936.2875 897.2875 154 154 936.9250 897.9250
104 104 936.3000 897.3000 155 155 936.9375 897.9375
105 105 936.3125 897.3125 156 156 936.9500 897.9500
106 106 936.3250 897.3250 157 157 936.9625 897.9625
107 107 936.3375 897.3375 158 158 936.9750 897.9750
108 108 936.3500 897.3500 159 159 936.9875 897.9875
109 109 936.3625 897.3625 160 160 937.0000 898.0000
110 110 936.3750 897.3750 161 161 937.0125 898.0125
111 111 936.3875 897.3875 162 162 937.0250 898.0250
112 112 936.4000 897.4000 163 163 937.0375 898.0375
113 113 936.4125 897.4125 164 164 937.0500 898.0500
114 114 936.4250 897.4250 165 165 937.0625 898.0625
115 115 936.4375 897.4375 166 166 937.0750 898.0750
116 116 936.4500 897.4500 167 167 937.0875 898.0875
117 117 936.4625 897.4625 168 168 937.1000 898.1000
118 118 936.4750 897.4750 169 169 937.1125 898.1125
119 119 936.4875 897.4875 170 170 937.1250 898.1250
120 120 936.5000 897.5000 171 171 937.1375 898.1375
121 121 936.5125 897.5125 172 172 937.1500 898.1500
122 122 936.5250 897.5250 173 173 937.1625 898.1625
123 123 936.5375 897.5375 174 174 937.1750 898.1750
124 124 936.5500 897.5500 175 175 937.1875 898.1875
125 125 936.5625 897.5625 176 176 937.2000 898.2000
126 126 936.5750 897.5750 177 177 937.2125 898.2125
127 127 936.5875 897.5875 178 178 937.2250 898.2250
128 128 936.6000 897.6000 179 179 937.2375 898.2375
129 129 936.6125 897.6125 180 180 937.2500 898.2500
130 130 936.6250 897.6250 181 181 937.2625 898.2625
131 131 936.6375 897.6375 182 182 937.2750 898.2750
132 132 936.6500 897.6500 183 183 937.2875 898.2875
133 133 936.6625 897.6625 184 184 937.3000 898.3000
134 134 936.6750 897.6750 185 185 937.3125 898.3125
135 135 936.6875 897.6875 186 186 937.3250 898.3250
136 136 936.7000 897.7000 187 187 937.3375 898.3375
137 137 936.7125 897.7125 188 188 937.3500 898.3500
138 138 936.7250 897.7250 189 189 937.3625 898.3625
139 139 936.7375 897.7375 190 190 937.3750 898.3750
140 140 936.7500 897.7500 191 191 937.3875 898.3875
141 141 936.7625 897.7625 192 192 937.4000 898.4000
142 142 936.7750 897.7750 193 193 937.4125 898.4125
143 143 936.7875 897.7875 194 194 937.4250 898.4250
144 144 936.8000 897.8000 195 195 937.4375 898.4375
145 145 936.8125 897.8125 196 196 937.4500 898.4500
146 146 936.8250 897.8250 197 197 937.4625 898.4625
147 147 936.8375 897.8375 198 198 937.4750 898.4750
148 148 936.8500 897.8500 199 199 937.4875 898.4875
149 149 936.8625 897.8625 200 200 937.5000 898.5000
150 150 936.8750 897.8750 201 201 937.5125 898.5125
151 151 936.8875 897.8875 202 202 937.5250 898.5250
152 152 936.9000 897.9000 203 203 937.5375 898.5375
153 153 936.9125 897.9125 204 204 937.5500 898.5500
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900 MHz Channels
Prog Chan. | FCC Chan. | Repeater Tx| Repeater Rx Prog Chan. | FCC Chan. | Repeater Tx | Repeater Rx

No. No. Freq. Freq No. No. Freq. Freq

205 205 937.5625 898.5625 256 256 938.2000 899.2000
206 206 937.5750 898.5750 257 257 938.2125 899.2125
207 207 937.5875 898.5875 258 258 938.2250 899.2250
208 208 937.6000 898.6000 259 259 938.2375 899.2375
209 209 937.6125 898.6125 260 260 938.2500 899.2500
210 210 937.6250 898.6250 261 261 938.2625 899.2625
211 211 937.6375 898.6375 262 262 938.2750 899.2750
212 212 937.6500 898.6500 263 263 938.2875 899.2875
213 213 937.6625 898.6625 264 264 938.3000 899.3000
214 214 937.6750 898.6750 265 265 938.3125 899.3125
215 215 937.6875 898.6875 266 266 938.3250 899.3250
216 216 937.7000 898.7000 267 267 938.3375 899.3375
217 217 937.7125 898.7125 268 268 938.3500 899.3500
218 218 937.7250 898.7250 269 269 938.3625 899.3625
219 219 937.7375 898.7375 270 270 938.3750 899.3750
220 220 937.7500 898.7500 271 271 938.3875 899.3875
221 221 937.7625 898.7625 272 272 938.4000 899.4000
222 222 937.7750 898.7750 273 273 938.4125 899.4125
223 223 937.7875 898.7875 274 274 938.4250 899.4250
224 224 937.8000 898.8000 275 275 938.4375 899.4375
225 225 937.8125 898.8125 276 276 938.4500 899.4500
226 226 937.8250 898.8250 277 277 938.4625 899.4625
227 227 937.8375 898.8375 278 278 938.4750 899.4750
228 228 937.8500 898.8500 279 279 938.4875 899.4875
229 229 937.8625 898.8625 280 280 938.5000 899.5000
230 230 937.8750 898.8750 281 281 938.5125 899.5125
231 231 937.8875 898.8875 282 282 938.5250 899.5250
232 232 937.9000 898.9000 283 283 938.5375 899.5375
233 233 937.9125 898.9125 284 284 938.5500 899.5500
234 234 937.9250 898.9250 285 285 938.5625 899.5625
235 235 937.9375 898.9375 286 286 938.5750 899.5750
236 236 937.9500 898.9500 287 287 938.5875 899.5875
237 237 937.9625 898.9625 288 288 938.6000 899.6000
238 238 937.9750 898.9750 289 289 938.6125 899.6125
239 239 937.9875 898.9875 290 290 938.6250 899.6250
240 240 938.0000 899.0000 291 291 938.6375 899.6375
241 241 938.0125 899.0125 292 292 938.6500 899.6500
242 242 938.0250 899.0250 293 293 938.6625 899.6625
243 243 938.0375 899.0375 294 294 938.6750 899.6750
244 244 938.0500 899.0500 295 295 938.6875 899.6875
245 245 938.0625 899.0625 296 296 938.7000 899.7000
246 246 938.0750 899.0750 297 297 938.7125 899.7125
247 247 938.0875 899.0875 298 298 938.7250 899.7250
248 248 938.1000 899.1000 299 299 938.7375 899.7375
249 249 938.1125 899.1125 300 300 938.7500 899.7500
250 250 938.1250 899.1250 301 301 938.7625 899.7625
251 251 938.1375 899.1375 302 302 938.7750 899.7750
252 252 938.1500 899.1500 303 303 938.7875 899.7875
253 253 938.1625 899.1625 304 304 938.8000 899.8000
254 254 938.1750 899.1750 305 305 938.8125 899.8125
255 255 938.1875 899.1875 306 306 938.8250 899.8250
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900 MHz Channels
Prog Chan. | FCC Chan. | Repeater Tx| Repeater Rx Prog Chan. | FCC Chan. | Repeater Tx | Repeater Rx

No. No. Freq. Freq No. No. Freq. Freq

307 307 938.8375 899.8375 358 358 939.4750 900.4750
308 308 938.8500 899.8500 359 359 939.4875 900.4875
309 309 938.8625 899.8625 360 360 939.5000 900.5000
310 310 938.8750 899.8750 361 361 939.5125 900.5125
311 311 938.8875 899.8875 362 362 939.5250 900.5250
312 312 938.9000 899.9000 363 363 939.5375 900.5375
313 313 938.9125 899.9125 364 364 939.5500 900.5500
314 314 938.9250 899.9250 365 365 939.5625 900.5625
315 315 938.9375 899.9375 366 366 939.5750 900.5750
316 316 938.9500 899.9500 367 367 939.5875 900.5875
317 317 938.9625 899.9625 368 368 939.6000 900.6000
318 318 938.9750 899.9750 369 369 939.6125 900.6125
319 319 938.9875 899.9875 370 370 939.6250 900.6250
320 320 939.0000 900.0000 371 371 939.6375 900.6375
321 321 939.0125 900.0125 372 372 939.6500 900.6500
322 322 939.0250 900.0250 373 373 939.6625 900.6625
323 323 939.0375 900.0375 374 374 939.6750 900.6750
324 324 939.0500 900.0500 375 375 939.6875 900.6875
325 325 939.0625 900.0625 376 376 939.7000 900.7000
326 326 939.0750 900.0750 377 377 939.7125 900.7125
327 327 939.0875 900.0875 378 378 939.7250 900.7250
328 328 939.1000 900.1000 379 379 939.7375 900.7375
329 329 939.1125 900.1125 380 380 939.7500 900.7500
330 330 939.1250 900.1250 381 381 939.7625 900.7625
331 331 939.1375 900.1375 382 382 939.7750 900.7750
332 332 939.1500 900.1500 383 383 939.7875 900.7875
333 333 939.1625 900.1625 384 384 939.8000 900.8000
334 334 939.1750 900.1750 385 385 939.8125 900.8125
335 335 939.1875 900.1875 386 386 939.8250 900.8250
336 336 939.2000 900.2000 387 387 939.8375 900.8375
337 337 939.2125 900.2125 388 388 939.8500 900.8500
338 338 939.2250 900.2250 389 389 939.8625 900.8625
339 339 939.2375 900.2375 390 390 939.8750 900.8750
340 340 939.2500 900.2500 391 391 939.8875 900.8875
341 341 939.2625 900.2625 392 392 939.9000 900.9000
342 342 939.2750 900.2750 393 393 939.9125 900.9125
343 343 939.2875 900.2875 394 394 939.9250 900.9250
344 344 939.3000 900.3000 395 395 939.9375 900.9375
345 345 939.3125 900.3125 396 396 939.9500 900.9500
346 346 939.3250 900.3250 397 397 939.9625 900.9625
347 347 939.3375 900.3375 398 398 939.9750 900.9750
348 348 939.3500 900.3500 399 399 939.9875 900.9875
349 349 939.3625 900.3625 400 400 940.0000 901.0000
350 350 939.3750 900.3750 401 401 940.0125 901.0125
351 351 939.3875 900.3875 402 402 940.0250 901.0250
352 352 939.4000 900.4000 403 403 940.0375 901.0375
353 353 939.4125 900.4125 404 404 940.0500 901.0500
354 354 939.4250 900.4250 405 405 940.0625 901.0625
355 355 939.4375 900.4375 406 406 940.0750 901.0750
356 356 939.4500 900.4500 407 407 940.0875 901.0875
357 357 939.4625 900.4625 408 408 940.1000 901.1000
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900 MHz Channels
Prog Chan. | FCC Chan. | Repeater Tx| Repeater Rx Prog Chan. | FCC Chan. | Repeater Tx | Repeater Rx
No. No. Freq. Freq No. No. Freq. Freq
409 409 940.1125 901.1125 445 445 940.5625 901.5625
410 410 940.1250 901.1250 446 446 940.5750 901.5750
411 411 940.1375 901.1375 447 447 940.5875 901.5875
412 412 940.1500 901.1500 448 448 940.6000 901.6000
413 413 940.1625 901.1625 449 449 940.6125 901.6125
414 414 940.1750 901.1750 450 450 940.6250 901.6250
415 415 940.1875 901.1875 451 451 940.6375 901.6375
416 416 940.2000 901.2000 452 452 940.6500 901.6500
417 417 940.2125 901.2125 453 453 940.6625 901.6625
418 418 940.2250 901.2250 454 454 940.6750 901.6750
419 419 940.2375 901.2375 455 455 940.6875 901.6875
420 420 940.2500 901.2500 456 456 940.7000 901.7000
421 421 940.2625 901.2625 457 457 940.7125 901.7125
422 422 940.2750 901.2750 458 458 940.7250 901.7250
423 423 940.2875 901.2875 459 459 940.7375 901.7375
424 424 940.3000 901.3000 460 460 940.7500 901.7500
425 425 940.3125 901.3125 461 461 940.7625 901.7625
426 426 940.3250 901.3250 462 462 940.7750 901.7750
427 427 940.3375 901.3375 463 463 940.7875 901.7875
428 428 940.3500 901.3500 464 464 940.8000 901.8000
429 429 940.3625 901.3625 465 465 940.8125 901.8125
430 430 940.3750 901.3750 466 466 940.8250 901.8250
431 431 940.3875 901.3875 467 467 940.8375 901.8375
432 432 940.4000 901.4000 468 468 940.8500 901.8500
433 433 940.4125 901.4125 469 469 940.8625 901.8625
434 434 940.4250 901.4250 470 470 940.8750 901.8750
435 435 940.4375 901.4375 471 471 940.8875 901.8875
436 436 940.4500 901.4500 472 472 940.9000 901.9000
437 437 940.4625 901.4625 473 473 940.9125 901.9125
438 438 940.4750 901.4750 474 474 940.9250 901.9250
439 439 940.4875 901.4875 475 475 940.9375 901.9375
440 440 940.5000 901.5000 476 476 940.9500 901.9500
441 441 940.5125 901.5125 477 477 940.9625 901.9625
442 442 940.5250 901.5250 478 478 940.9750 901.9750
443 443 940.5375 901.5375 479 479 940.9875 901.9875
444 444 940.5500 901.5500
[1] Use the Programming Channel Number, not the FCC Channel Number
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SECTION 4 LTR-NET OVERVIEW
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Figure 4-1 LTR-Net System Diagram

4.1 INTRODUCTION
4.1.1 GENERAL

LTR-Net™ is the next generation of LTR®
trunked radio signaling. It provides many new
enhanced operating features while maintaining
compatibility with most current LTR equipment. Some
new LTR-Net features include roaming, unique ID
calls, and over-the-air reprogramming. Equipment
changes include the addition of an LTR-Net 3000-
Series switch and System and Subscriber Manager to
provide system control. A diagram of an LTR-Net
system is shown in Figure 4-1.

4.1.2 COMPATIBILITY WITH LTR

LTR Subscriber Units Operating in LTR-Net Systems

® Standard group calls occur in the normal manner.
These calls can be to other LTR subscriber units or
between LTR and LTR-Net subscriber units.

® Wide area group calls can be placed and received

(see Section 4.4).

® LTR telephone calls can be placed and received in

the normal manner.

® Enhanced LTR-Net features such as roaming and
unique ID calls are not available.

4-1
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® Current LTR subscriber units can remain in service
and LTR-Net subscriber units added gradually. This
makes upgrading to LTR-Net very convenient and
less costly.

LTR-Net Subscriber Units Operating on LTR Systems

® LTR-Net subscriber units can be programmed for
LTR operation. Therefore, they can place and
receive LTR group and telephone calls in the normal
manner.

¢ Enhanced LTR-Net features such as roaming and
unique ID calls are not available to LTR-Net
subscriber units operating on LTR system:s.

4.1.3 LTR-NET FEATURES

Networking

® Multiple LTR-Net and LTR localities may be linked
together to provide wide-area coverage.

® LTR-Net subscriber units can roam between LTR-
Net localities and register and de-register automati-
cally when entering and exiting.

Calls from one type of subscriber unit can be
patched to another type of subscriber unit at another
locality. For example, an LTR-Net subscriber unit
could talk to a conventional subscriber unit. Calls can
even be cross-band, for example, an UHF conven-
tional subscriber unit could talk to an 800 MHz LTR-
Net subscriber unit.

Special Calls

¢ Unique ID (UID) - Calls to be placed to specific
subscriber units in the same locality or some other
locality.

® Directed Group - Calls can be placed to any group
in the same locality or some other locality.

¢ Telephone - Calls can be placed over the public
switched telephone network (PSTN).

® Data - Data can be transmitted to specific location

selected by unique ID code (not currently available).
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System Control

®* When new channels are added to a locality,
subscriber units can be updated with those channels
over the air. This eliminates the need to bring them
back in for reprogramming.

® Over-the-air subscriber unit programming allows
the ID codes of up to 128 systems and 128 groups to
be changed.

® The system/group currently selected by a subscriber
unit can be changed over the air.

A temporary UID keyed to the ESN can be assigned to
a subscriber unit when it roams to a new radio system
(this feature has not yet been implemented).

® Unauthorized subscriber units can be temporarily or
permanently disabled.

A subscriber unit can be interrogated to determine if
it is currently in service. It can also be interrogated
for its ESN or unique ID code (see following).

Security

¢ FEach LTR-Net subscriber unit is assigned a unique
Electronic Serial Number (ESN), and no two
subscriber units in existence should have the same
ESN. This number can be interrogated as stated
above and is used for such things as assigning a
temporary UID.

® Over 65,500 unique ID codes can be assigned in
each locality. Each subscriber unit in a locality is
usually assigned a different unique ID code
although more than one can have the same code if
desired.

® Unique ID and group validation (by home repeater/
group ID) is performed. If an unauthorized ID is
detected, the call is terminated.

Miscellaneous

® Home channel backup is provided by the use of a
status channel at each locality. The status channel is
used for voice traffic the same as normal channels,
but is usually not assigned as a home channel.
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® Typical access time for group calls is the same as
with LTR operation. Access time for unique ID and
auxiliary calls is less than 500 milliseconds.

® Priority access, automatic emergency calls, status
messaging, and system security keys are not
available.

4.1.4 DEFINITIONS

The following are some terms that are used
frequently when describing LTR-Net operation:

Group - A subscriber unit has selectable systems and
groups. Each system can have several groups. The
group selects the call type and the subscriber unit or
units which receive the call. Refer to Section 2.4.9 for
more information.

Home Repeater - Each selectable system of LTR and
LTR-Net subscriber units has one of the locality
repeaters assigned as their “home” repeater. This is the
repeater from which “free” and “channel-in-use”
information is received (see Section 4.6). In addition,
with standard group calls, the home repeater number
and a group ID form the “address” of the recipient of a
call.

Locality - A group of co-located repeaters typically
connected by a common data bus. Refer to Sections
4.2.3 and 2.4.9 for more information.

LTR Signaling - This popular EFJohnson radio
trunking system provides the basis for the LTR-Net
system. For a complete description of LTR trunking,
refer to the LTR Application Note, Part No. 009-0001-
002, Revision 8 or later.

Mobile - A transceiver mounted in a vehicle. This
term may also be used generically to refer to any
transceiver, either mobile or portable, since both
operate basically the same. See also “Subscriber
Unit”.

Portable - A small handheld transceiver usually
battery powered and carried by a person. See also
“Subscriber Unit”.

Site - See “Locality”.

4-3

Status Repeater - The repeater at a locality designated
to provide home channel backup. It transmits call
information for all subscriber units on that locality.
Refer to Section 4.6 for more information.

System, Radio - This refers to the radio equipment and
other infrastructure that is accessed when a call is
placed.

System, Selectable - A subscriber unit has selectable
systems and groups. Each selectable system consists
or one or more groups and is programmed with a
unique home repeater (see Section 2.4.9 for more
information). A radio system refers to the radio equip-
ment that is accessed when calls are placed.

Subscriber Unit - A generic term referring to both the
mobile and portable transceivers being used in the
radio system.

Trunked Radio System - A radio system which utilizes
multiple radio channels and automatic channel
switching to allow all users equal access to any
channel not in use. This results in minimum waiting to
make a call and maximum utilization of the available
radio channels.

Unique ID - A unique number from 1-65503 assigned
to each subscriber unit. Although this number is
assignable on a per locality basis, the same number is
typically assigned on each locality a subscriber unit
can access.

4.2 SYSTEM ARCHITECTURE

4.2.1 INTRODUCTION

A diagram of a typical LTR-Net system is shown
in Figure 4-1. The number or localities, repeaters per
locality, number of 3000-series switches, and other
system parameters are determined by the requirements
of the particular system. The following is more infor-
mation on the components shown in Figure 4-1.

4.2.2 SUBSCRIBER UNITS

Subscriber units operating in an LTR-Net locality
must be the LTR-Net or LTR type. They may be the
mounted in a vehicle (mobiles) and or carried (porta-
bles). The features available with each type are as
follows:
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LTR-Net Subscriber Units

These subscriber units are designed for operation
in an LTR-Net radio system and therefore have all
LTR-Net features. An optional DTMF keypad is
required to place telephone, directed group, and
unique ID calls. These subscriber units can also be
programmed for LTR and conventional operation, so
will operate in those types of radio systems. Standard
group and also telephone calls can be placed when
operating in an LTR system.

LTR Subscriber Units

These transceivers are designed for operation in
LTR and conventional radio systems. They can also be
used in an LTR-Net radio system to make standard and
wide area group calls and telephone calls. Standard
group calls are to mobiles in the same locality, and
wide area group calls are to mobiles in some other
locality. Enhanced LTR-Net features such as unique
ID calls and full roaming capability are not available.

4.2.3 REPEATERS

Viking® VX 2000-series repeaters are used in an
LTR-Net system. Models are available for the VHF,
UHF, 800 MHz, and 900 MHz frequency bands. One
repeater is required for each radio channel.

As with standard LTR repeaters, all the signal
processing for the channel is performed by the logic
unit in each repeater. This is referred to as distributive
processing, and it eliminates the need for a separate
controller at each locality.

Audio (voice) and data signals are routed from
each repeater to a 3000-series switch. This allows the
switch to route the call to other localities and also
control certain repeater functions. The link to the
switch may be a direct connection if the switch is at
the same location or some other type such as micro-
wave, fiber optic, RF, or telephone line. The audio
interface to the switch is a standard 600-ohm, four-
wire path (transmit and receive pair). The data signal
can use an RS-232 interface or it can be FSK tones
using the same or a different audio path than the voice.
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A “locality” refers to repeaters at the same loca-
tion that are interconnected by a common high-speed
data bus. Up to 20 repeaters can be interconnected, so
a locality can include up to 20 repeaters. Although
more than 20 repeaters could be co-located, they
would be considered separate localities because they
are not interconnected by the same data bus. A single
data bus can be up to 500 feet long.

Standard LTR and conventional Viking VX and
8000-series repeaters can also be connected to the
3000-Series switch. However, since they would not be
using LTR-Net software, the only enhanced LTR-Net
feature provided would be wide area group calling (see
Section 4.4).

4.2.4 3000-SERIES SWITCH

The 3000-Series Switch connects several
different forms of communication together to form a
communications network. Each switch is controlled by
a Call Processor and System and Subscriber Manager
(see next sections). A switch can consist of up to three
racks, each containing up to eight shelves. Since each
shelf has 12-16 device slots, up to 96-128 slots per
rack and up to 288-384 slots per switch are available.
Many different modules are available for installation
in these slots. The exact number and type required is
determined by the requirements of each system.

A single 3000-Series Switch can control up to 30
repeaters. Therefore, if a LTR-Net network consisting
of several localities has more than 30 repeaters, one
switch is required for every 30 repeaters. A switch can
be located at one of the repeater localities or it can be
at a separate location. An audio and data link connects
the switch to each repeater as described in the
preceding section.

When a call is made by a subscriber unit in one
locality to a subscriber unit in another locality, the
switch provides the necessary patch. Likewise, when a
telephone call is placed by a subscriber unit, the switch
routes it to the Public Switched Telephone Network
(PSTN). Calls can also be routed to a PABX (Private
Automatic Branch Exchange). The dial access codes
and least cost routing facilities of the PABX can then
be utilized.
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425 CALL PROCESSOR

The Call Processor is a Windows NT-based
personal computer running switch management soft-
ware. The Call Processor serves as an interface
between the switch and the System and Subscriber
Manager (see next section). It contains the database
used to process calls on the switch and also logs call
information from the switch. The Call Processor
performs such tasks as processing wide area calls,
subscriber unit registration, and Interrogate and Reas-
sign requests. One Call Processor is required per
switch, and it is connected to the switch by two 19,200
baud data links.

4.2.6 SYSTEM AND SUBSCRIBER MANAGER

The System and Subscriber Manager (SSM) is
also a Windows NT-based personal computer. It runs
the software which provides overall system control.
One or more SSMs may be used to control the system.
This allows, for example, the system administrator to
have overall system control and then permit other
operators limited control privileges. Access is by pass-
word only, and only functions authorized to a partic-
ular user can be accessed. This ensures that only
authorized personnel can modify and monitor system
resources.

Some SSM functions are as follows:
¢ Set up and authorize auxiliary and telephone inter-
connect calls on a unique ID basis. Also authorize

group calls on a locality/home/group basis.

® Track the location of individual LTR-Net subscriber
units by unique ID.

¢ (Control wide area auxiliary calls by unique ID.

® Track wide area group calls by locality/home/group
or unique ID.

® Setup command calls such as Reassign, Interrogate,
Mobile Disable, and others.

® Monitor and display information on system activity.

® Record information on individual subscriber unit
system usage in a standard database format. This

information can then be exported and used by
billing software to generate customer billing.

4.3 STANDARD GROUP CALLS

Standard group calls are between subscriber units
at the same locality and use ID codes 1-239 that are
assignable on each home repeater. A group ID can be
assigned to one subscriber unit or a group of
subscriber units as desired. To place a standard group
call, all the user does is select the group programmed
for the group being called and press the PTT switch.
No number is dialed using a DTMF keypad as with
special calls described in Section 4.5.

Selectable groups used to make standard group
calls are programmed with a group ID code, and the
selectable system is programmed with a home repeater
number. This home repeater/ID code form the
“address” of the group call. Since each selectable
system can be programmed with a different home
repeater, standard group calls can be placed to any
group in a locality.

Standard group calls hold a repeater for only the
duration of a transmission, not for the entire call. This
provides maximum system efficiency because the time
between transmissions can be used by others.

4.4 WIDE AREA GROUP CALLS

The wide area group calling feature allows stan-
dard group calls from LTR or LTR-Net subscriber
units to be routed to any locality in the LTR-Net
system.

Specific locality/home/group ID combinations
can be programmed in the SSM (see Section 4.2.6) for
wide area calls. Then when a standard group call is
detected on one of these combinations, it is automati-
cally routed to the specified localities as well as occur-
ring on the home locality. The home/group can be
different on each wide area locality if desired.

Each wide area locality/home/group involved in a
wide area call can be programmed as follows:

® The call is always routed to the specified locality,
home, and group (if resources are available).
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® The call is routed to a specified locality only if a call
on the home/group has been recently detected. This
results in more efficient use of system resources.

® The call is routed to a specific locality if a tracked
unique ID is registered on that locality.

Wide area group calls can also be made over stan-
dard LTR and conventional Viking VX repeaters that
are connected to a 3000-series LTR-Net switch.
However, no other LTR-Net enhanced features are
available with those repeaters.

Wide area group calls continue to be received
while registration on a new locality occurs. For
example, the transceiver can exit a locality while
receiving a call, register on a new locality, and then
continue receiving the call on the new locality. In addi-
tion, a call can be received on the new locality before
registration occurs if the call is already active on the
new locality.

4.5 SPECIAL CALLS
45.1 GENERAL

LTR-Net subscriber units can place Auxiliary,
Telephone, and Data special calls. These calls are not
available to LTR subscriber units being used on an
LTR-Net system. When a special call is placed, a
number is dialed which specifies the recipient of the
call. The DTMF keypad used to dial this number may
be optional, and it is located on the microphone with
mobile subscriber units and on the front panel with
portable units. Special calls hold the channel until the
entire call is complete, not just until the transmission is
complete as with group calls. More information on
each special call follows.

4.5.2 AUXILIARY CALLS

Auxiliary calls include Unique ID and Directed
Group calls. Unique ID calls allow calls to be selec-
tively placed to an individual subscriber unit in any
locality. Likewise, Directed Group calls allow stan-
dard group calls allow group calls to be selectively
placed to any group in any locality. Refer to Section
2.9.1 for more information on these calls.
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4.5.3 TELEPHONE CALLS

Telephone calls allow calls to be placed over the
public switched telephone network. After the system is
accessed, a dial tone sounds and the telephone number
being called is entered using the DTMF keypad. Since
most subscriber units are half-duplex (do not transmit
and receive at the same time), it is not possible for the
mobile user to talk and listen at the same time.

If a unique telephone number has been assigned
to subscriber unit, it can be called directly from a land-
side telephone. If not, the radio system is called and
then the unique ID of the mobile must be overdialed
similar to when a unique ID call is placed by a
subscriber unit.

If a subscriber unit has been assigned a unique
telephone number, that number can also be used for
unique ID calls. This allows mobile-to-mobile unique
ID calls to be made by simply dialing the telephone
number of the desired subscriber unit.

45.4 DATA CALLS
NOTE: Data calls are not currently available.

Data calls allow data to be transmitted to a
specific unique ID. The audio of the receiving equip-
ment is automatically muted as data is received. Data
may be transmitted back and forth several times until
the entire data exchange is complete because the
channel is held for the duration of the call. To transmit
a data call, a group programmed for the data special
call is selected and then the unique ID is entered,
usually automatically by the data equipment. Data
calls are received the same as unique ID calls.

4.6 HOME CHANNEL BACKUP

4.6.1 INTRODUCTION

An LTR-Net repeater locality (site) consists of up
to twenty interconnected repeaters (see Section 4.2.3).
One of these repeaters is usually designated as status
repeater and the others are designated as home
repeaters (see following). The subscriber units are
programmed with the channel numbers of these
repeaters. Data signaling can occur continuously with
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voice on any repeater because the data occupies the
subaudible frequencies below the voice band.

4.6.2 HOME REPEATERS

The home repeater is used by the subscriber unit
as its primary source of incoming call and free
repeater information. When not receiving or transmit-
ting a call, it is monitoring this repeater. The home
repeater is always used to make a call if it is not busy.
In addition, if roaming mobiles searching for a new
locality cannot locate a suitable status repeater, the
home repeater is monitored (see Section 2.9.3). As
previously mentioned, up to 239 group ID codes can
be assigned on each home repeater, and the home
repeater and ID code form the “address” when making
group calls.

4.6.3 STATUS REPEATERS

One repeater at each locality is designated the
status repeater. The primary function of this repeater is
to provide backup for the other locality repeaters that
are assigned as home repeaters. It continuously trans-
mits call information for all calls occurring at that
locality. The status repeater is used for voice traffic,
but is usually not assigned as a home repeater because
there would then be no home channel backup on that
repeater. Roaming mobiles searching for a new
locality monitor the status repeaters (Section 2.9.3).
After registration occurs, the home repeater is then
monitored.

4.6.4 BACKUP OPERATION

If subscriber units were limited to only their
home repeater to receive update information and that
repeater became inoperative, all subscriber units that
were assigned to that repeater would then be unable to
place or receive calls. To prevent this from happening,
the status repeater can also be monitored for call infor-
mation.

If the signal from the home repeater is lost or
falls below a minimum threshold, the subscriber unit
automatically begins monitoring the locality status
repeater. If a usable signal is detected from the status
repeater, it continues to monitor that repeater. If a
message is detected that has its home repeater as the
“channel-in-use” or “free” repeater, the subscriber unit
then returns to monitoring its home repeater.
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A roaming subscriber unit also monitors the
status repeater in this manner when the home repeater
signal drops below the threshold level. However, the
status repeater signal level will probably also be below
the threshold, so the subscriber unit then begins
searching for a new locality.

4.6.5 HOME CHANNEL ALIASING

The LTR-Net Home Channel Aliasing feature
increases the number of addresses available on a
locality for group calls. It does this by allowing calls
to be programmed on non-existent home repeaters.

Each home repeater can be programmed with up
1-239 group ID codes. Assume a locality has four
active repeaters and one of these is the status repeater
(which is normally not assigned as a home repeater as
described in Section 4.6.3). The number a calls that
can be programmed are then as follows:

Without Aliasing - 3 x 239 or 717 calls
With Aliasing - 20 x 239 or 4780 calls

When a call is placed on a non-existent home
repeater, the subscriber unit automatically uses the
next lower numbered active repeater. Refer to Section
2.9.6 for more information.

NOTE: Since this feature does not increase system
capacity, adding too many users may result in unsatis-
factory operation due to frequent busy conditions.

4.7 OTHER LTR-NET FEATURES
4.7.1 UNIQUE ID CODES

Each LTR-Net subscriber unit in an LTR-Net
system is assigned a unique ID (a different unique ID
can be programmed for each locality if desired). Up to
65,503 user ID codes are assignable in each locality,
and a few other codes are used for system functions.
When an LTR-Net subscriber unit places a special
call, it transmits its unique ID code along with other
information such as the call type. This data is received
by the repeater and passed on to the SSM.

Uses of unique ID codes include registering and
de-registering on a locality, unit identification, airtime
billing, and unique ID calls (see “Unique ID Calls” in
Section 4.5.2). A call can also be made to individual
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subscriber units using a group call if the group is
assigned to only one subscriber unit.

A temporary unigue ID code can also be assigned
over-the-air. This may be required to allow a full
roaming subscriber unit to access a locality that is not
part of its network. Temporary unigue ID codes are
keyed to the ESN of the subscriber unit (see next

permanently disabled by the kill command or tempo-
rarily disabled by the Sleep command. If the Kill
command is sent, the unit responds indicating that it
has received the message and then it permanently
disables itself. It must then be brought back in for
reprogramming to make it functional again. If the
sleep command is sent instead, the transceiver is
disabled until the Interrogate command is sent. Refer

section). A roaming subscriber unit may also request a to Section 2.9.5 for more information.

temporary unique ID code. If no response is received
from the system after three requests, access was
denied and the unit must select another locality.

NOTE: The preceding feature has not yet been
implemented.

4.7.2 ELECTRONIC SERIAL NUMBER (ESN)

Each subscriber unit, both mobile and portable, is
given an electronic serial number at the factory. No
two LTR-Net subscriber units should ever have the
same ESN. This is a 32-bit number with the first 7 bits
reserved for the manufacturer code and the other 25
for the serial number. This allows for up to 128 manu-
facturers and over 33.5 million serial numbers per
manufacturer. The ESN can be interrogated over the
air as described next.

4.7.3 ESN AND UNIQUE ID REQUESTS

The system operator can request the Electronic
Serial Number (see preceding section) or unique ID

(see Section 4.7.1) that is programmed in a subscriber

unit. If the ESN is desired, the unique ID code of the
subscriber unit is specified, and vice versa. The
subscriber unit then responds with the requested
information.

4.7.4 INTERROGATE

4.7.6 OVER-THE-AIR REPROGRAMMING

Any system and group position of a subscriber
unit can be reprogrammed over the air. Up to 128
system selections and 128 group selections are
allowed. In addition, group alpha tags of up to 16
characters can be reprogrammed if applicable. The
subscriber unit to be reprogrammed is selected by
specifying its unigque ID code. One use of this feature
is to allow a subscriber unit to place and receive calls
for which it was not originally programmed.

4.7.7 MOVE TO SPECIFIC SYSTEM/GROUP

The system/group currently selected by a
subscriber unit can also be dynamically changed over
the air. As with reprogramming, the subscriber unit is
selected by specifying its unique ID code. When the
command is received, the unit automatically changes
to the specified system/group. This function may be
used, for example, to ensure that the correct system/
group is selected to receive an important message.

4.7.8 AUTO-REGISTRATION AND
DE-REGISTRATION

LTR-Net subscriber units are programmed with
the locality information of all localities they can roam
into. This includes the status and home channels and
the channel frequencies of the locality repeaters.

A system manager can interrogate any subscriber Roaming must be enabled and an LTR-Net system

unitin the field to determine if it is in service. The unit
is selected by specifying its unique ID code. Ifitis in
service, it automatically responds with an acknowl-

edge message, and this will be indicated on the system

manager’s screen.
4.7.5 KILL AND SLEEP

If a subscriber unit has been lost or stolen or is
being used to interfere with communications, it can be
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selected for roaming to occur (it is not necessary to
enable scanning).

Normally, a subscriber unit monitors its home
channel for incoming call and free channel informa-
tion. When moving out of range of a locality, the
signal from the home repeater decreases below a
programmable threshold level. With mobile trans-
ceivers, this threshold level is determined by squelch
levels (see Section 2.9.3), and with portable trans-
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ceivers, it is determined by the percentage of good attempts are made. With mobile transceivers, this
data messages received over a certain period. feature is always enabled, and with portable trans-
ceivers, it can be enabled or disabled by programming.
When the home repeater signal strength drops

below the threshold, the status channel of that locality When a mobile subscriber unit is no longer in

is then monitored (see Section 4.6). If its signal service (power is turned off), a de-registration
strength is also below the threshold, the subscriber  message is automatically sent if possible. This

unit then begins searching for another locality by prevents the system from wasting resources trying to
checking the status repeater of other programmed reach out-of-service units. Power is automatically held
localities. If one is located with a signal above the on until this message is sent. De-registration is

programmed threshold, it will attempt to register on  currently not available with portable subscriber units.
the locality. If no suitable status repeaters could be

located, the programmed home repeaters are moni-

tored. 4.7.9 NEW CHANNEL UPDATES

When a new locality is located, the subscriber New subscriber units are initially programmed
unit registers on the locality by sending messages indi- with the channel numbers of all repeaters at each
cating its unique ID code and the home channel it will locality. These are then the channels that can be
monitor. The system then knows the location of that accessed when placing and receiving calls on that
subscriber unit and will automatically route unique ID locality. If new channels are later added, the
calls to the new locality. subscriber units can be updated with the new chan-

nels over the air. This eliminates the need to bring

Automatic locality search can also be automati- subscriber units back in for reprogramming. Refer to
cally initiated if two consecutive unsuccessful access Section 2.9.4 for more information.
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